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Merci ! L’équipe de Vous et Votre Mac vous remercie 
pour l’accueil que vous avez réservé à ce nouveau magazine.
À l’évidence, vous avez bien compris que nous voulions 
proposer quelque chose de différent dans la presse Mac 
française. Une revue proche de vous, de votre pratique 
du Macintosh, de Mac OS X et des applications les plus 
courantes. Nous avons tapé dans le mille ! Mais, comme l’a 
si bien dit un visiteur de notre site Web, faire un bon numéro 1,
ce n’est pas le plus difficile... Il faut sortir les suivants, tenir 
la longueur, ne point décevoir. Nous espérons qu’avec 

le numéro 2 et ce troisième que vous êtes en train de feuilleter, nous avons su relever
le challenge et mériter votre confiance. 
Comme vous avez pu le constater le mois dernier, la maquette de Vous et Votre Mac
a su rapidement évoluer. Nous tenons compte des informations qui nous parviennent
grâce à l’enquête lecteur permanente, en ligne, dont vous êtes déjà plusieurs 
centaines à avoir rempli le formulaire. Nous vous invitons à y participer si vous ne
l’avez pas encore fait. Nous consultons aussi presque tous les jours vos contributions
sur le forum. Si nous n’intervenons pas systématiquement par manque de temps,
nous restons ouverts à vos remarques sur le magazine et prêts à intégrer 
les meilleures suggestions tant qu’elles cadrent avec notre projet de départ. 
Nous sommes encore plus sensibles aux sujets qui soulèvent questions et, 

vous l’aurez remarqué sans doute, plusieurs thèmes et pratiques des numéros 2 
et 3 sont nés de vos questionnements, réflexions et échanges. 
J’allais aussi vous reparler du Mac Mini auquel nous consacrons un dossier complet 
dans ce numéro. C’est vraiment un bon plan ! Mais ce matin, au réveil, j’ai eu droit 
à la huitième mise à jour de Panther. Avec toujours la même question : dois-je 
ou non la faire ? Une fois encore, j’ai répondu oui. C’est donc sous Mac OS X 10.3.8 
que j’écris cet édito. Bien sûr, on a tous lu sur Internet les récits cataclysmiques 
de tel ou tel utilisateur suite à une mise à jour. Je ne vous garantis pas que 
ça passera chez vous comme une lettre à la poste. Personne ne peut vous l’assurer.
Car chaque Mac est différent des autres. Il arrive ainsi que de rares séries 
révèlent des défauts à l’occasion d’une mise à jour système. Mais surtout, chaque
Mac est le résultat d’une relation plus ou moins longue, sereine ou agitée, avec 
son utilisateur. Le dieu de la micro sait ce que nous faisons subir à nos compagnons,
ce que nous installons au petit bonheur la chance sur leurs disques durs ! 
Ici, à VVMac, nous faisons pire encore pour vous servir. Et pourtant, nous n’avons
jamais connu le moindre problème suite à une mise à jour.
Si cela arrivait ? Ce serait l’occasion de faire le grand nettoyage, à l’évidence
nécessaire, trop longtemps repoussé. Dernier conseil : ici, comme en d’autres
matières, sortez protégés : faites donc une bonne sauvegarde avant d’aller plus loin.
Bonne mise à jour !
Bernard Le Du (bledu@vvmac.com)
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Outil complémentaire, le site de Vous et Votre Mac existe 
avant tout pour vous informer de la vie du magazine.
Vous y consulterez donc les sommaires des numéros 
et téléchargerez des ressources nécessaires à la réalisation 
de certains articles pratiques. 
Nous vous proposons aussi de répondre à notre Enquête lecteurs
permanente pour nous aider à améliorer le magazine, 
de vous rendre sur notre petit forum pour échanger avis et idées
avec la rédaction du magazine, ou encore partager vos trucs 
et astuces avec les autres lecteurs de Vous et Votre Mac.

Web www.vvmac.com
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Afin de mettre Vous et Votre Mac en conformité avec les exigences de la Commission paritaire 
des publications et agences de presse, nous avons retiré des articles tous les liens Internet.
Vous retrouverez donc les principales adresses et sites Web des articles de ce numéro 
dans notre Bottin, en page 104. 
Si l’information que vous recherchez ne s’y trouve pas, le plus simple est de saisir le nom 
d’une entreprise ou d’un produit dans Google ou un moteur similaire, ou encore d’effectuer 
une recherche via les moteurs Versiontracker ou FRtracker.
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Une encyclopédie libre !
L

e site Wikipédia 
(http://fr.wikipedia.
org/wiki/Accueil), 

encyclopédie gratuite et 
rédigée en plusieurs 
langues, est un des grands 
projets de l’ère Internet.
Utopiste ? Un brin sans doute,
mais le succès est là : 
elle vient de dépasser 
la célèbre Encyclopédie 
Diderot et d’Alembert
qui ne comptait pas moins 
de 71 818 articles ! 
L’originalité de Wikipédia ?
Tout un chacun peut jouer 
à l’encyclopédiste et, selon son domaine de compétence, contribuer à l’enrichir. 
Prodigieuse base de connaissances ouverte à tous, Wikipédia est classée par thèmes. 
On peut également la consulter avec les boutons Consulter (recherche dans les titres) 
ou Rechercher (examen du corps des articles). Partout, les hyper-liens aident à naviguer. 
Des pages spéciales proposent des sélections d’articles. On y trouve, par exemple, 
les nouveaux articles, ceux récemment modifiés, une page tirée au hasard, les articles 
par ancienneté ou par liste alphabétique. Vous avez des connaissances pointues 
ou une expérience dans tel ou tel domaine ? N’hésitez donc pas à participer. Les modalités
de votre participation vous sont parfaitement expliquées, en français.

Mode T, connectez-vous

protégé…
C

onnaissez-vous un moyen d’empêcher le
démarrage en mode Cible sans mot de passe ?
En effet, avec ce mode de démarrage 

(appui sur la touche T lors du boot), tous 
les volumes du Mac montent sans aucune 
protection sur l’ordinateur hôte. n Jean-Pascal Ruch

En effet, aucune protection système ne peut 
s’appliquer lorsque vous connectez 
votre PowerBook ou votre iBook à un autre Mac
et que vous le placez en mode « disque dur
externe ». Il existe toutefois une solution 
qui protégera au moins votre répertoire 
d’utilisateur : activez le mode FileVault. Pour 
ce faire, allez dans les propriétés de l’utilisateur
(panneau Comptes dans les Préférences Système).
Votre dossier Départ s’affichera alors comme 
une image disque cryptée et protégée 
par mot de passe. Si vous ne souhaitez assurer 
que la confidentialité de quelques fichiers, 
passez alors par Utilitaire de disque et créez vous-
même une image disque cryptée dans laquelle
vous glisserez vos documents les plus précieux.

Remonter mon disque

Firewire
J

’avais ces temps derniers un problème 
avec mon disque de sauvegarde FireWire 
qui refusait souvent de monter sur 

le Bureau de mon PowerBook, puis plus jamais,
mais semblait marcher parfaitement sur un autre
Mac. Puis, ce dernier n’a également plus voulu
reconnaître le disque… J’accusais illico le boîtier
– plutôt bas de gamme – dans lequel je l’avais
placé. Et j’étais à deux doigts d’en changer 
lorsque j’ai découvert en passant sur je ne sais
plus sur quel site, que quelqu’un connaissait 
les mêmes problèmes que moi. Celui-ci donnait 
une solution qui, appliquée dans les deux minutes
suivantes sur mes deux Mac, s’est révélée 
efficace. Depuis, mon disque s’affiche sans 
problème sur le Bureau. Je n’ai pu retrouver 
l’astuce originale, mais voici grosso modo
de quoi il s’agit… Oyez, oyez !
Si j’ai bien compris, un disque FireWire endosse
pour se faire connaître de Mac OS X les « habits »
d’un « utilisateur 99 ». Pour des raisons que 
je ne connais pas, cet utilisateur se corrompt

en quelque sorte, et l’astuce consiste 
à le supprimer pour en créer un nouveau
tout propre sur lui !
Pour ce faire, ouvrez Gestionnaire
NetInfo (dans le répertoire Utilitaires).
Dans la fenêtre qui s’affiche, repérez 
la colonne « / », déroulez la liste 
jusqu’à « users », cliquez pour afficher 
à droite la liste des utilisateurs.
L’utilisateur 99 y est référencé sous 
le label « unknown ». Cliquez dessus.
La zone des Propriétés s’affiche. 
Si tout est grisé : cliquez en bas 
à gauche sur le petit cadenas et donnez
votre mot de passe administrateur. 
Faites une copie d’écran de la zone 
des propriétés afin de conserver par devers
vous les paramètres.
Sélectionnez le User unknown et supprimez-le 
à l’aide du bouton Supprimer de la barre 
d’outils. Faites ensuite une copie de l’utilisateur
Nobody, par exemple, à l’aide du bouton

Dupliquer. Renommez-le « unknown ».
Dans la zone de ses propriétés, remplacez 
les valeurs des lignes iud, gid, name, realname
et _writers_passwd par celles que vous voyez sur
la copie d’écran. Sauvez et quittez Gestionnaire
NetInfo. Connectez votre disque. Le voilà 
qui remonte sur le Bureau sans crier gare !

10 Mars 2005Vous et Votre Mac
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Ah… maudits acronymes!

Balle qui tourne
n’amasse pas mousse
S

ous Mac OS X, c’est peu courant, mais il arrive que des applications se bloquent
sans pour autant vous forcer le moins du monde à redémarrer votre machine !
L’affaire se règle plus simplement, au prix de quelques pertes de données… 

Le Finder est une application comme les autres. Donc, il lui arrive aussi de « perdre
les pédales ». La roue (la balle) multicolore se met alors à tourner, tourner, 
et tourner indéfiniment. Pour relancer le Finder, vous pouvez opter pour un clic droit
sur son icône dans le Dock. Le menu Relancer apparaît alors. Mais il arrive 
que le Finder ne réagisse toujours pas. Alors, comme pour toutes les applications 
plantées, usez de la combinaison de touches Pomme + Alt + Esc : dans la fenêtre 
qui s’affiche, un bouton Forcer à quitter est proposé pour les applications. 
Pour le Finder, le système vous propose de cliquer sur le bouton Relancer.

L
es fichiers .iso ou .bin/.cue (toujours 
en couple comme nous allons l’expliquer) 
correspondent la plupart du temps à des 

images de CD ou de DVD. C’est un moyen simple 
de conserver toutes les caractéristiques d’un
média comme son nom, ses différents volumes… 

La taille des fichiers .iso ou .bin est généralement
assez importante (plusieurs dizaines ou 
centaines de Mo) : ce sont eux qui renferment
l’information. Si le fichier .iso vit sa vie tout 
seul, on associe en revanche à un fichier .bin, 
un petit fichier texte de description doté 
de l’extension .cue. Ce fichier .cue seul ne sert 
à rien. Mais un fichier .bin, seul, n’est pas 
utilisable non plus. C’est le couple .bin/.cue 
qu’il faut garder dans un même dossier.
Comment ouvrir ces fichiers images ? C’est simple
pour le fichier .iso : il s’ouvre tout simplement
avec l’utilitaire de disque d’Apple. Pour le couple
.bin/.cue, vous devrez recourir aux bons services
de Toast qui monte et grave ce type d’images.

U
n de nos lecteurs, Louis Martin, a relevé dans le premier numéro 
de Vous et Votre Mac tout un ensemble d’acronymes qui l’ont 
laissé quelque peu pantois. J’espère qu’avec le temps et la lecture

régulière de VVMac (merci pour votre abonnement, d’ailleurs), 
vous serez incollable sur tous ces formats. En attendant, je tente un petit
classement avec quelques mots d’explication pour chacun. Je m’excuse 
par avance, auprès des puristes, des approximations éventuelles…

Un fichier .iso ou

.bin/.cue?
MPeg Famille de formats développée par le comité du même nom.
MPeg-1 Format audio et vidéo développé pour le vidéo-CD.
MPeg-2 Format adapté à la vidéo pour les médias DVD.

MPeg-4

Format normalisé permettant de stocker, intégrer et diffuser des objets
audiovisuels variés : la vidéo, l’audio, les graphismes 2D et les mondes virtuels en 3D.
Ce format est bien adapté pour diffuser des contenus sur des réseaux bas débit
(Internet par modem) et sur des réseaux haut débit. Il permet les deux modes d’accès :
par téléchargement et par streaming (c’est-à-dire en flux continu).

DivX Nom générique de toute une famille de compression vidéo (gratuite ou commerciale).
DivX3 Compression vidéo DivX en version 3.
DivX4 Compression vidéo DivX en version 4.
DivX5 Compression vidéo DivX en version 5.
XVid Variante du format DivX (format libre d’utilisation).
3IVX Variante commerciale du format DivX.

DV
Standard d’enregistrement qui propose une manière d’écrire un signal vidéo com-
pressé sur une bande magnétique. Utilisé par la majorité des caméscopes numériques.

.Vob Fichier des DVD-vidéo (mixe la vidéo et le son).
MPG Extension (et enveloppe) des fichiers de la famille MPeg.
Avi Extension (et enveloppe) des fichiers de la famille DivX.

OGM
Enveloppe dans laquelle on retrouve un format vidéo et un format audio.
Développé par Vorbis.

MP3 Partie audio du format MPeg-1 layer 3. C’est donc de la compression audio.
AIFF Format de fichier natif développé par Apple pour Mac OS.
Wav Format de fichier natif développé par Microsoft pour Windows.
WMA Compression audio concurrente du MP3, développée par Microsoft et donc propriétaire.
AAC Format audio basé sur la norme MPeg-4. Se veut le remplaçant du format MP3.
OGG Ogg Vorbis. Format sonore développé par la société Vorbis.

AC3
Encodage du son utilisé pour le cinéma et la vidéo. Étudié pour géré 6 enceintes
(2 sur les côtés, 2 arrière, 1 centrale et 1 caisson pour les basses).

5.1 Similaire à l’AC3.

Mars 2005 11Vous et Votre Mac
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V
oici la solution, à mon sens, la plus performante pour qui veut diviser 
ses fichiers MP3. C’est MP3 Trimmer, un shareware très bien pensé 
et d’une précision diabolique. Il retravaille les fichiers MP3 sans avoir 

à effectuer d’opération de dé-encodage/ré-encodage. Il sera utile pour nettoyer 
des enregistrements radio ou télé, pour supprimer de grandes plages de silence… 
Glissez un fichier MP3 dans sa fenêtre. Il est analysé et réparé si besoin. Avec 
le curseur ou l’écoute en direct, positionnez un point d’entrée (IN-point) et un point 
de sortie (OUT-point), et ce de manière très précise avec les zones Try. Pour finaliser,
ajoutez si vous voulez une montée et une descente du volume. C’est pratique 

pour les morceaux enregistrés en public ! Votre fichier MP3 est prêt en quelques
secondes. MP3 Trimmer est aussi capable de faire des regroupements et détecte 
automatiquement les blancs. Son interface, bien qu’en anglais, est très 
simple à maîtriser. Fonctionnel, il coûte 9 $ avec les mises à jour gratuites. 

Découpez un MP3 en 

morceaux

Quand ça fait 

Bong!

L
a copie d’écran d’une fenêtre ou d’un élément
d’interface que vous réalisez avec 
la combinaison de touches Pomme + Shift + 4,

suivie d’un appui sur Espace (et apparition 
d’un petit appareil photo), génère un fichier PDF
qui, si on l’ouvre dans Adobe Photoshop 
ou Photoshop Elements, est un calque. 
Tel n’est pas le cas des copies effectuées par 
les combinaisons Pomme + Shift + 3 ou 
Pomme + Shift + 4. La copie d’écran en mode
Fenêtre respecte donc parfaitement les coins
arrondis et vous évite un laborieux détourage.
Pour vous en convaincre, essayez de faire 
la manipulation avec l’horloge. La forme ronde
de la fenêtre est parfaitement gérée et prête 
à être insérée sur une photo, par exemple.

L
e Bong de démarrage est plutôt rassurant. 
Il indique que votre Mac fonctionne. Dans d’autres
occasions, il peut réveiller toute la maison 

ou attirer sur vous l’attention dans un lieu public. 
Il existe plusieurs manières de s’en affranchir. Si votre
Mac tourne et que vous devez redémarrer, coupez 
simplement le son (avec la touche Mute ou F3)
avant le redémarrage. C’est pratique, mais vous devrez
ensuite remettre le son à son niveau habituel.
Autre solution : au lieu de redémarrer, éteignez 
votre Mac. Tenez enfoncée la touche Mute ou F3 avant
d’appuyer sur le bouton d’alimentation. Relâchez 
dès que l’écran s’allume. Dans ce cas, le niveau sonore
que vous aviez précédemment n’a pas été modifié.
Enfin, il existe un Panneau de préférences qui propose
de régler le volume du son de démarrage. StartupSound
(www5e.biglobe.ne.jp/~arcana/index.fr.html) 
est gratuit et il est immédiatement opérationnel 
dans les Préférences système de votre Mac.

C’est un calque !

12 Mars 2005Vous et Votre Mac

M
ac OS X supporte le clic
droit, mais Apple n’offre
toujours que des souris 

à un bouton. Alors, soit 
vous achetez une autre souris 
à deux boutons (et une molette)
– à part le design, ce sont 
les mêmes souris USB que pour
les PC : elles seront reconnues immédiatement –, soit vous obtenez l’équivalent
du clic droit en appuyant sur la touche Ctrl tout en cliquant avec 
votre souris Apple. Ayez le réflexe clic droit ! De très nombreuses 
applications Mac OS X l’utilisent, et les fonctions qui lui sont associées 
ne figurent pas toujours dans leurs menus.

Tout le monde a droit à son
clic droit !
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Quand le Mac n’intéresse pas les fabricants… 
mais que ça marche tout de même !

Réparez souvent
les autorisations…

A
pple a livré des machines très 
limitées en termes d’entrées/sorties
audio. C’est le cas du Cube, 

mais aussi des portables. Pour combler
cette lacune, le constructeur propose 
sur l’AppleStore l’adaptateur audio USB
iMic de Griffin. Il est un peu cher, mais
fonctionne sous Mac OS 9.0.4. Avec
Mac OS X, vous avez une alternative,
testée par des utilisateurs, mais pas 
supportée par son fabricant : les boîtiers
SoundBlaster MP3+ ou SoundBlaster
Audigy 2Nx de Creative Labs. Sous 
Mac OS X 10.3.6, ils sont supportés

nativement par Mac 
OS X. Bien sûr,
vous ne pourrez
pas utiliser le
pack de logiciels
Windows livré
avec, mais toutes les
entrées/sorties, hormis 
le 5.1 (que je n’ai pas testé),
sont complètement opérationnelles 
et apparaissent comme ports d’entrées/
sorties audio dans le panneau 
de préférences Son. La Soundblaster
MP3+ est quasiment au même prix 

(50 € env.) que l’iMic de Griffin 
avec des possibilités bien supérieures.
Vous retrouverez des expériences 
utilisateurs sur le site Macbidouille, 
avec le mot-clé « SoundBlaster ».

V
ous arrive-t-il parfois d’avoir
l’impression que le système 
ne tourne plus rond ? 

Il m’est arrivé hier de ne pas 
pouvoir réaliser une simple copie
de fichiers sur un disque 
externe avec l’utilitaire Carbon
Copy Cloner. Ceci n’est pas 
vraiment une astuce, mais juste 
un petit conseil à conserver 
dans un petit coin de mémoire 
– la vôtre, pas celle de votre Mac. 
Il s’agit simplement de se rappeler
que Mac OS X est un système
Unix et qu’il utilise 
tout un mécano 
d’autorisations pour
tous les dossiers 
et fichiers. Et, parmi
ces quelques 
dizaines de milliers 
de fichiers qui 
se trouvent sur 
vos disques, et dont
vous ne soupçonnez
souvent pas même
l’existence, il arrive
que quelques-uns 
finissent par apparte-
nir à des utilisateurs
ou à des groupes
inconnus ou depuis

longtemps effacés. Le plus souvent,
ce ne sont pas des fichiers 
stratégiques qui sont touchés. 
On ne s’en aperçoit que très 
longtemps après, à l’occasion 
de back-up, de copies de dossiers...
Alors, n’oubliez pas ce réflexe :
réparez les autorisations du disque
régulièrement ! Cette procédure
ne prend que quelques minutes. 
Il suffit de cliquer sur le bouton
correspondant dans l’onglet
S.O.S de l’Utilitaire de disque.
Tous les mois, ce n’est pas 
du luxe et cela vous évitera bien 
des cheveux blancs…

V
ous n’aimez pas le son « numérique » des CD, 
trop lisse et sans défaut ? Vous regrettez le bon temps
des 33T qui « grésillaient » sous le saphir 

du tourne-disque ? Alors jetez-vous sur RetroPlayer : 
il transforme l’écoute d’un morceau de musique qualité CD 
en enregistrement « d’époque ». Craquements, rayures, 
distorsions, volume des effets, on s’y croirait ! 
Les préférences vous permettent de régler tout cela 
à l’épreuve de vos souvenirs. Pas trop de rayures, sinon 
ça saute tout le temps !
RetroPlayer s’intègre à iTunes grâce à un AppleScript. 
Vous avancez dans le morceau de musique en déplaçant 
le bras de tourne-disque à la souris. Retroplayer 
est gratuit, mais n’oubliez pas de faire un don si vous aimez
ce petit produit sympa.

Pour les nostalgiques

des vinyles

14 Mars 2005Vous et Votre Mac
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iBook ou PowerBook, fermez-lui

le clapet!

V
ous êtes fatigué d’entendre 
toujours le même son d’alerte
de Mac OS X ! Pourquoi ne pas

en changer ? Le son d’alerte système
n’est qu’un simple fichier au format
AIFF (extension .AIF).
Il faut en revanche 
veiller à ce qu’il 
ne soit pas trop long,
quelques secondes 
au maximum. Vous 
trouverez sur Internet
des fichiers déjà 
créés par d’autres 
utilisateurs, mais 
vous pouvez aussi 
utiliser QuickTime,
MP3 Trimmer 
et iTunes pour 
la conversion… et
fabriquer les vôtres.
Une fois votre fichier
.AIF prêt, il suffit de le glisser dans 
le dossier Bibliothèque > Sounds
de votre dossier utilisateur. Attention,
il existe aussi un dossier Sounds dans
Bibliothèque > Audio. Ce dossier
n’est pas utilisé par le système.
Si vous voulez que le son d’alerte
soit applicable à tous les utilisateurs
du Mac, soit vous le recopiez 
dans le dossier Sounds de chaque
utilisateur, soit vous le placez 

dans Système > Bibliothèque >
Sounds (depuis la racine de votre
disque dur), mais vous devez 
bénéficier des privilèges root pour 
effectuer cette dernière opération.

Redémarrez le Mac une fois 
les fichiers copiés. Pour activer 
le nouveau son d’alerte, dans
Préférences système, choisissez 
le tableau de préférences Son
et cliquez sur le nouveau son qui
doit normalement apparaître 
dans la liste. Vous remarquerez que 
les sons système apparaissent 
comme Intégré, les sons utilisateur
comme Personnalisé.

Mars 2005 15Vous et Votre Mac

S
avez-vous que vous pouvez très bien personnaliser 
la barre d’icônes qui se trouve à gauche 
de toutes les fenêtres du Finder et qui s’appelle 

« barre latérale » ? Elle peut devenir un véritable outil
d’organisation, de rangement et d’accès. 
Tout d’abord, cette zone peut être réglée en largeur 
et même disparaître complètement. On utilise pour cela 
le petit point dans la zone de séparation. Cette barre 
d’icônes se paramètre dans les préférences du Finder
(Finder > Préférences > Barre latérale). Il suffit de cocher
les objets que vous souhaitez voir apparaître. 
Par défaut, vous aurez tous les dossiers de votre dossier
Départ. Une autre approche consiste à placer 
le dossier Départ (la maison) en tant qu’objet. On supprime
alors tous les dossiers (Musiques, Séquences…) pour 
éviter la redondance. La barre latérale se gère un peu
comme le Dock : vous y placez des dossiers que vous 
voulez avoir à portée de souris en les glissant 
dans la barre. On fait le ménage en les sortant en dehors 

de la barre.
N’hésitez
donc pas à
personnaliser
la barre 
latérale, à 
y glisser tous
les dossiers
de travail 
que vous
ouvrez plu-
sieurs fois
par jour. Gain
de temps
assuré !

Barre latérale : faites

comme 
chez vous

Des sons d’alerte
personnalisés

V
ous possédez un iBook ou un PowerBook… Pourquoi ne pas travailler machine fermée, 
avec un grand écran LCD (ou un CRT) ? Il vous faudra bien entendu rajouter 
à votre configuration un clavier et une souris. Notez que sur les modèles récents, 

les claviers/souris Bluetooth fonctionnent de cette façon (une révision a été effectuée après 
la sortie du iMac G5), mieux vaut choisir clavier et souris USB pour être sûr de votre coup.
Branchez tout d’abord l’écran sur votre portable. Faites-le détecter, réglez la résolution… 
Bref, vérifiez que cet écran externe fonctionne correctement. Maintenant, mettez le portable 
en veille avec le menu Pomme > Suspendre l’activité. Fermez le portable.
Réveillez-le à l’aide de votre clavier externe en appuyant sur la barre d’espace. L’écran du portable
reste éteint (vous ne le voyez pas puisque ce dernier est fermé). Seul fonctionnent l’écran
externe et les clavier/souris USB (ou Bluetooth). Vous pouvez maintenant mettre le portable sur 
un coin du bureau : ce n’est plus qu’une unité centrale. Attention, cette manipulation peut ne pas
fonctionner avec des modèles anciens. Mieux vaut tester chez un ami (même s’il a un PC).
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B
ien que les mécanismes internes 
sur lequel repose le Finder aient été 
particulièrement bien cachés 

par Apple, on ne peut pas toujours 
les ignorer. Un fichier de préférences, 
un pilote matériel, un logiciel ou un 
utilitaire issu du monde Unix… vous voilà
confronté à la dure réalité du système. 
Ces éléments du système sont normalement
cachés, mais il est également possible 
de les rendre visibles. En premier lieu, sachez
que l’utilitaire Terminal vous les listera 
sans problème. La commande « ls »
(ou mieux « ls -a ») est là pour cela. 
Il existe aussi des outils Mac OS X qui 
les révèlent. TinkerTools est l’un des plus 
anciens et des plus connus. Il n’en reste pas
moins qu’avant de toucher un fichier 
système, il vaut mieux savoir ce que l’on

fait. La simple recopie d’une partie 
manquante du système telle qu’on 
la pratiquait sous Mac OS 9 n’est plus 
d’actualité. Nous vous proposons donc ici,
en guise de première approche, une liste
des principaux éléments (fichiers et réper-
toires) système, et leur brève description.
Vous serez peut–être aussi surpris de 
retrouver un jour tous les dossiers système,
les noms des applications et utilitaires 
Apple en anglais et non plus en français.
Pourtant, votre système (les menus, par
exemple) est bien en français ! Cette bizarre-
rie, présente dans les versions de Mac OS X,
vient de l’option Afficher toutes les extensions
de fichier. Lorsqu’elle est cochée (menu
Finder > Préférences > Avancé), tous 
les noms passent en anglais. Décochez-la et
tout repasse en français immédiatement !

Mais c’est quoi tout ça ?

Fichiers système Description
.DS_Store Dans chaque dossier, ce fichier contient des réglages du Finder.
.hidden Liste les fichiers qui doivent être cachés par le Finder.
Desktop DB, Desktop DF Fichier correspondant au Bureau de Mac OS Classic.
dev Lien symbolique. Pointe vers le répertoire des définitions de périphériques.
etc Lien symbolique. Pointe vers le répertoire des fichiers de configuration Unix.
mach Lien symbolique, Pointe vers le fichier mach.sym.
mach.sym Symboles du noyau du système.
mach_kernel Le noyau Darwin (système Unix du Mac).
tmp Lien symbolique. Pointe vers le répertoire des fichiers temporaires.
VM Storage Fichier de mémoire virtuelle de Mac OS 9.
Desktop (Mac OS 9) Lien qui pointe vers le dossier Bureau de Mac OS 9.

Répertoires système Description
.Trashes Contient les fichiers jetés à la Corbeille.
.vol Gère les fichiers HFS+.
automount Contient les points de montage statiques NFS.
bin Répertoire des exécutables du système Unix.
Desktop Folder Le dossier Bureau de Mac OS 9.
lost+found Répertoire des fichiers « orphelins » trouvés avec la commande fsck.
private Contient les sous-répertoires tmp, var, etc et cores.
sbin Répertoire des exécutables d’administration et de configuration Unix.
Shared Items Répertoire utilisé par Mac OS 9 pour le partage entre utilisateurs.
Temporary Items Fichiers temporaires utilisés par Mac OS 9.
TheVolumeSettingsFolder Créé pour chaque point d’entrée d’un volume ou d’un dossier partagé.
Trash La Corbeille de Mac OS 9.
usr Répertoire des applications Unix BSD et des fichiers de support.
var Contient les fichiers fréquemment modifiés (les fichiers log par exemple).
Volumes Liste des systèmes de fichiers montés.

Dossiers
(nom anglais)

Dossiers
(nom français) Description

Applications Applications Contient les applications Mac OS X. Le sous-répertoire Utilitaires contient un ensemble d’outils OS X livrés avec le système.
Applications (Mac OS 9) Applications (Mac OS 9) Contient les anciennes applications Mac OS 9 livrées par Apple.
Developer Developer Les outils développeurs Apple accompagnés de la documentation. Disponible si vous avez installé le CD Développeur (X Code).
Library Bibliothèque Fichiers de support pour les applications installées.
System Folder System Folder Le dossier Système de Mac OS 9.
System Système Contient des fichiers de support pour le système et les applications système Mac OS X.
Users Utilisateurs Contient tous les répertoires Départ des utilisateurs.

P
our égayer votre Finder ou si comme moi, vous avez 
une mémoire visuelle, remplacez les dossiers 
standard de Mac OS X par des photos ou des images

caractéristiques. Exemple : vous avez importé un album 
avec iTunes. Pourquoi ne pas remplacer l’icône basique 
du dossier par la pochette de l’album. 

1 Si le fichier qui contient la pochette présente l’icône 
standard, ouvrez-le dans Photoshop Elements 
et réenregistrez-le avec l’option Aperçu (case de la boîte 
de dialogue Enregistrer).

2 Affichez
les informa-
tions 
du dossier 
et celles 
de l’image.

3Sélectionnez et copiez l’icône de l’image. Sélectionnez
l’icône du dossier, puis collez. Le dossier s’offre 
un nouveau visage. Pour retrouver l’icône habituelle, éditez 
les informations et faites un Couper de l’icône.

Personnalisez vos dossiers

de musique

[ ]
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Les PowerBook accèdent aux technologies

les plus modernes
S

urfant sur le succès jamais démenti de ses ordi-
nateurs portables professionnels, Apple propose
un renouvellement complet de la gamme.

Disons-le tout de suite : le G5 n’est pas au rendez-
vous. Il n’est en effet pas prêt à se laisser enfermer
dans un boîtier aussi mince ! C’est donc toujours du
G4. Pour le reste, Apple soigne ses clients, avec des
prix bien ajustés. Il est cependant dommage qu’on ne
puisse réaliser plus de combinaisons, même sur
l’Apple Store. Impossible d’acheter un PowerBook 17”
avec lecteur optique combo. Vous ne pouvez le com-
mander qu’avec un SuperDrive.
Apple ne change rien à la recette de base qui a fait le
succès des PowerBook. Le design reste celui que
nous connaissons, avec un boîtier alu dont l’épais-
seur et le poids sont toujours exceptionnels pour des
portables embarquant tout ce dont vous avez besoin
pour travailler. Le processeur G4 est ici proposé dans
une version un peu plus rapide : 1,5 ou 1,67 GHz. Ce ne
devrait pas faire grande différence en termes de per-
formances. En revanche, toutes les machines bénéfi-
cient de 512 Mo de mémoire et de disques durs 5400
tours/min. Là, on va gagner quelque chose !
Pour s’y retrouver dans la nouvelle gamme, il faut se
baser sur la taille d’écran. On retrouve les versions 12,
15 et 17 pouces (avec respectivement les cartes gra-
phiques NVIDIA GeForce FX GO 5200/64 et ATI Mobility
Radeon 9700/64 et 9700/128). Une gradation qui cor-

respond pile aux différents niveaux de l’offre : entrée
de gamme, utilisation générale et haut de gamme.
Les performances graphiques sont donc nettement
différentes et les résolutions gérées de plus en plus
élevées. Pour le reste, on retrouve tous les ports d’en-
trée/sortie : FireWire 400, USB2, entrée/sortie audio,
Ethernet, modem, mini-DVI ou DVI. Apple a accordé
aux modèles 15 et 17 pouces quelques petits « plus »
(Ethenet Gigabit, FireWire 800, sortie S-vidéo, port
audio numérique) au fil de la montée en gamme. 
Tous les PowerBook « Février 2005 » intègrent une
technologie inédite, Sudden Motion Sensor, qui par-
que les têtes du disque dur aussitôt qu’une accéléra-
tion verticale (chute) brusque est détectée. Dès que
vous remettez le Powerbook horizontalement, il rede-
vient opérationnel. Le TrackPad simule la molette de
défilement lorsqu’on l’utilise avec deux doigts. Pour
le clic droit, je ne vois pas ce qu’ils vont inventer ! 
La gamme intègre aussi la norme Bluetooth 2.0+EDR
(Enhanced Data Rate). Une fois encore, Apple est en
pointe des technologies, car il n’y a pas encore de
périphérique Bluetooth 2.0 disponible sur le marché.
Rassurez-vous, c’est compatible Bluetooth 1.x. Enfin,
cerise sur le gâteau, le SuperDrive grave bien en 8x
tous les médias DVD±R/RW. Selon le communiqué
d’Apple, les nouveaux PowerBook étaient tous dispo-
nibles immédiatement à la mi-février.

n Alain Lalisse
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Nouveaux PowerBook et
Bluetooth 2.0+EDR

Décidément, Apple veut offrir 
aux acheteurs de portables 

ce qui se fait de mieux ! Les nouveaux
PowerBook (lire ci-contre) embarquent
tous en standard, que ce soient 
les modèles 12, 15 ou 17”, la toute 
dernière version de la technologie 
de communication de proximité
Bluetooth. En fait, ce sont même 
les premiers matériels au monde qui
soient disponibles à cette norme.
Bluetooth 2.0+EDR (pour Enhanced
Data Rate) est trois plus rapide 
(atteignant un débit de 3 Mbps) 
et, surtout, elle consomme beaucoup
moins d’énergie. Elle devrait supporter
des applications tels que le streaming
audio, le transfert d’images ou encore 
l’impression laser. On nous promet 
également un fonctionnement plus
simple lorsque plusieurs appareils 
sont interconnectés. Les PowerBook
restent bien entendu compatibles 
avec tous les matériels Bluetooth 1.x.

Et encore un émulateur 
PC pour Mac OS X

Nous testons Guest PC de Lismore
Systems dans ce numéro de 

Vous et Votre Mac. Mais il existe
encore un autre nouvel émulateur PC :
iEmulator, qui en est à sa version 1.7. 
Sa première version publique fut la 1.6 
commercialisée en novembre 2004.
iEmulator s’appuie sur le moteur QEMU
développé par Fabrice Bellard, 
un Français, et réputé pour sa rapidité 
(notamment par rapport à Bochs, 
un moteur d’émulation Open Source
que nous avons essayé à plusieurs
reprises et qui s’avère terriblement
lent). iEmulator est vendu pour 24 $, 
ce qui en fait le moins cher des trois
émulateurs PC pour Mac OS X. Il est
fourni avec un Dos minimal, 
nécessaire pour le démarrage. Comme
Guest PC, iEmulator ne fournit pas
l’excellente intégration qu’offre Virtual
PC de Microsoft (c’est aux anciens
ingénieurs de Connetix qu’on le doit).
Mais VPC 7, sans aucun OS intégré,
coûte près de 160 €.

Modèle PB 12” Combo PB 12” SuperDrive PB 15” Combo PB 15” SuperDrive PB 17” SuperDrive
Prix 1 529 € 1 729 € 1 999 € 2 299 € 2 699 €
Écran TFT 12 pouces TFT 12 pouces TFT 15,2 pouces TFT 15,2 pouces TFT 17 pouces
Résolution 1024 x 768 pixels 1024 x 768 pixels 1280 x 854 pixels 1280 x 854 pixels 1440 x 900 pixels
PowerPC G4 à 1,5 GHz G4 à 1,5 GHz G4 à 1,5 GHz G4 à 1,67 GHz G4 à 1,67 GHz 
Mémoire 512 Mo de DDR333 512 Mo de DDR333 512 Mo de DDR333 512 Mo de DDR333 512 Mo de DDR333
Disque dur Ultra ATA/100 de 60 Go Ultra ATA/100 de 80 Go Ultra ATA/100 de 80 Go Ultra ATA/100 de 80 Go Ultra ATA/100 de 100 Go
Carte graphique NVIDIA GeForce FX GO 5200 NVIDIA GeForce FX GO 5200 ATI Mobility Radeon 9700 ATI Mobility Radeon 9700 ATI Mobility Radeon 9700
Mémoire vidéo 64 Mo DDR 64 Mo DDR 64 Mo DDR 64 Mo DDR 128 Mo DDR
Clavier - - Rétro-éclairé Rétro-éclairé Rétro-éclairé
Réseau Ethernet 10/100 BASE-T Ethernet 10/100 BASE-T Ethernet Gigabit Ethernet Gigabit Ethernet Gigabit 
Ports FireWire 400, 2 USB 2 FireWire 400, 2 USB 2 FireWire 400 et 800, 2 USB 2 FireWire 400 et 800, 2 USB 2 FireWire 400 et 800, 2 USB 2
E/S audio Analogique Analogique Analogique Analogique Analogique & numérique
Vidéo Sortie mini-DVI Sortie mini-DVI Sortie DVI et S-vidéo Sortie DVI et S-vidéo Sortie DVI et S-vidéo
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L
e f a m e u x
logiciel de
téléphonie

sur Internet, de
messagerie instanta-
née et de conférence audio à plu-
sieurs est désormais disponible pour Mac OS X et Linux en
version finale 1.0. Skype était d’abord sorti en 2004 en plate-
forme Windows où il a rencontré un grand succès. Il était en
bêta publique pour Mac OS X depuis plusieurs mois. 14 % des
visiteurs ayant répondu fin janvier à un sondage du site
MacGénération ont déclaré utiliser Skype. Le logiciel est gra-
tuit ; seules les communications vers des téléphones filaires
ou mobiles sont payantes. Une version française n’était pas
encore disponible au téléchargement mi-février. n BLD

V
ous êtes le très heureux possesseur d’un iMac G5 ou d’un Mac Mini ? Et vous pensez
que vous ne pouvez décidément pas vivre comme les autres ? Alors, si vous en avez
les moyens, offrez-vous le luxe de ce superbe fauteuil C-Station, signé BlueBroc, qui

expose actuellement au Business
Design Center de Londres. Je ne
connais pas le prix de l’objet (le
site Web du designer reste hélas
muet sur ce point), mais ce doit
être cher. C’est tout cuir, avec tout
un choix de couleurs et de textu-
res. Le matériel informatique n’est
pas livré avec. Il faut juste prévoir,
si vous avez un Mac Mini, un écran
plat compatible avec le système
de fixation Vesa. n BLD

N
ous avions déjà XPress et
InDesign. Il va falloir sans
doute compter avec un

troisième larron : MLayout,
dont la toute nouvelle version 2
est en cours de localisation et
sera commercialisée en France
par Trias, intégrateur de solu-
tions pour l’édition et la presse. 
J’ai découvert MLayout il y a
quelques années, lors d’une
Macworld Expo à San Francis-
co où son développeur coréen
SoftMagic avait pris un stand.
La société SoftMagic a conçu
plusieurs produits pour la pres-
se et l’édition, mais je n’avais
par la suite jamais entendu par-
ler du logiciel en Europe. 
MLayout, c’est du « gros cali-
bre ». Développé dès l’origine
pour le tout nouveau Mac OS X,
en « natif » Objective C, MLay-
out est particulièrement utilisé
en Asie car il est totalement
Unicode et OpenType. De par
sa conception même, il est très
ouvert : des fonctionnalités
peuvent lui être aisément ajou-
tées (via la technologie Apple
des Bundles) et on peut l’inté-
grer facilement à des workflows
de production. 
MLayout ne déroutera que très
peu les utilisateurs de XPress :
l’interface utilisateur est pres-

que identique et j’ai retrouvé la
plupart de mes habitudes im-
médiatement. Nul besoin de
formation pour l’utiliser.
MLayout sait de plus ouvrir les
documents XPress 3.3, ce n’est
pas très récent certes, mais ce
format reste l’un des plus utilisés
dans la presse aujourd’hui en-
core. Mais, bien entendu, il ne
se contente pas de « cloner »
XPress : il apporte des concepts
qui lui sont propres et des fonc-
tions supplémentaires impor-

tantes par rapport à XPress. Si
l’on peut l’utiliser exactement
comme ce dernier, MLayout
met en avant l’architecture Mo-
del Design, intègre le système
de balisage XML et privilégie
donc une forte séparation de la
présentation et du contenu.
Avec des possibilités natives de
mise en page automatique,
Trias va proposer MLayout
aux entreprises de presse qui
doivent migrer vers Mac OS X,
mais qui ne peuvent, même

avec les baisses de prix annon-
cées par Quark, renouveler leur
parc de licences. Ainsi, le grou-
pe Metro International, qui a
plus de 1 000 postes XPress,
envisage-t-il de tout remplacer
par MLayout. En France, le
prix d’une licence MLayout
sera de 299 € HT (alors qu’il
faut compter 520 € HT pour
une mise à jour de XPress 4.x
vers XPress 6.5). Un argument
prix qui peut faire la différence.

n Bernard Le Du

MLayout 2 bientôt en français

Luxe, calme, volupté et iMac
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Skype en 1.0
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S
i la photo numérique
ou la PAO reviennent
souvent à la une des

magazines d’informatique,
tel n’est pas le cas de l’élec-
tronique. Le sujet vous pas-
sionne ? Faites donc un
tour sur le site Macbrusoft,
la référence pour tout ce
qui touche l’électronique et
votre Mac. Bon, je n’aime
pas spécialement sa mise
en page, à la fois minima-
liste et violemment colorée,
mais ce n’est pas vraiment
important. Ce si te est une véritable
caverne d’Ali Baba et fait remonter quel-
ques souvenirs à la mémoire de l’étudiant
de l’ISEN que je fus. 
Vous y trouverez bien évidemment des
liens et des petites annonces, mais surtout
des plans, des schémas, ou encore des res-
sources HyperLogo/HyperStudio (qui ne
sont malheureusement pas passés à Mac
OS X, mais qui au moins fonctionnent
parfaitement dans Classic). Sans compter
deux rubriques Téléchargements spéciali-

sées, avec ce qu’il vous faut d’utilitaires et
de logiciels gratuits ou commerciaux en
démo pour vous lancer.
À noter également le lien vers un site qui
propose, en micro-paiement par télépho-
ne (un moyen rapide et efficace qu’on ren-
contre de plus en plus en France) des kits
électroniques pour l’informatique, le mo-
délisme ou encore pour créer des alar-
mes... fichiers en format PDF avec typons
à l’échelle. Pas mal !

n Alain Lalisse

La suite bureautique OpenOffice.org, de son petit
nom OOo, est un ensemble logiciel très riche : 
un traitement de texte, un tableur, un logiciel 

de présentation, un autre de dessin vectoriel… 
La version 2.0 qui s’annonce devrait enfoncer le clou !
Pour Mac OS X, il existe à ce jour plusieurs initiatives 
de portage. La plus avancée est basée sur X11. Il faudra
donc installer cette option du système et oublier le style
Aqua de Mac OS X. Il existe une variante Java, J/Office, qui est tout à fait utilisable et un poil plus intégrée 
à Mac OS X, mais avec toujours le « look and feel Unix». Un développement natif Cocoa est en cours, mais 

on ne développe pas une suite bureautique en quelques mois, surtout que
tout repose sur le volontariat des développeurs. Le premier ouvrage 
que je vous propose est réalisé par les animateurs directs du portage 
français de OOo /X11. Ses 366 pages suivent la logique habituelle 
de l’utilisation : de l’installation aux options les plus complexes en passant
par l’utilisation proprement dite des principaux outils. Bien sûr, nous avons
encore AppleWorks et maintenant iWork. Mais OpenOffice, projet un peu 
utopique il y a quelques années encore, est le seul à concurrencer vraiment
Microsoft Office. Grâce aux choix judicieux d’Apple, nous ne serons pas
oubliés cette fois-ci. Le CD contient la version 1.1.3 pour Panther.
Les Éditions O’Reilly propose un autre livre pour ceux qui veulent 
découvrir OOo ou ont déjà abandonné Microsoft pour la suite bureautique 
la plus célèbre du monde Open Source. 215 pages et un CD avec le logiciel
pour Mac OS X, malheureusement dans une version ancienne. n AL

À SAVOIR[ ]
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Mac etélectronique

Open Office
entre en scène

Doc pour 
iPhoto 4

iPhoto 4, 35 €
Éditions O’Reilly 
ISBN : 2-84177-268-3 

Voici un petit guide, 
concentré et pratique, utile
référence pour se mettre

rapidement à FileMaker Pro dans
sa toute dernière version 7.
C’est plutôt bien fait et, en plus, 
ce n’est pas cher. À avoir à portée 
de la main si vous mitonnez vos
petites applications vous-même.

Point sur…
FileMaker Pro 7 

FileMaker Pro 7, 7,32 €
Éditions ENI
ISBN : 2-7460-2514-0

Si vous avez besoin d’une
documentation en français
d’iPhoto, ce livre sera utile.

Il traite certes de la version 4 
alors que la version 5 vient 
de sortir, mais il est très complet
avec ses 360 pages. 
Un peu cher tout de même !
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L
es livres sur Excel pour Mac ne sont pas légion,
c’est le moins que l’on puisse dire ! Nous 
sommes donc obligés de nous rabattre sur des

ouvrages écrits pour la version Windows. Heureuse-
ment, les deux versions se ressemblent beaucoup,
même si certaines parties sont toujours un peu en
avance, ou un peu en retard, ou encore développées
par des équipes qui semblent parfaitement s’ignorer. 
Ces deux ouvrages proposent des trucs et astuces pour
le tableur de Microsoft. Avec un peu d’attention et un
petit effort d’adaptation, vous pourrez tout de même
vous en servir. Jetez-y quand même un coup d’œil
avant de les acheter ! n AL

Vous l’avez remarqué, nous nous attachons 
à Vous et Votre Mac à réaliser des prises 
en main assez pratiques des logiciels, 

mais le papier a ses contraintes que le Web 
ne connaît point. Car si la bande passante est
payante, l’espace-page sur Internet est quasiment
gratuit. Passionnés ou professionnels peuvent 
« s’éclater », si j’ose dire : leurs tests couvrent

autant d’écrans qu’ils le veulent. 
Ainsi, l’excellent site Cuk.ch, dont 
l’animateur est un Suisse, nous a proposé
mi-janvier un banc d’essai très personnel
et assez dithyrambique du logiciel Pages
d’Apple sur plus de 40 pages ! Une visite
vraiment approfondie – peut-être trop
pour la plupart des utilisateurs. 
J’aime bien Cuck et suis assez souvent en
accord avec les tests qu’il publie. C’est
aussi un espace de convivialité, avec un

forum sérieux, ce qui est suffisamment rare pour
être mentionné et encouragé.
Sur MacDigit.com, j’ai retrouvé Jean-Christophe
Courte ou Thierry Lothon, d’anciens collaborateurs
de l’Univers Mac – celui d’il y a dix ans. Des gens de
qualité et des utilisateurs Mac très compétents.
Vous trouverez sur leur site, qui tient plus du blog
que de l’agence de presse, des articles liés à 

l’actualité, mais souvent bien plus 
détaillés qu’ailleurs. Les contributions 
des trois principaux animateurs
de MacDigit sont fouillées, toujours très
bien écrites, comme un point d’honneur,
même si parfois des sujets « technologie »
sont un peu ardus, voire austères. 
Les tests de logiciels sont là aussi précis,
et la passion du Mac et des produits 
est bien présente. n Bernard Le Du

À SAVOIR[ ]

Excel à 200%
36 €, ISBN : 2-84177-291-8
Editions O’Reilly

Supertests en français, s’il vous plaît !

Mieux connaîtreExcel

Pour les
switchers !

Office 2004 pour Mac, 16 €
Éditions ENI
ISBN : 2-7460-2728-3 

Réussir un projet de site Web
25 €, Éditions Eyrolles 
ISBN : 2-7460-2728-3 

Traiter de Word, Excel, Power-
Point, Entourage et même MSN
Messenger en 280 pages,

quelle gageure ! Cet ouvrage est
destiné aux débutants qui ont
choisi la suite Office 2004 pour Mac
et pour nos nouveaux amis venus
du monde PC. Car Office Mac 
n’est pas Office Windows ! Petit
prix, lecture rapide, c’est tout 
ce qu’il faut pour ne pas perdre de
temps. Mais, attention, vous n’aurez
que les bases de démarrage.

Réalisez votre site
Internet

Ces livres ont paru 
en grand nombre pendant 
la bulle Internet.

Depuis, le soufflet est retombé !
On y trouve trucs, conseils,
erreurs à éviter… pour bien créer
son site Web.

Excel Trucs et Astuces pour les nuls
24,90 €, ISBN : 2-84427-682-2
Editions First Interactive
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L’INTERFACE UTILISATEUR D’IPHOTO 5 A ÉVOLUÉ DANS LE BON SENS.
À gauche, votre photothèque et les rouleaux, les albums (automatiques,
créés sur sélection ou intelligents), mais aussi les nouveaux dossiers 
d’albums, les diaporamas et les livres que vous avez confectionnés . 
Au centre, la zone de visualisation des photos, sous forme de vignettes 

de taille variable ou une à une. Sur mon G4, la netteté des vignettes est 
immédiate. Et lorsque je double-clique sur une image « lourde » pour 
l’afficher, iPhoto montre brièvement une vignette assortie de l’avertissement 
« Chargement de la photo… », plutôt que de présenter une image pleine 
taille et atrocement pixellisée. Je trouve que c’est un bon compromis.
En bas, finis les quatre panneaux Importer, Organiser, Éditer
et Partager. Le panneau unique propose désormais automatiquement 
les bonnes fonctions selon votre contexte. Le changement de contexte

2

PRISE EN MAIN
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A
lors que tout le monde (ou pres-
que) possède un appareil photo
numérique – simple photophone,

compact, caméra bridge ou reflex semi-
professionnel –, iPhoto est devenu fort
logiquement l’application de la suite iLife
la plus utilisée. D’abord critiqué, et à rai-
son, iPhoto s’est beaucoup amélioré lors
de son passage en version 4. Cette nou-
velle version 5, sans être aussi importante,
apporte toutefois des évolutions significa-
tives de l’interface utilisateur, la gestion
des photos ainsi que des outils d’édition
et de retouche. Elle propose également
quelques fonctions inédites.
Parmi les améliorations (je reviendrai sur
certaines plus en détail), vous apprécierez
tout particulièrement d’avoir tous les ou-

tils à portée de main et de pouvoir bascu-
ler automatiquement, en fonction du con-
texte, entre les différents modes d’utilisa-
tion. Les possibilités de gestion accrue des
photos dans la base de données et de créa-
tion d’albums intelligents et de dossiers de
rangement sont aussi les bienvenues. 
Pour vos diaporamas, vous disposerez de
plus de transitions (les mêmes que dans
Keynote 2 et iMovie). Vous pourrez utili-
ser l’effet Ken Burns comme dans
iMovie et caler la durée du diaporama sur
celle de la musique. Quant aux livres (les
albums photo imprimés sur commande),
leur interface de création a été améliorée
et ils sont désormais disponibles dans une
plus grande variété de thèmes, de formats
et de types de couverture. 

Avec cette belle nouvelle version, Apple
répond à la plupart des demandes des uti-
lisateurs sans alourdir son logiciel de
fonctions superflues ou trop profession-
nelles. Apple réunit tous les outils pour
gérer, retoucher, imprimer, échanger des
photos avec un confort de travail inégalé.
Toutefois, iPhoto 5 reste en-deçà d’un lo-
giciel comme iView Media Pro. Mais pour
ceux qui l’obtiendront gratuitement sur
leur nouveau Mac, iPhoto 5 est parfait !
Si vous n’utilisez que cette application
d’iLife, le coût d’achat (79 €) est un peu
élevé. D’autant qu’iPhoto n’évite pas tout
recours à une application tierce, Photo-
shop Elements 3 par exemple, ou en ce
qui me concerne, PhotoPerfect Digicam.

n Bernard Le Du

1

iPhoto 5.01 offre de nombreuses améliorations dans la gestion et l’édition
des photos ainsi qu’une optimisation bienvenue de l’interface utilisateur. iPhoto 5.01

+ Un confort d’utilisation optimisé par la simplification de l’interface ; 
de nouvelles possibilités d’organisation et de gestion (albums intelligents,
dossiers, prise en charge des fichiers Raw et MPeg-4…) ; les outils d’édition ; 
la possibilité de créer des diaporamas encore plus sophistiqués.

- Pas de gestion directe de l’export vers un site FTP (seulement le service .Mac,
ce qui est de bonne guerre).

PRIX : intégré à la suite iLife 5 (79 €). Installé 
en standard sur tous les nouveaux Mac actuellement 
commercialisés. ÉDITEUR : Apple
DISTRIBUTION : Apple Store, revendeurs agréés. 
CONFIGURATION MINIMALE : G3 400 MHz, 512 Mo de Ram,
Mac OS X 10.3.4 (10.3.6 pour le Raw).

PRISE EN MAIN

Tout pour le photographe amateur

Plus simple et directe

1

3

3

2

9
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IPHOTO 5 REPOSE TOUJOURS SUR LE MÊME SYSTÈME de base de données, 
organisée très simplement en années, mois et jours. Si l’import des photos
dans une photothèque reste un préalable à leur utilisation dans iPhoto
(contrairement à iTunes où les morceaux de musique peuvent ne pas être
obligatoirement rangés dans la discothèque), rien ne vous empêche,
contrairement à ce que nombre d’utilisateurs croient, de gérer plusieurs
photothèques – et même certaines archivées sur CD-Rom ou DVD. Demandez

simplement « photothèque » dans l’aide
d’iPhoto pour obtenir des explications 
rapides et claires à ce sujet. Nul besoin 
de recourir à des utilitaires tiers. 
L’organisation de la base de données 
permet un premier niveau de recherche
par dates. La version 5 ajoute d’ailleurs 
à l’interface utilisateur un calendrier ,
ce qui facilite la navigation dans 
la photothèque. Mais pour affiner 
une recherche, il faut que l’utilisateur 
participe activement, d’une part lors de
l’importation quand iPhoto vous permet
de donner un titre aux images du rouleau
et de saisir un commentaire ; ensuite, 
par recours aux mots-clés, aux notes 
(des étoiles comme dans iTunes) et aux
commentaires. Vous pouvez le faire photo
par photo – ce qui peut représenter 
des heures et des heures de travail ! – ou
bien par lot sur une sélection de photos.

7

LE MODE ÉDITION COMPREND UN NOUVEL OUTIL
nommé Ajuster qui ouvre à l’écran 
une fenêtre semi-transparente de couleur 
anthracite , comme dans les logiciels 
professionnels d’Apple (fenêtres banalisées dans
Tiger). Gros avantage : elle ne masque pas 
totalement l’image que vous êtes en train 
de retravailler et qui se trouve peut-être 
en-dessous d’elle. L’outil Ajuster, outre 
la luminosité et le contraste déjà au programme
des versions précédentes, supporte les réglages
de saturation, température, teinte, netteté. 
À noter, une amusante fonction de redressement
avec affichage fugitif d’une grille . 
Vous pouvez aussi corriger l’exposition et jouer
avec les courbes de niveaux. Un ensemble 
assez complet qui devrait limiter le recours 
à un logiciel auxiliaire. Tout cela fonctionne en
temps réel. Bien entendu, si vous n’y entendez
rien, la fonction Améliorer , totalement 
automatique, est toujours là et donne de bons résultats. Toutefois, je n’ai pas
réussi à obtenir par moi-même une correction qui atteigne le niveau 
de qualité que m’offre automatiquement le magicien PhotoPerfect Digicam
(testé également dans ce numéro de Vous et Votre Mac).

6

5

4

Raw… Raw à demi !
La base de données d’iPhoto 5 prend en charge deux nouveaux types 
de fichiers : les courts films en MPeg-4 qu’enregistrent les appareils photo
numériques ainsi que les photos Raw. Examinons ce dernier point. 
Les Raw sont des images « brutes de capteur ». Parce qu’après capture, 
elles ne sont pas traitées par le logiciel interne de l’appareil. Pour 
les utiliser, vous devez les convertir vous-même en JPeg grâce à un module
Raw, comme ceux de Photoshop et Photoshop Elements 3, qui vous permet 
surtout d’intervenir sur de nombreux réglages et paramètres de la prise 
de vue (nous vous l’avons expliqué dans Vous et Votre Mac #2 ). 
iPhoto 5 intègre bien les Raw à sa base de données, mais il ne vous donne
aucun moyen d’intervenir vous-même sur les images. Les images Raw sont
stockées dans leur format original et iPhoto les convertit en JPeg selon 
ses propres algorithmes. Si un indicateur Raw apparaît à l’écran lors 
de leur visualisation , ce sont bien les JPeg auxquels vous accédez 
et que vous éditez, pas les Raw. Bref, autant enregistrer vos photos 
en JPeg directement sur la carte mémoire si vous avez un bon appareil ! 
Heureusement, comme pour tout original, vous pouvez exporter les fichiers
Raw à tout moment en tirant l’image hors de la fenêtre d’iPhoto.

9

Retouche plus poussée

Enfin des dossiers !

Rien ne vous empêche de modifier la date et l’heure de prise de vue sur tout
un ensemble de fichiers. Toutes ces informations permettent de créer des
requêtes qui seront la base d’albums intelligents, avant-goût de Tiger. Ainsi
pouvez-vous avoir un dossier intelligent regroupant toutes les photos dont
les titre et commentaire comportent le mot « chat », et cela sans rien 
modifier de l’organisation de la base de données d’iPhoto. Autre évolution
importante pour qui aime classer : iPhoto 5 permet de créer votre propre 
arborescence au sein d’une photothèque : vos albums, diaporamas, livres,
etc., sont alors rangés dans des dossiers thématiques par projets, clients…
comme vous le souhaitez. Là encore, comme pour les albums intelligents, 
les dossiers ne modifient pas l’organisation générale de la photothèque.

8

s’effectue de façon transparente. Ainsi, double-cliquer sur une photo 
vous fait automatiquement basculer en mode Édition avec 
les outils adéquats (j’y reviendrai). Lorsque vous êtes satisfait, 
vous n’êtes pas obligé de cliquer sur le bouton Terminer, sauf à vouloir

vraiment repasser en mode Consultation. En effet, toutes les photos 
de l’album ou du rouleau dans lequel se trouve celle que vous retouchez
apparaissent en haut de l’écran, avec un ascenseur pour accéder 
facilement à l’une ou à l’autre .3

7

8

4

5

6
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A
vec les appareils photo numéri-
ques, il faut pratiquement tou-
jours corriger l’éclairage, le con-

traste, les couleurs… Or, pour nombre
d’amateurs, un histogramme relève plus
du casse-tête que d’une aide réelle.
Adobe met d’ailleurs en avant avec Pho-
toshop Elements 3 des fonctions auto-
matiques de retouche de contraste et de
couleur. En s’appuyant sur sa technolo-
gie propriétaire Reco, Binuscan propose
PhotoPerfect Digicam, un utilitaire en-
core plus radical. Extrêmement simple à
utiliser, il vous servira à mettre vos pho-
tos au bon format, les renommer, corri-
ger leur colorimétrie et y ajouter quel-
ques effets, photo par photo ou par lot.
PhotoPerfect Digicam n’est pas gratuit.
Mais après avoir investi plusieurs cen-
taines d’euros dans un appareil photo
numérique de qualité, débourser 35 €

pour obtenir des photos parfaites, ce
n’est pas vraiment un problème.

n Alain Lalisse

LA MANIÈRE DONT LES PHOTOS (JPeg 
ou Tiff, mais pas PDF) sont choisies 
et ajoutées devrait être repensée pour 
la prochaine version. Car ici, pas 
question de charger un dossier, voire
une arborescence entière, et encore 
moins d’effectuer un glisser-déposer 
d’un dossier sur la fenêtre unique 
de travail. Non, il vous faut aller pêcher 
à la main les fichiers à traiter !
Pour le reste, l’ergonomie du produit est 
plutôt bonne. Il suffit de savoir ce que 
l’on veut faire et piocher dans les menus
déroulants : un tirage papier, 
du panoramique, une galerie sur Internet
ou un envoi par e-mail… Pour chaque 
utilisation, la plupart des formats 
du marché sont disponibles. Il n’y a qu’à 
choisir dans les pop-up menus. On pourra
tourner , redimensionner 

et si nécessaire rogner (Inscrire
redimensionne la photo pour la faire 
entrer dans le format alors que Couper,
comme son nom l’indique, coupe 
les bords sans redimensionner). Vous 
pouvez aussi renommer les images .
Choisissez quels traitements automatiques
appliquer . Trois sont proposés : 
Couleurs de l’original (transforme la taille
ou le nom, par exemple, mais conserve 
la colorimétrie originale), Traitement auto
couleurs et Traitement auto noir § blanc.
Choisissez éventuellement un filtre dans 
le pop-up menu . Un fichier sera créé
sur disque pour chacun des traitements. 
En déplaçant la petit boule verte, vous 
prévisualisez le résultat. Les originaux 
sont conservés. Les boutons 
lancent le traitement des images, une 
à une ou sur toute la sélection.

9

8

7

6

5
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2
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LE TRAITEMENT DE LA COULEUR effectué par PhotoPerfect 
Digicam est vraiment très performant ! Il est vrai que 
son éditeur n’est autre que Binuscan, un des grands experts
de l’imagerie, de la couleur et de la retouche photo,
et bien connu dans les milieux du pré-presse 
pour son logiciel haut de gamme PhotoRetouche Pro. 
Comme son grand frère, PhotoPerfect DigiCam est basé 
sur la technologie propriétaire Reco d’analyse de l’image
grâce à des techniques d’intelligence artificielle. Suite 
à cette analyse, le logiciel assure un traitement automatique. 
Au-delà des autres fonctions (notamment une batterie 
de quelque cinquante filtres, parfois un peu trop agressifs),
Reco est clairement le point fort de ce logiciel. J’ai 
littéralement redécouvert des photos que j’avais pourtant
déjà optimisées avec Photoshop. Ce qui est très fort, 
c’est que je n’ai eu à cocher qu’une case, et cliquer. De prime
abord, je suis toujours réservé sur les outils  « clic-bouton »,
mais là, chapeau bas ! J’ai donc décidé de repasser toutes 
mes photos à la moulinette de PhotoPerfect Digicam. J’en ai
pour un certain temps, car ce ne sont pas de petits fichiers…

L’IA au service de la photo
Si l’ergonomie est encore à peaufiner, ce logiciel a en revanche 
montré son excellence dans le traitement automatique de nos photos.PhotoPerfect DigiCam

+ Le traitement automatique de la couleur très performant et super-simplifié ;
la gestion des formats très variés ; la simplicité d’utilisation ; le prix.

- Difficile à utiliser sur des centaines de photos déjà classées dans 
une arborescence de dossiers et de sous-dossiers ; la licence du logiciel 
est liée à une seule machine, ce que nous n’aimons pas du tout.

PRIX : 35 €. ÉDITEUR : Binuscan. 
DISTRIBUTION : Par Internet 
CONFIGURATION MINIMALE : Mac OS X toutes 
versions, 256 Mo de mémoire vive.

PRISE EN MAIN

Une ergonomie simplifiée et agréableL’excellence des couleurs

1
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S
i vous êtes graphistes, monteurs Final
Cut ou créateurs de DVD, Motion
ne vous déconcertera pas ! Novices,

vous êtes les bienvenus ! Apple reprend un
concept bien connu : l’interactivité d’élé-
ments placés sur une hiérarchie de couches,
organisés dans le temps, sur une Timeline,
en fonction d’images-clés. Là où Motion
révolutionne l’animation graphique, c’est
avec son extrême simplicité d’utilisation,
surtout pour un logiciel « pro ». 
L’interface de Motion est proche de celle de
DVD Studio Pro. La partie principale, le
Canevas , est le plan de montage des ob-
jets. Une palette Navigateur permet de
naviguer dans le disque dur, d’appliquer des
effets et des comportements aux objets et
d’accéder aux propriétés avancées d’un
objet. Quant à la Timeline, située en bas de
l’écran , c’est là où s’organise l’anima-
tion et elle s’utilise comme celles d’iMotion
et de Final Cut.

Puissant et 
déconcertant de facilité !
Motion accepte en entrée les séquences
QuickTime, des fichiers graphiques (tels
les fichiers Photoshop, par exemple), des
fichiers audio supportés par QuickTime…
Il est même possible de séparer des calques
composites et de les animer individuelle-
ment sur un même plan. 
Les éléments peuvent êtres animés dans le
temps : entrée d’un logo sur la gauche de
l’écran, déplacement vers la droite, grossis-
sement et scintillement, puis dispararition
sur la droite quelques secondes plus tard. Il
est possible d’inclure des séquences vidéo
et de les animer en tant qu’objets : elles ap-
paraissent, disparaissent, se superposent...
Rien de plus simple que d’ajouter du texte,
objet animé comme les autres. Motion
construit également de superbes effets spé-

ciaux par simple glisser-déposer sans que
vous ayez parfois à vous soucier des ima-
ges-clés, et propose de nombreux compor-
tements « clés en main ». Le moteur temps
réel du logiciel sait générer des effets à par-
ticules haut de gamme, supporte la colli-
sion entre objets, etc., dont il assure la vi-
sualisation immédiate, vous évitant ainsi
d’attendre le rendu final. D’où une très
grande souplesse de travail. 
Vous testez, testez à nouveau comme vous
le voulez, sans vous soucier de la perte de
temps ou de la productivité. Plus de pro-
blème pour présenter à un client plusieurs
versions d’un même générique, par exem-
ple ! Seule limite connue : votre imagina-
tion. Mais attention, pour observer les ré-
sultats en totale fluidité, il vous faut une

solide configuration. Visez d’emblée un
PowerMac G5 biprocesseur avec un maxi-
mum de Ram.
Motion est proposé à un prix agressif pour
ce type de produit. Il est vrai qu’il peut ren-
dre des services à une large gamme d’utili-
sateurs, et bien sûr aux pros du montage
audiovisuel et du multimédia qui réalisent
des animations sophistiquées pour leurs
films, CD-Rom et DVD. Mais si vous êtes
vidéastes amateurs, étudiants en audiovi-
suel ou simples amateurs avertis, et que
vous avez le budget, vous pouvez acquérir
Motion pour intégrer des créations excep-
tionnelles à vos projets iMovie et iDVD et
goûter aux joies du compositing sans de-
voir suivre une formation complexe et coû-
teuse. Chapeau Apple ! n Frédéric Blaison

3

2

1

Glissez un élément dans le Canevas, réalisez quelques réglages 
dans les utilitaires et la Timeline : le tour est joué ! L’animation 
graphique en temps réel avec Motion, c’est aussi simple que cela.

Apple Motion

+ Simplicité d’utilisation et puissance de calcul au service d’animations 
graphiques pros ; l’interface proche de celle d’autres produits de la gamme
Pro ; l’intégration avec Final Cut Pro HD ; les modèles et didacticiels 
pour les novices, dans le même esprit des modèles de DVD Studio Pro.

- Pour une première version, le rapport qualité/prix flirte avec l’excellence ; 
difficile de trouver de réels défauts ; pour bien en profiter, il faut disposer
d’une très grosse configuration (un G5 gonflé à bloc en Ram) !

PRIX : 289€ ÉDITEUR : Apple DISTRIBUTION : Apple-
Store, revendeurs agréés CONFIGURATION MINIMALE :
G4 867 MHz ou G5, 512 Mo de Ram, Mac OS X 10.3.5, 
QuickTime 6.5.1, affichage 1280x1024 recommandé, carte 
ATI Radeon 9800 XT, 9800 Pro, 9700 Pro, 9600 XT, 9600
Pro, ou ATI Mobility Radeon 9600, 9700, ou nVidia GeForce
Go5200, ou nVidia GeForce FX 5200 ultra, lecteur DVD.

L’animation en toute simplicité

1

2

3
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PRISE EN MAINPRISE EN MAIN

Palettes en transparence

Le comportement de chaque objet peut être 
modifié individuellement. Pour ce faire, 
vous disposez d’une palette flottante, transparente
et très esthétique, accessible en cliquant 
sur l’icône Panneau de contrôle de la barre 
d’outils. Cette palette devrait vous rappeler 
les petits gadgets proposés par Dashboard dans
Tiger. Dès la sortie de Mac OS X 10.4, 
ces palettes devraient être massivement présentes
dans de nombreuses applications, comme 
les lecteurs DVD et QuickTime... Vous disposez
aussi de ce genre de palettes avec les applications
de la suite iLife 05. Vous pouvez ainsi 
modifier le comportement d’un objet sans que 
la palette ne le masque totalement. Et bien sûr
les modifications s’effectuent en temps réel !

Votre première animation avec Motion
1 Création de l’animation
VOUS ALLEZ CRÉER UNE ANIMATION
que vous pourrez utiliser dans iMovie,
iDVD, Final Cut ou DVD Studio Pro. 
Faites menu Fichier > Nouveau, et dans
le menu local Préréglage de la fenêtre
de sélection des préréglages, choisissez
PAL DV. Enregistrez le projet. 

2 Mise en place d’une vidéo 
en fond de plan
DANS LA FENÊTRE DES UTILITAIRES, 
sur la gauche, cliquez sur Navigateur.
Recherchez dans votre disque dur 
le dossier Utilisateurs > Partagés > 
Motion > Médias d’initiation > National
Geographic. Glissez-déposez 
l’élément Clouds.mov sur le Canevas. 
Des guides apparaissent pour 
vous aider à centrer l’objet et l’agrandir
pour qu’il masque entièrement 
le fond noir de l’animation.

4 Mise en place d’une deuxième
couche et ajout d’un graphique
UNE COUCHE PEUT CONTENIR un ou 
plusieurs objets. Tirez sur la languette 
à gauche du Canevas pour faire apparaître
l’onglet Couches et visualisez les objets
composites contenus par chacune d’elles.
Retournez dans la Timeline, cliquez sur
le bouton « + » pour ajouter une nouvelle 
couche. Dans la fenêtre du navigateur, sélectionnez le dossier Utilisateurs > Partagés > Motion >
Médias d’initiation > Graphiques, puis le fichier GreenSquares.psd et glissez-le sur la nouvelle 
couche. Un menu contextuel apparaît : optez pour l’option Insérer, puis relâchez la souris.

5 Animez le fichier graphique
DANS LA TIMELINE, RÉGLEZ LA DURÉE de l’objet GreenSquares.psd en raccourcissant 
la barre comme vous le feriez dans iMovie ou Final Cut. 
Dans le Canevas, sélectionnez l’objet GreenSquares.psd, placez-le légèrement 
vers le bas de l’animation et de préférence sur la gauche.
Dans la fenêtre des Utilitaires, cliquez sur Bibliothèque, puis sur Comportements > 
Animation standard. Sélectionnez l’objet Fondu entrant/sortant et glissez-le sur l’objet
GreenSquares.psd dans le Canevas. Sélectionnez ensuite l’objet Trajectoire d’animation
et glissez-le sur l’objet GreenSquares.psd dans le Canevas. Comme vous le voyez, 
dans Motion, tout se fait facilement par glisser-déposer d’actions pré-programmées.
Utilisez le bouton Lecture pour visionner le rendu en temps réel. Le fichier 
graphique apparaît désormais de la gauche vers la droite en fondu entrant/sortant 
sans que vous n’ayez eu à effectuer vous-même aucun paramétrage.

3 Réglage de la durée 
de l’animation
CLIQUEZ SUR L’ICÔNE CONTRÔLE DE TEMPS
dans la barre des outils du Canevas pour faire apparaître la Timeline. Glissez la flèche 
de lecture pour réduire la durée de l’animation afin qu’elle concorde avec celle de la vidéo
Clouds.mov : 175 sec. 
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6 Ajoutez du texte
DANS LA TIMELINE, CLIQUEZ SUR LE BOUTON « + » pour créer une troisième couche, 
puis placez la tête de lecture en début de piste. Dans la barre d’outils du Canevas, 
sélectionnez l’outil Texte dans Créer, puis entrez l’intitulé « Chapitre I » comme 
si vous écriviez dans un traitement de texte. 
Faites apparaître la palette des réglages (Panneau de contrôle). Choisissez police 
et taille. Refermez la palette, puis dans la barre d’outils du Canevas, cliquez sur l’outil 
Sélecteur des Outils d’affichage pour bien placer votre texte au centre du Canevas 
et légèrement au-dessus du fichier graphique animé. Pensez enfin à régler la durée 
de l’objet texte dans la Timeline pour qu’il soit calé sur la durée de l’animation. 

7 Animez le texte
DANS LA BIBLIOTHÈQUE, sélectionnez Comportements > 
Séquence de texte > Texte-mouvement. Glissez l’objet Jump
In sur l’objet Texte dans le Canevas. Motion génère un effet
de saut des lettres sans aucun réglage de votre part.

8 Ajoutez du son
DANS LA BIBLIOTHÈQUE, naviguez sur votre disque dur 
pour localiser un fichier MP3, AAC ou AIFF, par exemple.
Placez la tête de lecture de l’animation au début 
de la piste. Glissez le fichier dans le Canevas.
Motion ajoute une piste audio en dessous du Canevas, 
juste au-dessus des boutons de lecture de l’animation. 
Vous pouvez déplacer la piste ou ajuster la durée du son.

9 Exportez l’animation
ENREGISTREZ VOTRE PROJET [Pomme + S]. 
Appuyer sur le bouton Lecture pour visualiser votre animation. 
Choisissez le menu Fichier > Exporter. Puis réglez les options
comme dans la copie d’écran ci-dessous.
Vous venez de créer votre première animation avec Motion.
Libre à vous maintenant d’importer la séquence obtenue dans
iMovie ou Final Cut, par exemple.
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D
efault Folder X se propose d’améliorer la gestion des fi-
chiers en palliant certaines faiblesses du Finder, notam-
ment dans les boîtes de dialogue standard d’ouverture et

d’enregistrement. De plus, il offre des fonctions qui vous permet-
tront d’optimiser la gestion de vos documents.
Default Folder est un nom qui ne vous est peut-être pas inconnu.
Cette version Mac OS X est l’héritière de celle qui avait déjà connu
un beau succès sous Mac OS 9. D’ailleurs, les possesseurs de la
version Mac OS ont droit à une remise pour la mise à jour. Cet
utilitaire est disponible en français grâce à Philippe Bonnaure,
localiseur émérite. On peut l’essayer gratuitement et il vous en
coûtera 42 € pour une licence complète. n Alain Lalisse

DEFAULT FOLDER X EST IMPLÉMENTÉ
en tant que panneau des Préférences
système . C’est donc là que vous
l’activez et que vous le configurez le
plus rapidement. Mais pour une 
utilisation de tous les jours, vous avez
trois possibilités d’accéder à ses
services : un bandeau d’icônes qui

s’accroche à droite des fenêtres
d’ouverture et d’enregistrement des
fichiers ; un menu qui s’ajoute en haut
à droite de l’écran ; un clic droit
sur l’icône du Dock qui déploie alors
une arborescence de menus . 
Default Folder est toujours à portée
de souris !

6

5

4

3

SI À CHAQUE FOIS QUE VOUS OUVREZ 
ou enregistrez un fichier, vous naviguez
dans une arborescence complexe 
de dossiers, Default Folder X est fait
pour vous ! Grâce à lui, je crée
un dossier « images traitées » et 
j’indique à Photoshop que ce dossier
sera utilisé à chaque enregistrement
et à chaque fois que je veux ouvrir
une image . Je fais de même 
pour mes principales applications 
qui auront donc toutes un dossier par
défaut – d’où le nom de l’utilitaire.
Simple, mais aussi très efficace ! Le
Finder de Mac OS X n’offre pourtant
pas de telles possibilités. 
Default Folder X ne fait pas
que cela. Son développeur lui
a intégré tout un ensemble
d’outils autour de la gestion
des documents. Vous pouvez

lui indiquer une liste de dossiers 
favoris (un peu comme les favo-
ris Internet). Il gère un accès visuel 
à toutes les fenêtres ouvertes 
du Finder. Il propose toute 
l’arborescence des fichiers en menus
hiérarchiques et il enregistre une liste
dynamique des dossiers récemment
utilisés (jusqu’à 100) pour les proposer
en accès direct. Enfin, cet utilitaire 
se propose de vous faciliter la gestion
courante : renommer, jeter, créer 
un nouveau dossier… directement 
depuis les dialogues d’ouverture 
ou d’enregistrement standard.

2

1

Optimisez la gestion des fichiers
Les boîtes de dialogue d’ouverture et d’enregistrement standard 
de Mac OS X ont été repensées : ergonomie et productivité assurées !Default Folder X 1.9.7

+ Très pratique pour naviguer ; améliore la productivité et évite les erreurs 
en sauvegardant chaque type de fichier dans un dossier spécifique ; 
bonne intégration avec le système ; en français.

- Un peu trop d’options secondaires, utiles certes, mais qui font parfois 
oublier la fonction de base de cet utilitaire ; un peu cher pour un utilitaire
système tout de même pas aussi indispensable.

PRIX : 42 € (mise à jour 24 €). 
ÉDITEUR : St Clair Software. 
CONFIGURATION MINIMALE : Existe aussi bien pour
Mac OS 9 que pour toutes les versions de Mac OS X.

PRISE EN MAIN

À chaque logiciel, son dossier

Jamais bien loin !

1
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D
rive Genius rassemble, sous une même inter-
face agréable, des fonctions simples à mettre
en œuvre (comme une défragmentation) et

d’autres beaucoup plus complexes, voire dangereuses
entre des mains non averties (l’édition directe des sec-
teurs du disque, par exemple). Il entre en concurrence
avec les « techtools », même s’il n’offre pas exactement
la même palette d’outils. Bien qu’il ne soit proposé
qu’en anglais, son utilisation ne présente pas beau-
coup de difficultés. En revanche, l’interprétation des
résultats impliquera souvent une lecture attentive de
la documentation. Mais tel est le sort de ces logiciels
dont le fonctionnement et les avis restent souvent
hermétiques. Sachez encore que la version actuelle
présente quelques limitations. Elle ne gère ainsi que
les disques HFS+, pas les disques Raid, ni certains
disques SCSI. Il faut de même éviter de l’utiliser sur
une partition Mac OS 9 bootable. 
Le principal atout de Drive Genius 1.0 est de pouvoir
regrouper, sous une seule interface, la plupart des
fonctions de contrôle, de maintenance et de récupé-
ration de disques. Vous avez tout sous la main. 

n Alain Lalisse

POUR LES VOLUMES, DRIVE GENIUS PROPOSE deux fonctions 
spécifiques : la réparation qui s’effectue en plusieurs étapes
(vérification, réparation, reconstruction à partir des données, 
réparation des permissions). Un outil de défragmentation 
a été ajouté, bien qu’avec Mac OS X et les disques 
de capacité importante, cette fonction soit de moins en moins
utile, sauf si vous jonglez avec de très gros fichiers.

13

12

DRIVE GENIUS DÉTECTE automatiquement 
les disques montés et les liste. Il travaille,
soit sur un disque entier (onglet Device ),
soit sur un volume (onglet Volume ).
Dans les deux cas, il propose des fonctions
spécifiques et des fonctions communes 
sous la forme de grosses icônes situées 
au bas de la fenêtre générale .
D’abord, pour travailler, Drive Genius 
démonte les disques. Ainsi, soit vous avez
deux disques de démarrage et basculez 
de l’un vers l’autre, soit vous vous fabriquez
un CD bootable embarquant Drive Genius 
ou bien vous attendez que Prosoft propose 
sa propre version CD – ce qui est prévu, mais
n’était pas disponible lors de notre test.
Les deux fonctions-clés de l’onglet Device

sont l’initialisation du disque 
et la modification de la configuration 
des partitions . Cette dernière opération
est effectuée sans reformatage, ce qui est 
un avantage certain par rapport à l’utilitaire
Disque d’Apple. On peut effacer une partition,
en ajouter une, la redimensionner ou 

la cacher aux yeux des indiscrets. Tout cela
s’effectue en quelques simples clics sur 
de gros boutons. Je vous invite à ce sujet 
à lire la prise en main de VolumeWoks 
dans VVMac n°1, car Drive Genius intègre 
en fait cet utilitaire de SubRosaSoft 
que nous avions testé. D’ailleurs, l’interface
utilisateur de l’ensemble de Drive Genius 
est calquée sur celle des produits 
de cet éditeur néo-zélandais.
Parmi les autres outils, la fonction Duplicate

copie bit à bit un disque sur un autre 
de taille au moins équivalente. Utile pour
passer à un disque de capacité supérieure.
Mais elle ne vérifie pas la structure, ni 
la bonne santé du disque. Pour cela, il existe
les fonctions Integrity Check et
Scan . Enfin, quelques fonctions annexes
ont été ajoutées : l’édition d’un secteur 
disque (uniquement si vous savez ce que
vous faites) , l’effacement sécurisé 
(à utiliser avant de se séparer d’un disque
qui a contenu des données sensibles)
et Benchtest (le test de rapidité).11
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Tout pour cajoler vos disques
Drive Genius est un intégré qui regroupe la plupart des outils 
de vérification, maintenance et réparation de disques.Drive Genius 1.0

+ Une interface simple qui regroupe tout ce qui est utile en ce domaine ; 
des outils majeurs : repartitionnement à la volée, réparation, 
défragmentation, duplication.

- Interface et documentation en anglais ; pas de distribution ni de support 
en France à ce jour (achat sur le Web).

PRIX : 99 $ 
ÉDITEUR : Prosoft Engineering 
CONFIGURATION MINIMALE : Non précisée 
par l’éditeur, logiciel testé ici sous Mac OS X 10.3.7

Réparez un volume

8117109654

3

2

12 13

1

Partitionnez au vol
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T
ous les utilisateurs Mac connaissent StuffIt Expander, fourni
en standard avec Mac OS X. «Couteau suisse» de la décom-
pression, StuffIt Expander s’avère indispensable car nombre

de logiciels Mac comptent sur lui pour décompresser fichiers et do-
cuments téléchargés depuis Internet. Mais Allume Systems (ancien-
nement Aladdin) propose également deux produits commerciaux :
StuffIt Standard et StuffIt Deluxe. Trois mois après la sortie améri-
caine, la version française de StuffIt Deluxe 9 est désormais dispo-
nible. Comme à chaque nouvelle version, les améliorations plus ou
moins importantes sont nombreuses. Mais je suis déçu : le premier
usage de StuffIt reste la compression, et les résultats de mes tests dé-
montrent qu’il n’est plus forcément la seule solution.

Une solution complète
Autour du moteur de compression, StuffIt Deluxe regroupe plu-
sieurs utilitaires. Archive Assistant programme des compressions
aux fins d’archives et leur stockage sur supports optiques. StuffIt
Express automatise des processus sophistiqués, impliquant des
compressions avec StuffIt Engine, en interaction avec d’autres logi-
ciels. Archive Search – qui n’est pas nouveau non plus – facilite la
recherche dans l’ensemble de vos archives .sit, .sitx, .tar et .zip. Et
le nouveau DropStuff , outil de compression et de segmenta-
tion, combine désormais les fonctions des anciens DropStuff,
DropZip et DropTar. Tout ce bric-à-brac est plus ou moins amé-
lioré dans la version 9, mais son utilisation reste marginale. Ainsi,
depuis que StuffIt Express et Archive Search existent (dans la ver-

sion 7, si je me sou-
viens bien), je ne
m’en suis jamais ser-
vi au quotidien.
Si vous possédez une
vieille version de
StuffIt Deluxe, c’est
que vous n’utilisez
pas toutes ses fonc-
tionnalités, alors
contentez-vous de
récupérer la toute
dernière version de
StuffIt Expander 9,
il vous sera toujours utile. À la rigueur, achetez StuffIt Standard, un
produit qui regroupe les fonctions d’Expander et DropStuff, mais
il n’est disponible qu’en anglais et affiche le prix un trop élevé de
50 $. Si vous mettez à jour systématiquement StuffIt Deluxe, c’est
que vous l’exploitez à fond. Vous avez alors tout intérêt à faire la
mise à jour pour 25 €. Les petits ajouts et améliorations valent tout
de même le coup. Quant à acheter pour la première fois StuffIt De-
luxe (65 €), à vous de voir si vous avez vraiment besoin de tous les
outils qu’il contient... Si votre besoin se limite à compresser quel-
ques fichiers que vous envoyez par Internet ou stockez sur un CD-
RW, le .zip du Finder vous contentera amplement. 

n Bernard Le Du

1

Y A-T-IL UN AVANTAGE À ACHETER STUFFIT 
STANDARD OU DELUXE alors que le Finder de Mac
OS X propose la compression Zip ? J’ai mesuré 
les temps et le niveau de compression de deux 
dossiers différents, l’un de 86 Mo, l’autre beaucoup
plus important de 1,37 Go, contenant des fichiers 
divers : maquettes XPress, images JPeg, images 
Tiff et quelques .mov. Tout ceci sur un Macintosh G4
1,25 GHz équipé de 1 Go de Ram. Les résultats 
obtenus ne sont pas à la faveur de StuffIt. 
Seule la compression de type .sitx s’en tire à peu
près bien à condition de choisir l’option Rapide lors 
de la compression. L’option Optimisée offre un gain
de 20 % en place (sur mon dossier de 88 Mo) 
mais prend presque cinq fois plus de temps ! 
Pas rentable. De plus, le format .sitx ne s’est pas 
imposé, d’où des complications si les fichiers sont

communiqués à des tiers. Beaucoup devront 
se connecter à Internet pour trouver StuffIt Expan-
der pour Mac ou Windows afin de décompresser
l’archive reçue. Bien entendu, vous pourriez tenter
de régler les préférences de compression.
Mais qui va s’amuser à perdre 
son temps à jongler avec 
des paramètres abscons pour
le commun des mortels ?
Donc, s’il n’a pour lui que 
la compression, StuffIt 
Deluxe n’est pas aujourd’hui
un logiciel performant,
ni même rentable. 
Heureusement, il est fourni
avec d’autres outils qui 
peuvent se révéler utiles
pour certains utilisateurs.
Le fait que le moteur 

de StuffIt Deluxe 9 ait été écrit pour gérer plusieurs
processeurs s’avère finalement assez anecdotique.
Le gain constaté est d’environ 28 %. Ceci ravira
simplement les professionnels sur PowerMac G4 
et G5 bi-pro, créateurs de très gros fichiers.

En mal d’inspiration et de souffle
Le neuvième opus de cet ensemble d’outils de compression 
et de gestion des fichiers compressés a bien du mal à me convaincre.StuffIt Deluxe 9

+ Regroupe de nombreux utilitaires autour d’un moteur de compression ; 
version localisée.

- Le moteur de compression de StuffIt ne rivalise avec la fonction .zip 
du Finder que lorsqu’on utilise le mode .sitx rapide ; la pléthore d’utilitaires
inclus ne sera pas d’une grande utilité dans le cadre d’une utilisation 
courante de votre Macintosh.

PRIX : 65 €
ÉDITEUR : Allume Systems. 
DISTRIBUTION : Apacabar (France).
CONFIGURATION MINIMALE : Mac OS X 10.3.x

PRISE EN MAIN

Application Format utilisé Poids compressé Temps de compression

Poids du dossier original : 1,37 Go 

Finder Mac OS X .zip 880,7 Mo 0:08:55

StuffIt Deluxe

.zip Opération annulée après plus de 10 min.

.sit Opération annulée après plus de 10 min.

.sitx (rapide) 400,8 Mo 0:08:28

Poids du dossier original : 86 Mo

Finder Mac OS X .zip 50,1 Mo 0:01:39

StuffIt Deluxe

.zip 50,1 Mo 0:01:24

.sit 50,1 Mo 0:00:50

.sitx (rapide) 50,6 Mo 0:00:41

.sitx (optimisé) 47,1 Mo 0:04:28

Seul le .sitx vaut le coup

1
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G
uest PC est basé sur une
technologie développée
par Lismore Software

Systems qui a déjà à son catalo-
gue l’émulateur PC BlueLabel
pour Mac OS 9. Il fonctionne
sur G4 et G5 et émule un PC
basique, mais suffisant pour ins-
taller tous les OS Microsoft ou
Linux. Vous pouvez ouvrir plu-
sieurs PC simultanément, cha-
cun avec un OS différent et son
propre disque dur virtuel.
Mais comme avec VPC, il est
nécessaire de posséder une ma-
chine puissante et beaucoup de
mémoire pour en accorder 512
Mo à chaque machine virtuelle
ouverte. Guest PC supporte le
fenêtrage ou le plein écran (mais
sur les écrans allongés qu’affec-
tionne Apple, il pourra rester
des bandes noires à gauche et à
droite). Au mieux, vous aurez

du 1280 x 1024. Guest PC gère
bien entendu le clavier, la souris,
mais également le port Ethernet,
le lecteur de CD/DVD, le mo-
dem et le son. Mais pas l’USB et
le FireWire. Il émule aussi une
imprimante LaserWriter Select
360. Tout ceci s’installe rapide-
ment (additions fournies) après
l’installation de Windows qui
est, elle, assez longue (comptez
trois heures !). 
L’intégration de Guest PC est
donc assez sommaire et il vous
faudra une bonne connaissance
de Windows. Par exemple,
vous devrez paramétrer, comme
sur un vrai PC, la connexion
réseau. Les développeurs ont
prévu tout de même quelques
facilités intéressantes comme la
prise en charge d’images CD
sous forme de fichiers .ISO ou
.IMG. Les touches spéciales et

leurs combinaisons, comme
[Ctrl + Alt + Delete] ou [Print
Screen], sont émulées par menu.
Sur PowerBook 1 GHz, avec
seulement 512 Mo, ça tourne
plutôt pas mal pour une utilisa-
tion ponctuelle bureautique, s’il
n’y a pas de solution logicielle

équivalente sous Mac OS X.
Mais pas question de jouer au-
trement qu’aux cartes ou à la
bataille navale ou de faire du
multimédia ! Guest PC est en
anglais et livré juste avec un
DOS (non Microsoft). Son prix
est abordable. n Alain Lalisse

PAS QUESTION DE GLISSER-DÉPOSER UN FICHIER DU MAC vers la fenêtre de l’émulateur, 
ni de partager un dossier comme avec Virtual PC. Pour transférer des données 
d’un environnement à l’autre, deux solutions. Solution 1 : vous créez un partage 
de fichiers et utilisez les deux environnements comme s’ils étaient physiquement sur 
un réseau local. C’est lourd et c’est difficile à paramétrer, alors on oublie ! Solution 2 : 
fermez Guest PC et double-cliquez sur l’icône de la machine virtuelle utilisée 
(Windows XP, par exemple). Elle va alors monter sur le Bureau du Mac. Il suffit de copier
les fichiers dans un sens ou dans l’autre, le tour est joué. On regrettera seulement 
qu’il faille un peu fouiller dans la documentation (en anglais) pour trouver ces astuces.

UN ASSISTANT EST INTÉGRÉ POUR L’INSTALLATION DES SYSTÈMES
Microsoft. Vous pouvez avoir autant de machines virtuelles que vous 
le souhaitez, chacune correspondant à un fichier sur le disque dur 
du Mac. Il suffit de faire New PC. Vous indiquez le type d’OS (Dos,
Windows 95, 98, NT, 2000 ou XP), la taille du fichier disque PC (jusqu’à
32 Go), la mémoire maximale utilisée par le PC et vous donnez 
un nom à la machine virtuelle qui sera créée dans Documents
de votre dossier personnel. Pour les systèmes Windows, il faut aussi
entrer les informations propres à l’OS, notamment la clé du produit.
Le CD de Windows XP bootable est bien reconnu comme tel par 
Guest PC. Je vous conseille de quitter toutes les autres applications 
et de ne plus rien faire sur le Mac pendant l’installation. En cas d’arrêt
prolongé (plusieurs dizaines de minutes pour être sûr), redémarrez
Guest PC ; l’installation devrait reprendre au point de blocage. 
Attention, l’installation de XP demande plusieurs heures 
(sur un PowerBook G4). Restez donc zen et laissez-le tourner 
en jetant juste un petit coup d’œil de temps en temps.
Le Dos étant déjà intégré à Guest PC, créer une machine virtuelle 
Dos prend moins d’une minute. Ce système basique, mais complet, 
est très peu gourmand et l’émulation s’avère alors très rapide !

Il invite Windows sur votre Mac !
Successeur de BlueLabel, ce nouvel émulateur PC fonctionne autant 
sur G4 que sur G5, le tout sous Mac OS X 10.3.x.Guest PC 1.0

+ Toutes les fonctions utiles sont présentes ; le prix est agressif, 
c’est l’émulateur le moins cher du marché ; l’intégration du DOS ; 
une bonne réactivité pour les applications bureautiques.

- L’intégration étant plus limitée qu’avec VPC, il faut bien connaître Windows
pour en paramétrer les fonctions ; la documentation de Guest PC est 
en anglais et, si elle est précise et pratique, elle n’est pas toujours correcte.

PRIX : 70 $ (environ 55 €)
ÉDITEUR : Lismore Software Systems. 
DISTRIBUTION : Par Internet.
CONFIGURATION MINIMALE : Macintosh G4 ou G5, Mac
OS X 10.3, de 256 à 512 Mo libres par machine virtuelle
et plusieurs gigaoctets sur disque pour chacune.

Passez des données Mac à PC

Installez Windows XP ou DOS
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L
es polices de caractères,
dans Mac OS X, il y en 
a vraiment un peu par-

tout. Dans la Bibliothèque du
système, dans la Bibliothèque
générale, dans la Bibliothèque
de chacun des utilisateurs, sans
oublier le dossier Polices de
votre éventuel environnement
Classic ! Apple fournit cepen-
dant le Livre des polices avec
Mac OS X, me direz-vous.
Mais si vous êtes dans les mé-
tiers de la presse, de l’édition,
des arts graphiques et de la
communication, il se peut que
ce livre ne soit pas à la hauteur.
Le meilleur gestionnaire alter-
natif est selon moi FontAgent
Pro (qui n’est malheureusement
pas localisé). D’une grande
souplesse (avec ou sans gestion
des polices système), il pré-
sente une bonne ergonomie (le
glisser-déposer est ainsi large-
ment utilisé). Dans cette ver-
sion 3, naviguer dans les li-
brairies est plus fluide. La
vérification de l’intégrité des

polices se fait en un clin d’œil
et l’auto-activation des polices
au lancement d’un logiciel est
instantanée. L’interface utilisa-
teur évolue peu, mais vous dis-
posez désormais d’une fonc-
tion de recherche en temps réel
sur des métadonnées, avec le
renfort de filtres . 
Un panneau permet de compa-
rer côte-à-côte (en wysiwyg)
autant de polices que vous
voulez . Nombre d’amélio-
rations par petites touches ren-
dent l’utilisation de FontAgent
Pro vraiment très confortable.
Lors de l’import de polices, as-
sisté ou manuel, vous avez le
choix de déplacer dans un dos-
sier spécifique unique toutes
les polices que vous donnez à
gérer, ou de les recopier sim-
plement dans ce même dossier.
Vous pouvez également, dans
les Préférences, demander à
FontAgent Pro de gérer ou non
les polices du répertoire Sys-
tème. Personnellement, Font
Agent Pro gère l’ensemble de

mes polices qui sont toutes
rangées et organisées dans son
dossier FontAgent Pro Fonts.
C’est plus simple et je n’ai ja-
mais eu le moindre problème. 
Pour ceux qui travaillent en
groupe, FontAgent Pro 3, en
licence Workgroup, permet de
partager des librairies et sets
de polices non par un système
de serveur centralisé, mais via
le protocole Rendezvous qui ne
nécessite aucun paramétrage

réseau. Si dans votre activité
professionnelle, vous devez sto-
cker et gérer pour vous-même,
vos collaborateurs, voire vos
clients, un très grand nombre
de pilotes, FontAgent Pro 3 est
alors vraiment un must. 
D’ailleurs, n’hésitez surtout pas
à l’installer sur toutes vos ma-
chines : vous pouvez l’essayer
pendant trente jours, fonction
réseau comprise.

nBernard Le Du

3

2

1

C’EST LA SIMPLICITÉ MÊME ! Dans 
la fenêtre de FontAgent Pro 3 – dans 
la zone en haut à droite –, cliquez sur 
l’onglet Sharing (Partage) . La liste 
affiche les polices partagées sur 
le réseau, rangées par nom de machine

. Si vous voulez vous-même 
partager des polices, il suffit de cliquer
sur Enable Font Sharing et de glisser
dans la fenêtre une police ou un set 
de polices, immédiatement mis à la 
disposition des autres utilisateurs. Ce système impose que les machines soient 
actives. Mais rien ne vous empêche de mettre toutes vos polices sur un seul Mac 
toujours en fonctionnement et de les partager avec Rendezvous, comme 
dans une configuration serveur traditionnelle – sans avoir à en payer le prix.

5

4

Polices sur Rendezvous
C’était déjà le meilleur gestionnaire de polices pour Mac OS X. 
La version 3 rajoute le partage en réseau local sur simple Rendezvous.FontAgent Pro 3

+ La fonction de recherche avec filtres, très pratique ; le panneau 
de comparaison wysiwyg ; la fonction de partage en réseau 
via Rendezvous ; une auto-activation immédiate, signalée à l’écran 
par une fenêtre fugitive translucide ; de nombreuses améliorations, 
subtiles, de l’interface utilisateur.

- Pas de localisation en français.

PRIX : 100 $ (env. 77 €) pour la version sans 
fonction Rendezvous activée ; 130 $ (env. 100 €)
pour la version Workgroup Edition.
ÉDITEUR : Insider Software. 
DISTRIBUTION : Par Internet.
CONFIGURATION MINIMALE : Mac OS X 10.2 et 10.3.

PRISE EN MAIN

Partagez lespolicesenréseau Auto-activation rapide
FONTAGENT PRO 3 EST FOURNI avec plusieurs 
plug-in d’auto-activation pour les principaux 
logiciels de création professionnels : Photoshop, 
InDesign, Illustrator et XPress 5 et 6.

3

4

5

1

2
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Il existe toujours des millions de particuliers de par le monde 
qui utilisent d’anciens Mac sous Mac OS 7, 8 ou 9. Pour enfin
effectuer leur saut vers Mac OS X, beaucoup attendaient 

– et désespéraient – qu’Apple propose un jour une machine 
performante et peu onéreuse. Dans les secteurs professionnels 
de la presse et de la communication, chez des architectes et 
des cabinets de médecins, dans des écoles… des millions de vieux G3
aspirent en effet à prendre une digne retraite. Avec le Mac Mini, 
Apple peut donc envisager de reconquérir son propre marché. 
Avec son dernier-né, Apple prétend également séduire autant 
que possible les utilisateurs PC déçus de Windows, en quête 
d’une solution alternative séduisante, éprouvée et fiable. Et faire
enfin craquer toutes celles et ceux, néophytes, jeunes ou seniors, 
qui rêvent de posséder un ordinateur de bonne composition, simple 
« à vivre avec ». Depuis l’Apple II et le tout premier Macintosh, 
c’est la troisième fois de son histoire qu’Apple dispose d’une
puissante arme de conquête. Mais pour que cette stratégie
puisse réussir, encore faut-il que le Mac Mini tienne 
ses promesses. Premier essai et premières tentatives de réponse.

n Bernard Le Du et Alain Lalisse

[DOSSIER]
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Il tient toutes ses
promesses !

Mac Mi ni
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Mi ni

à tout faire !
avec un p’tit Mac
Rencontre
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[DOSSIER]

J
e me suis rendu, comme
beaucoup de journalistes
et de grands clients, à la

Maison de la Radio, à Paris, en
cette soirée du 11 janvier où
Apple Europe retransmettait
par satellite et en exclusivité la
keynote inaugurale de la Mac-
world Expo de San Francisco.
Bien que pressé par la foule ex-
citée, j’avais eu l’occasion d’en-
trevoir quelques minutes le Mac
Mini. Aussi, lorsque j’en ai reçu
un exemplaire à la rédaction, ce
n’était plus vraiment pour moi
une découverte. Toutefois, ce
n’est qu’à ce moment-là que j’ai
vraiment « percuté » et saisi à
quel point le Mac Mini est…
mini. D’abord, ce n’est qu’un
petit carton tout marron qu’on
vous livre. On l’ouvre et on y

trouve une belle petite boîte.
Qu’on ouvre pour tomber sur…
une autre boîte, très sobre, très
minimaliste : le Mac Mini.

Vraiment mini !
L’objet est un parallélépipède de
16,5 cm en largeur et profon-
deur, épais de 5 cm, le tout pour
un poids plume de 1,3 kg. Il res-
semble à un gros disque dur ex-
terne ou à une boîte à biscuits.
Les quatre coins sont arrondis.
Le tour du couvercle est en alu-
minium brossé ; le dessus cons-
titué d’une assez fine couche de
polycarbonate blanc nacré est
frappé d’une pomme gris ar-
gent. Sur le devant, rien que la
très discrète fente du lecteur  op-
tique combo (ou du Superdrive)
ainsi qu’un minuscule voyant

indiquant que le Mac Mini est
sous tension. Évitez de placer
quoi que ce soit sur le dessus du
Mac Mini : d’une part, le poly-
carbonate est relativement sou-
ple ; d’autre part, le blindage 
intérieur du couvercle est percé
à deux endroits correspondant
aux emplacements des antennes
AirPort et Bluetooth qui poin-
tent donc vers le haut. Poser un
objet métallique pourrait per-
turber les communications.
Vous pouvez utiliser le Mac
Mini aussi bien en position ho-
rizontale que verticale. En posi-
tion horizontale, il glissera
moins facilement grâce à son re-
vêtement de gomme. Veillez
dans tous les cas à laisser l’air
circuler librement. La prise d’air
s’effectue sur trois côtés par le

dessous – c’est donc une très
bonne idée de surélever un peu
le Mac Mini – et l’évacuation à
l’arrière, au-dessus des ports
d’entrée/sortie. 
Justement, l’ensemble des ports
d’entrée/sortie est assez com-
plet. On recense à l’arrière, ou-
tre le bouton d’allumage, une
prise FireWire 400, deux prises
USB 2.0, un connecteur DVI,
un port réseau Ethernet 10/100
BaseT, une prise modem 56k
V.92 et une sortie casque audio
et stéréo. Dommage qu’Apple
n’ait pas pensé à mettre le même
port audio analogique/numéri-
que déjà présent sur les iMac et
PowerMac G5. 
Pour bénéficier du son 5.1 des
DVD-vidéo, vous devrez trou-
ver un adaptateur, sinon vous

Steve Jobs a de la suite dans les idées… et le don 
de transformer avec le temps les échecs en succès.
Ainsi l’étonnant, mais anecdotique, système 
d’exploitation NeXT s’est finalement imposé au monde
grâce à Mac OS X. Et le design du génial, mais trop 
élitiste, Cube va peut-être connaître un immense 
succès populaire grâce au Mac Mini.

Mac Mini
Premiers tests

36 Mars 2005Vous et Votre Mac

Antenne 
Airport

Antenne 
Bluetooth

1

2 3 4 5 6 7 8

9

10

Bouton d’allumage
Branchement de l’alimentation
Port Ethernet 10/100 BaseT
Modem 56k V.92
Prise vidéo DVI5

4

3

2

1 2 ports USB 2.0
Port FireWire 400
Sortie jack audio stéréo
Port Kensington (sécurisation)
Évacuation d’air10

9

8

7

6
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vous contenterez de la stéréo.
Enfin, un port Kensington per-
met de sécuriser le Mac Mini.
Une préoccupation majeure des
utilisateurs, surtout dans des
lieux publics ou semi-publics :
le Mac Mini se glisse ni vu ni
connu dans un cartable, un at-
taché-case ou un sac à main ! 

Quelques compléments 
à acheter rapidement
Un hub USB 2.0/FireWire 400
va s’avérer nécessaire car, même
avec le renfort d’un clavier fi-
laire Apple (qui propose deux

ports USB 1.1 de plus) ou d’un
écran équipé d’un hub USB, les
possibilités d’extension seront
vite saturées. Rien qu’avec un
clavier et une souris USB, vous
n’avez plus de prise de libre !
Pensez aussi à un kit d’enceintes
car le haut-parleur interne du
Mac Mini est anémique.
Bref, on a vite fait le tour du
propriétaire. Il n’y a plus qu’à
procéder à l’installation. Avant
toute chose, il faut trouver un
écran, un clavier et une souris.
Je mets la main sur un modeste
écran LCD 15” Iiyama (que je

remplacerai ensuite par un Dell
20”) que je branche grâce à
l ’adaptateur VGA fourni
(l’adaptateur S-vidéo et compo-
site nécessaire pour se raccorder
à une télévision ou certains pro-
jecteurs est une autre option). 
En ce qui concerne le couple
clavier/souris, après plusieurs
essais, j’opte finalement pour
un ensemble sans fil Logitech de
technologie RF, parfaitement
géré grâce au pilote Mac OS X
proposé par le fabricant et livré
avec un remapping en règle du
clavier (qui a été conçu à l’ori-

gine pour être branché à un
PC). Le choix d’une souris, mais
surtout d’un clavier, est assez
délicat. Je vous invite à lire, ci-
dessous, l’encadré consacré à
cette question.

Un Mac, tout simplement
Démarrage. Rien de particulier
à signaler. Petit tour dans les in-
fos système : la vitesse du bus
système est de 167 MHz. Le
processeur tourne à 1,42 GHz
et intègre 512 Ko de cache mé-
moire de niveau 2 (à la même
vitesse que le processeur).

Mac Mini Tient-il ses promesses ?

L’idée d’Apple, c’est que vous avez déjà un clavier et une souris. Soit parce que
vous possédiez déjà un Mac et que vous en changez, soit parce que vous étiez 
équipé d’un PC. Mais ce n’est pas si simple. Si vous avez un clavier et une souris
Apple, aucun problème ! Vous branchez et en avant Simone ! Mais si ce n’est pas
le cas, alors il faut entrer dans le détail…

e Pour la souris, c’est pas le choix qui manque…
Si vous possédez une souris à fil USB d’un autre fabricant, vous n’aurez aucun 
problème pour l’utiliser, avec ses deux boutons principaux et sa molette 
qui sont pris directement en charge par Mac OS X. Les éventuels autres boutons
de votre souris ne seront fonctionnels que si le fabricant propose un pilote 
pour Mac OS X qui permet de les exploiter et de les paramétrer. Pour recycler 
votre souris PS/2 sur un Mac Mini, il vous faudra trouver un adaptateur PS/2-USB
(13 € chez CDiscount). 
Les souris sans fil de technologie infrarouge ou RF ne seront gérées 
que si le fabricant propose un pilote Mac OS X. Pour ma part, je me suis servi 
sans difficulté de souris sans fil de marques Logitech et Microsoft. 
Les souris Bluetooth, quant à elles, s’interfacent parfaitement avec le logiciel 
de gestion BT de Mac OS X et sont pleinement fonctionnelles, sans pilote 
spécifique – mais pour seulement les deux boutons et la molette. J’ai fait le test
avec une souris Logitech Bluetooth MX900 et une des toutes premières souris 
BT de voyage, sortie chez Macally au printemps 2004.

e …mais il vaut mieux choisir un clavier conçu pour le Mac.
Si vous passez d’un PC au Mac Mini, l’utilisation de votre clavier va s’avérer 
problématique. Il y a de grande chance qu’il soit PS/2 (car certaines touches 
de fonction ne sont opérationnelles sur un PC que via une connexion PS/2). 
Dans ce cas vous devrez acheter un adaptateur pour le brancher.
Mais qu’il soit PS/2 ou USB, reste le problème du plan du clavier, de  la disposition
des touches (la «map» en anglais) . Le plan d’un clavier AZERTY pour PC est diffé-
rent de celle d’un clavier AZERTY pour  Mac. Je l’avais espéré, mais c’est non : Ap-
ple ne livre aucun nouveau plan de clavier avec Mac OS X. Sans doute parce que le
problème semble ne pas se poser avec les claviers QWERTY américains. C’est du

moins ce que laissent entendre ceux qui utilisent le Mac Mini outre-Atlantique. 
Le plus sûr est donc de vous servir soit d’un clavier Apple, soit d’un clavier conçu
à 100 % pour le Mac. Il y en a peu mais ça existe, notamment chez Macally et 
Kensignton. Des claviers qui servent parfois de hub USB, ce qui est rarement le
cas des claviers PC que j’ai testés jusqu’à maintenant. 
Les seuls claviers d’origine PC que j’ai pu utiliser avec succès sur le Mac Mini
– comme sur n’importe quel autre Mac, d’ailleurs – sont ceux (filaires ou RF), 
de Logitech pour lesquels un driver Mac OS X avec un plan de clavier adapté est
proposé par le fabricant. Faites un tour sur le site de Logitech et rapatriez le
Logitech Control Center pour Mac OS X. Installez-le.. Même si vous n’avez pas un
clavier Logitech, vous pourrez choisir dans le menu International le Clavier 
Logitech Français qui offre un mapping correct pour tous les claviers PC !  Notez
que même l’utilitaire IntelliType 5.1 pour claviers Microsoft, ne fournit pas, lui,  un
plan de clavier correct à 100%.  Il y a toujours quelques inversions gênantes, 
notamment de signes très utilisés sur Internet. Par exemple, les touches [#/@] et
[</>]. Et les 2 et & ne sont pas à leur bonne place.
Les claviers Bluetooth de Logitech et Microsoft n’ont pas de pilote pour Mac OS X,
mais certains utilisateurs ont réussi à utiliser un Logitech diNovo BT. Si votre Mac
Mini est équipé  Bluetooth et que la bidouille n’est pas votre fort, achetez le clavier
BT d’Apple et une souris BT à deux boutons/une molette chez un autre fournisseur 
– à moins que vous ne teniez absolument à la souris à un seul bouton…

Àla recherche d’un 
clavier et d’une souris
Le Mac Mini est fourni sans ces indispensables 
accessoires. À vous de trouver votre couple idéal.

aaa
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Ouvrir le Mac Mini, c’est finalement assez simple une fois qu’on a pris 
le coup de main. L’appareil n’est en fait qu’une boîte. Toutefois, les deux 
éléments qui la composent (le corps et le couvercle) sont clipsés. Et pas
qu’un peu ! Pour les désolidariser, il suffit de les… déclipser. Apple ne vous 
interdit pas d’ouvrir le Mac Mini pour changer la barrette de mémoire 
vous-même. Toutefois, si vous cassez plusieurs clips, vous aurez tout intérêt 
à ne pas vous manifester auprès du SAV avant que votre garantie n’expire…
Cela dit, les clips sont assez gros et si vous êtes un tantinet précautionneux,
cela ne devrait pas poser trop de problème. De plus, les clips sont nombreux 
et si vous en cassiez par malheur un ou deux, cela ne vous empêchera pas 
de refermer le Mac Mini et de l’utiliser comme si de rien n’était. Enfin, 
cette opération ne se fera sans doute qu’une fois ! Ce n’est pas demain 
que les barrettes de 2 Go seront accessibles. Quant à changer d’autres 
composants internes, c’est nettement plus compliqué : lorsque vous aurez
ouvert votre Mac Mini, vous comprendrez qu’il vaut mieux éviter d’y mettre
vos petits doigts – même si vous avez mis la main sur le Guide illustré 
de démontage qu’Apple destine aux revendeurs et services de maintenance.

Couteaux, vous avez dit couteaux ?
Préalable indispensable pour ouvrir efficacement un Mac Mini : se procurer
un ou deux couteaux de peintre, à la fois souples et très fins . 
Ceux-ci servent habituellement à reboucher des petites fissures dans 
les murs, avant la mise en peinture. Essayez d’en trouver qui soient 
assez larges afin que, lors de l’ouverture, la pression exercée soit répartie
sur plusieurs clips. Si leur tranchant est trop épais, vous devrez l’amincir
avec du papier de verre ou une meule.
Débranchez le Mac Mini du secteur et retournez-le. Positionnez-vous 
sur un des deux côtés, vers l’arrière, près du panneau des ports
d’entrée/sortie. À cet endroit, il faut insérer verticalement la lame entre 

1

[DOSSIER]
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Dès la commande de votre Mac Mini, Apple recommande de choisir la taille mémoire que vous désirez avoir. 
Mais comme la barrette de 1 Go coûte plus de 350 €, certains peuvent songer à prendre la configuration de base 
puis à monter eux-mêmes une barrette achetée ailleurs. C’est possible et en voici le modus operandi.

Changez vous-même la barrette 
mémoire de votre Mac Mini

1

2

3

4
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Des «options» plus 
abordables
Dix jours après l’annonce du Mac Mini, Apple a revu à la baisse 
le prix de quelques-unes de ses options.
Si vous ambitionnez 1 Go de mémoire pour votre Mac Mini, 
sachez qu’il ne vous en coûtera plus que… 330 € au lieu des 430€
annoncés au départ. Malgré cette évolution louable, la barrette Apple
reste encore très chère. Cela vaut le coup d’acheter sur des sites, 
en France et en Allemagne, la barrette de 1 Go à 173 €, d’investir 
dans un ou deux couteaux de peintre et de démonter son Mac Mini
vous-même. En revanche, si vous voulez les extensions AirPort 
et Bluetooth, il faudra mieux le faire dès la commande car de toute
façon, seul Apple vend les puces et les antennes pour Mac Mini. 
Il ne vous en coûtera finalement que 100 € (et non les 128 € annoncés).
Par ailleurs, le constructeur avait baissé fin décembre le prix des clavier
et souris Bluetooth qui ne sont plus facturés que 59 € chaque.

39Vous et Votre MacMars 2005 39Vous et Votre Mac

Mac Mini Tient-il ses promesses ?

Le modèle que j’ai testé embar-
que 512 Mo de Ram DDR-
SDRam PC3200-30330, un dis-
que dur Toshiba 2,5” et 4200
tours/min MK8025 GAS de
74,53 Go disponibles, ainsi
qu’un lecteur combo DC-RW
CW-8123 de Matshita (Panaso-
nic). Le sous-ensemble vidéo,
implanté directement sur la carte
mère, est fourni par ATI. 
Il s’agit d’un processeur graphi-
que Radeon 9200 sur interface
AGP 4X épaulé de 32 Mo de
DDR dédiée. C’est la même con-
figuration vidéo que celle des
eMac et des iBook. Suffisant
donc pour supporter un affi-
chage numérique allant jusqu’à
1920x1200 pixels sur les moni-
teurs Apple Cinema Display 20
et 23” d’Apple, ou un affichage
analogique jusqu’en 1920x1080
pixels. Enfin, le modèle prêté
par Apple disposait des puces
AirPort Extreme et Bluetooth.

iLife 5 en standard
Outre Mac OS X 10.3.7 (build
7T21), Apple livre en standard
la toute dernière version d’iLife
(iPhoto 5, iMovie 5 HD, iDVD 5
et GarageBand 2) ainsi que l’in-
tégré bureautique AppleWorks
6.2.9, le logiciel de gestion fami-
liale Tous Comptes Faits Décou-
verte 3.6.7, et deux jeux : Mar-
ble Blast Gold et Nanausor 2.
Notez bien que iDVD 5 s’ins-

talle parfaitement puisque vous
pouvez très bien concevoir un
projet sur un Mac non équipé de
Superdrive. Nous avons donc
une trousse à outils plutôt com-
plète et de qualité. Même si Ap-
pleWorks a un peu vieilli, il offre
un traitement de texte complet,
un tableur, une gestion de fi-
chiers et un logiciel de dessin
vectoriel. Autant d’applications
de base indispensables.

Silence, ça tourne
Ah oui, j’oubliais ! Comme le
Cube, le Mac Mini possède une
alimentation externe très dis-
crète, petite et légère, qui ne
chauffe pratiquement pas. C’est
un avantage indéniable : le Mac
Mini n’intègre qu’un très petit
ventilateur indécelable à basse
vitesse. Un silence qui ravira
nombre d’utilisateurs. J’échan-
gerais bien mon PowerBook Alu
qui est particulièrement bruyant
lorsque la ventilation se déclen-
che – ce qui arrive plusieurs fois
par jour. Le Mac Mini s’avère
aussi beaucoup plus silencieux
que le Shuttle XPC Zen (un PC
mini réputé pour être un des
modèles les plus silencieux du
marché) qui me sert de Media
Center intégré à mon ensemble
Home Cinéma. Notez toutefois
que le lecteur optique combo
fait pas mal de bruit – comme
sur les autres machines.

la boîte en plastique et le couvercle en aluminium . Forcez un peu,
mais surtout pas trop. Si cela ne rentre pas, affinez encore 
la lame. Celle-ci va descendre à l’intérieur et verticalement d’environ 
un centimètre. À ce moment-là, reprenez votre souffle et, doucement
mais fermement, appliquez une pression sur votre couteau 
(vers l’extérieur). Le couteau va repousser légèrement les clips. 
Ça doit venir. Poursuivez : le corps du Mac Mini va se déboîter. Faites 
la même chose sur le côté opposé . Vous allez peut-être devoir 
vous y reprendre à deux fois. N’ayez pas peur, même si vous entendez 
le plastique crisser. Une fois que les deux côtés sont bien dégagés, 
saisissez le panneau arrière et tirez un peu pour déclipser l’avant .
Voilà, c’est fini !

e Changez la barrette
Vous allez immédiatement apercevoir la barrette mémoire 
qui prend tout un côté de la structure. Si vous avez acheté un modèle
avec module Bluetooth intégré, il vous faudra tout d’abord mettre 
de côté l’antenne qui gêne l’accès à la mémoire. Il suffit pour cela 
de dévisser un tout petit peu la minuscule vis cruciforme que vous
découvrez sous l’antenne BT et juste au-dessus de la barrette.
Une fois votre antenne retirée (surtout, ne pliez pas le fil et agissez 
avec la plus grande douceur !), faites comme d’habitude pour déloger 
la barrette de son emplacement. Bien entendu, comme il n’y a qu’un seul
emplacement, la barrette de 256 Mo que vous échangez pour 
une autre de 1 Go sera perdue, à moins que vous n’en trouviez l’utilité
dans un autre Mac ou un PC).
Refermer le Mac Mini est l’opération la plus simple d’entre toutes. 
Repositionnez bien le couvercle au-dessus du corps de l’appareil, puis
appliquez une pression uniforme. Ne forcez pas ! Le couvercle 
devrait s’emboîter sans difficulté. Vous entendrez le « clac » des clips 
qui s’enclenchent. Voilà, votre Mac Mini est prêt.

7
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En conclusion
Le Mac Mini est un ordinateur
polyvalent. À la différence du
Cube, perçu comme un exercice
de style, il est sans doute l’ordi-
nateur le plus « anonyme »
qu’Apple ait jamais produit.
Vendu sans écran, clavier et sou-
ris, il affiche une conception mi-
nimaliste et un prix étudié pour
« viser large ». C’est la machine
à tout faire, à la maison comme
au bureau. Bureautique, com-
munications, Internet, etc., sont
autant d’applications qui ne de-
mandent pas plus. Pas de pro-
blème pour la conception Inter-
net et le développement de logi-
ciels, ni pour la création perso et
même pro, en illustration 2D, re-
touche photo et PAO. Après tout,
la plupart des journaux et maga-

zines réalisés sur Mac le sont en-
core avec des G3 et des G4. En
revanche, le Mac Mini n’est sans
doute pas taillé pour les calculs
3D création ou jeu ou les effets
graphiques ou vidéo temps réel. 
Le Mac Mini séduira les profes-
sionnels libéraux ou indépen-
dants, les entreprises et établisse-
ments d’éducation et de forma-
tion qui attendaient d’Apple une
machine simple, sans écran, fa-
cile à maintenir... et pas chère. 
Pour une utilisation en entre-
prise, dans un cabinet médical
ou dans une école, il suffira bien
souvent de rajouter l’écran et le
couple clavier-souris. Le Mac
Mini est alors une bonne affaire.
Pour les particuliers, dans le ca-
dre de la famille, ce n’est pas tou-
jours aussi évident… Avec des 

« options » bien souvent néces-
saires (la mémoire) et des achats
complémentaires (un écran 17
ou 20”, un disque externe, un
hub USB/FireWire, des adapta-

teurs et boîtiers divers…), l’achat
d’un iMac G5 pourrait s’avérer
plus intéressant. À vous de bien
réfléchir, de faire vos additions,
et le bon choix !

iMacG5 @ 1,80 GHz 17”

iMacG5 @ 1,60 GHz 17”

iBook G4 @ 1,33 GHz

eMac G4 @ 1,25 GHz

iMacG4 @ 1,25 GHz 17”

Mac Mini G4 @ 1,42 GHz

0 20 40 60                                   80                                  100                                  120

Le Mac Mini livré à la rédaction était équipé d’un processeur G4 à 1,42 GHz 
et de 512 Mo de Ram. Après passage de notre batterie de tests, j’obtiens 
un indice global très proche de ceux constatés sur d’autres Mac équipés 
d’un processeur équivalent. Il se montre toutefois nettement plus 
performant qu’un iBook G4 1,33 GHz. Pourtant, le Mac Mini est presque 
un iBook reconditionné : processeur G4, disque dur, lecteur optique, mémoire,
sous-ensemble graphique… sont identiques d’une machine à l’autre. 
Il est aussi un peu plus véloce qu’un iMac G4 1,25-17, mais un poil en-dessous 
du eMac G4 1,25 GHz, le disque dur faisant sans doute ici la différence.

e Le disque dur du Mac Mini n’est ni très gros, ni rapide. 40 ou 80 Go, 
si vous êtes un tantinet créatif, vous verrez que cela se remplit très vite ! 
Si vous faites un peu de montage vidéo, songez à acheter un disque dur 
externe FireWire 400 ou USB 2.0.

e J’ai également utilisé le Mac Mini avec seulement 256 Mo de Ram. C’est 
possible, mais vraiment offrez-vous 512 Mo ! Pour 80 € de plus, vous connaîtrez
un tout autre confort d’utilisation ! Avec les 256 Mo de la configuration 
de base, difficile d’exploiter pleinement Mac OS X et d’ouvrir simultanément
plusieurs applications tout en maintenant une parfaite fluidité. De plus, Apple

vend la barrette de 512 Mo au prix du marché. Si vous avez oublié, 
vous pourrez toujours augmenter vous-même la mémoire par la suite 
(je vous explique comment procéder un peu plus haut dans ce dossier).

e La mémoire vidéo dédiée est un bon point par rapport à nombre des PC 
à très bas prix qui ponctionnent en fait la mémoire centrale. Mais, pour 
un ordinateur qui sera aussi utilisé pour la vidéo, le multimédia et le jeu, 
on aurait aimé avoir un sous-ensemble vidéo un peu plus musclé, comme celui
qui équipe les PowerBook G4, par exemple (au moins 64 Mo de mémoire 
dédiée). Toutefois, le sous-ensemble vidéo est suffisamment dimensionné
pour utiliser pleinement Quartz et bénéficier des effets graphiques 
de Mac OS X, comme Exposé par exemple, à une résolution de 1024x768. 
Au-delà de 1280 x 960, des problèmes apparaissent. Toutes les applications 
de création 2D et de PAO passent ainsi sans aucun problème. 
Nos essais avec iMovie HD (iLife 05) n’ont pas mis le Mac Mini à genoux, 
mais l’importation de la vidéo s’avère toutefois très laborieuse. Je n’ai 
personnellement pas installé de jeux sur le Mac Mini et je n’ai donc aucun 
commentaire à faire, si ce n’est qu’il n’y a aucune raison pour que le Mac Mini 
ne soit pas pareillement performant en la matière par rapport aux autres Mac
G4 dotés de la même carte graphique.

Configurations et options proposées par l’Apple Store
Mac Mini 1 Mac Mini 2
PowerPC G4 à 1,25 GHz PowerPC G4 à 1,42 GHz
256 Mo de SDRam DDR333 256 Mo de SDRam DDR333
Disque dur Ultra ATA de 40 Go Disque dur Ultra ATA de 40 Go
Lecteur combo Lecteur combo
Sortie DVI ou VGA Sortie DVI ou VGA

499 € 599 €
Option AirPort 50 €
Option Bluetooth 50 €
Option Superdrive 100 €
Option mémoire 512 Mo 80 €
Option mémoire 1 Go 350 €
Clavier Bluetooth 59 €
Souris Bluetooth 59 €

Performances : le Mini se comporte bien, mais sans surprise

Plus la barre est longue, plus 
la machine est performante.

Indice de performance Vous et Votre Mac
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Mac Mini Tient-il ses promesses ?

Transformez
votre Mini en Media Center !

Pour mériter le label Media Center, votre Mac Mini doit être à même de remplacer votre chaîne 
stéréo et votre lecteur de DVD-vidéo. Et s’il pouvait faire également office de magnétoscope numérique,
ce serait vraiment parfait. C’est certes possible, mais la facture peut être « salée ».

S
orti de son emballage, le Mac Mini ne
saurait immédiatement prétendre au
rôle de Media Center et jouer la star

au cœur de votre salon ! Comme tout autre
Mac, il constitue une bonne base de départ,
et dans ce cas précis, la moins onéreuse… Il
faut cependant l’épauler de pas mal d’op-
tions et autres accessoires annexes, et la fac-
ture augmente alors très vite.

Le Mac Mini, une bonne plateforme
Côté processeur, tout va bien. Le G4 à 1,25
ou 1,42 GHz du Mac Mini est plus que suf-

fisant pour ce type d’utilisation. Question
mémoire, comme pour tout autre usage, la
barrette de 512 Mo est un minimum que
vous devez absolument faire installer à la
commande (à 80 €, Apple pratique le prix
du marché). Autre élément-clé : l’affichage.
Le Mac Mini n’est pourvu que d’un seul
port vidéo. Vous ne pourrez donc pas le rac-
corder simultanément à une télévision et à
un moniteur plat de contrôle, par exemple. Si
vous possédez une télévision classique, vous
pourrez vous brancher dessus… à condition
d’acheter l’adaptateur DVI/S-vidéo et RCA

(composite) qu’Apple vend en option 19 €.
Attention toutefois : à cause de l’entrelace-
ment des images TV analogiques, l’affichage
informatique est toujours relativement diffi-
cile à lire. Décrypter vos listes iTunes ou
composer la playlist dans votre lecteur DivX
se révélera fatigant à la longue. 
Ce n’est clairement pas la bonne solution.
Pour composer un Media Center de qualité,
il vous faudra brancher votre Mac Mini sur
un écran numérique, simple moniteur LCD
ou grande télévision plasma… Consultez
donc votre banquier ! aaa
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Pour rajouter la fonction d’acquisition vidéo, les choses se corsent. 
C’est possible, mais il y a plusieurs points à passer en revue. 

e Une heure de vidéo MPeg-2 pèse dans les 2 Go. Technologie 2,5” oblige, 
le disque dur interne du Mac Mini est à la fois 
de taille médiocre et lent. Il faudra donc que vous
investissiez dans un plus gros disque externe 
FireWire400/USB2 à 5 400 tours/min. Une 
solution externe est préférable : le démontage
du Mac MIni n’est pas chose aisée et il n’existe
en 2,5” que très peu de disques 100 Go à 5 400
tours/min. Voilà, vous avez maintenant de la place
et une bonne interface… Comment y enregistrer la vidéo ? 

e Il faut acheter un boîtier d’acquisition. Externe, bien évidemment.
Optez pour un boîtier qui convertira la vidéo en fichiers MPeg–2. 
De quoi obtenir des images en qualité DVD. Je préconise l’EyeTV 200 
d’ElGato (300 €) ou l’une de ses variantes (selon vos équipement 
et abonnement). Il est livré avec un logiciel propriétaire complet et efficace 

(avec suppression des plages inutiles : blancs, pubs, etc.). Comme l’EyeTV 200 
fait office de tuner TV, vous pouvez vous passer de télévision et investir 
dans un écran plat LCD ou plasma un peu plus grand. Si vous optez pour 
l’application magnétoscope numérique, il est évident qu’il vous faudra choisir
un Mac Mini avec graveur de DVD, seule manière de pouvoir soulager le disque

dur interne des heures de vidéo enregistrées et conserver vos séries, 
documentaires et films préférés. Notre collaborateur Alynpier, 
le patron du site Macetvidéo, vous apprend comment faire 
dans ce numéro de Vous et Votre Mac. Et tant que vous y êtes,
pour un confort maximal, prévoyez l’intégration de Bluetooth 

et l’achat du clavier et de la souris BT, histoire de pouvoir piloter
l’ensemble, sans fil depuis votre canapé.

e Quant aux logiciels, pas la peine de rajouter grand-chose
à ce qu’Apple fournit en standard sur le Mac Mini. iLife 05 possède 

d’étonnantes ressources. Dans Vous et Votre Mac #1, en 
rubrique Ateliers, nous vous expliquions comment, autour
d’un PowerBook G4, monter de toute pièce un Media Center.
Il suffit d’effectuer la même manœuvre avec votre Mac Mini.

3

La solution évoluée avec magnétoscope numérique

La solution basique « son et DVD »
Bien ! Maintenant que nous avons défini la configuration Mac Mini qui servira 
de base, voyons ce qu’implique chaque fonction d’un Media Center. 

e Pour la musique, c’est très simple et cela ne vous 
coûtera presque rien : vous n’avez qu’à brancher 
le Mac Mini sur votre ampli à l’aide d’un simple câble audio
stéréo. Vous utiliserez à cette fin la sortie son jack 
stéréo du Mini . Ensuite, vous afficherez directement
iTunes, avec plus ou moins de bonheur selon l’écran 
dont vous disposez (voir mes remarques précédentes
concernant l’affichage vidéo-TV). 

e Pour la lecture des DVD-vidéo, le Mac Mini est équipé en standard d’un lecteur
combo qui grave les CD et lit les DVD. Parfait ? Oui, avec un bémol toutefois : 
si la sortie audio ne pose aucun problème pour la musique (qu’elle soit lue depuis
un disque dur ou un CD-audio ou MP3), elle ne vous permettra pas de visionner 
vos DVD-vidéo avec le meilleur confort d’écoute, car la banale prise jack stéréo 
du Mac Mini ne saurait transmettre le son numérique codé en Dolby Digital 5.1 
des DVD. Vous n’aurez donc que de la stéréo, au mieux du son Surround simulé 
si vous passez par un ampli audio numérique intégrant cette fonction. Pour 
bénéficier du vrai son, vous devrez vous procurer un boîtier externe. M-Audio 
(Midiman) propose le Transit qui se branche d’un côté sur un port USB du Mac et
de l’autre, en câble optique, sur l’ampli audio numérique de votre équipement

Home Cinéma, par exemple. Comprenez bien que le Transit n’effectue aucun 
décodage par lui-même – et de ce fait, commercialisé à 120 €, il est beaucoup 
trop cher. Pour 30 € de plus, le Sonica Theater de même marque s’avère plus 
complet (il gère sept satellites et un caisson de basse) et effectue directement 
le décodage Dolby Digital 5.1 (AC-3 et DTS). À considérer si vous n’avez pas 
d’équipement intégrant déjà un décodeur – ampli audio numérique ou kit 
d’enceintes. Une autre solution financièrement plus intéressante a été présentée
lors de la dernière Macworld Expo de San Francisco par Griffin. On n’a pas encore 
beaucoup de détails sur le FireWave qui ne sera commercialisé qu’au 
printemps pour 100 $. Si j’ai bien compris, c’est un boîtier proche du Transit, 
mais qui intègre directement le décodage 5.1. Pour profiter pleinement 
des DVD-vidéo et des DVD de concerts, le FireWave pourrait donc être 
un compagnon idéal du Mac Mini. À vérifier lorsqu’il sera disponible en France.

e Pour les DivX et autres formats compressés, le son est généralement com-
pressé en MP3. Pas de soucis, tous les outils existent (voir Vous et votre Mac #1). 

2

1

Comme nous le verrons plus loin, si vous
décidez d’ajouter à votre installation une
fonction de magnétoscope numérique, un
grand moniteur informatique devrait suffire
dans tous les cas de figure – le tuner étant in-
clus dans le boîtier d’acquisition, vous
n’avez pas besoin de télévision.
Enfin, pour clore le chapitre des généralités,
je note que le Mac Mini est sans doute le
Mac le plus silencieux qui me soit passé en-
tre les mains. C’est quelque chose d’essentiel
pour un Media Center. De fait, il est encore
plus discret que le Shuttle XPC Zen (lui

aussi à alimentation externe) qui, à défaut
d’une configuration Mac adéquate, fait chez
moi office de Media Center. Mais cela, c’est
seulement la base de votre Media Center.

Prévoyez un bon budget !
Pour créer une configuration de qualité qui
puisse assurer toutes les fonctions de lecture
musicale (audio, MP3 et AAC), de lecture
de DVD-vidéo (et autres formats DivX) et
d’enregistrement vidéo numérique, cela re-
présentera au bas mot un investissement de
2 000 €. Comptez en effet 979 € pour le

Mac Mini configuration haute et ses acces-
soires Bluetooth, 600 € pour un bon écran
19”, 80 € de plus pour le boîtier son 5.1 Fire
Wave et 300 € pour le boîtier d’acquisition
EyeTV 200. Ce n’est pas donné ! 
Cela dit, c’est tout de même moins cher que
si vous construisiez une solution similaire
autour d’un iMac G5. Et puis, c’est modu-
laire : vous n’êtes pas obligé de tout acheter
d’un seul coup. Commencez donc par la lec-
ture de la musique et de vos DVD. Vous
compléterez plus tard avec la fonction de
magnétoscope numérique.

1
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Pour plus d’efficacité, jonglez avec des

Docks multiples !
L

e Dock fut l’une des caractéristiques de l’interface utili-
sateurs de Mac OS X les plus critiquées. On lui a repro-
ché d’être un vrai bric-à-brac et de mélanger – pour le

pire – différentes fonctionnalités (lanceur, Menu Pomme,
Menu Application...) qui avaient été bien identifiées et implé-
mentées, chacune de façon différenciée, sous Mac OS 9… 

Peut-être. Toujours est-il que le Dock est là et qu’on s’y fait.
Avec le temps, des outils sont venus, soit l’améliorer, soit se
substituer à lui, sans toutefois remettre en cause le concept. Si
vous vous sentez trop à l’étroit dans le Dock proposé par
Apple, jetez donc un œil sur ces quelques outils que vous pro-
posent certains développeurs. n Bernard Le Du

Vous aimez le concept du Dock de Mac OS X, mais vous trouvez qu’un seul Dock, ce n’est pas assez
pour conserver vos fichiers et applications à portée de souris ? Eh bien, multipliez-le !

A-Dock X

Développé par un Français, Jérôme
Foucher, A-Dock X (10 $, 7,50 € env.,
en français) vient compléter le Dock
standard de Mac OS X d’un second
bandeau à placer à gauche, à droite
ou en bas de l’écran (lancement
libre avec Majuscule-Clic). 
Il propose de nombreuses options
de paramétrage qui touchent aussi
bien son propre fonctionnement
que celui du Finder, par exemple.
Vous avez la liberté de changer 
la couleur du fond du bandeau 
A-Dock, des bords, des séparateurs
et des triangles indiquant les appli-
cations ouvertes et l’application
courante. Pour mieux repérer 
cette dernière, vous demandez que

son icône soit décalée. Les noms
des applications et fichiers 
s’affichent lorsque vous survolez
leurs icônes comme pour le Dock
standard, ou dans des info-bulles
colorées et personnalisées. Vous
déterminez des raccourcis clavier
pour révéler le Bureau, basculer
entre applications ou naviguer
dans le dock. A-Dock supporte une
fonction d’ouverture automatique
des dossiers (et déroule leur hiérar-
chie) lorsque vous glissez un objet
sur leurs icônes dans le Dock. 
Pratique pour ranger rapidement
un document au fond d’un sous-
dossier quelconque (attention 
toutefois : lorsque vous tentez 

de déplacer un document vers 
un endroit où existe déjà un fichier
du même nom, le déplacement ne
sera pas effectué, mais rien ne vous
alerte). Il est même possible, 
avec la touche G, de prendre
un objet dans la hiérarchie d’un
dossier pour le déplacer ailleurs.
A-Dock propose des modules
à activer ou non : affichage
direct du Bureau (Exposé offre 
une fonction identique), listing 
des serveurs Rendezvous, 
gestion de Classic (avec accès 
instantané au dossier Menu

Pomme et aux tableaux de bord 
de Mac OS 9), corbeille, gestion 
des disques et volumes.
Enfin, l’utilitaire est livré avec 
plusieurs thèmes – d’autres
sont téléchargeables – pour 
personnaliser encore un peu plus
votre second Dock.
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Et un bandeau de plus !

MAC OS X
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Cet utilitaire (10 $, 7,50 € env., en anglais) proposé par Gideon Software,
éditeur connu pour ses outils toujours bien pensés et fiables, offre plus
de fonctions que SwitchDock, mais il ne s’intègre pas au Dock de Mac OS X
et crée un système de Docks parallèle. Le Dock Mac OS X reste bien sûr
opérationnel. S’il comporte de nombreuses options, Dock-It ne reprend
pas à son compte les comportements habituels du Dock de Mac OS X.
Ainsi, vous ne pouvez pas régler à la souris la taille des icônes dans 
un Dock, ni la position des Docks à l’écran, ni y déposer des icônes 
par glisser-déposer. Toutes ces opérations et d’autres obligent à passer
par les menus cachés sous l’icône « G » présente dans chaque Dock .

Cela dit, Dock-It autorise, lui, d’avoir plusieurs Docks simultanément 
opérationnels, positionnés sur les quatre bords de l’écran (ou plus 
si plusieurs écrans sont raccordés à votre Mac). Évitez simplement que
les Docks se recouvrent les uns les autres (Dock-It devrait par défaut
interdire cela !). La création et le paramétrage d’un nouveau Dock 
passent par un éditeur dédié . C’est là que vous définissez le contenu 
d’un Dock, ses comportements par défaut et la couleur et la transparence 
de son fond ainsi que de son contour. Vous pouvez aussi décider de placer
dans un Dock les disques et volumes montés et y naviguer grâce 
à un système de menus hiérarchiques. Bref, Dock-It sert alors de lanceur. 
Dock-It est livré avec quelques « applets » que vous installez ou non 
dans chaque Dock. Par exemple, vous pouvez avoir une horloge ou l’accès

aux Préférences système. Les deux
applets les plus intéressants sont
sans conteste l’étagère (Shelf) et le
presse-clips (Clipping). La première
est une sorte d’étagère, un espace
de stockage temporaire sur lequel
vous placez un ou plusieurs 
éléments (logiciel, fichier, document)
lors d’une manipulation dans le 
Finder que vous ne pouvez réaliser
aisément d’un seul coup (un déplace-
ment entre deux volumes par exem-
ple). Lorsque vous créez des fichiers
extraits (clippings), glissez-les sur 
le second applet de Dock-It plutôt
que sur le Bureau : l’utilitaire gère
une mini-base de données des clips,
dotée d’une petite interface 
de consultation. Shelf et Clipping
sont deux aides fort appréciables.

2
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SwitchDock

Développé par Alex Pagliaro,
SwitchDock (10 $, 7,50 € env., 
en anglais) est typiquement 
l’utilitaire de base qui permet 
simplement de se fabriquer 
plusieurs Docks, puis de passer 
de l’un à l’autre.  Vous pouvez
avoir ainsi un Dock donnant accès
aux logiciels d’usage courant, 
un Dock Internet regroupant toutes
vos applications de navigation, 
de téléchargement… et un Dock
jeux. Pour ajouter des objets 
à un dock, il suffit de les y glisser.
Inversement pour les retirer. Toutes
les fonctions de SwitchDock sont

accessibles via son icône (un petit
couteau suisse) installée automati-
quement dans chaque Dock. 
Les nouveaux Docks sont graphi-
quement presque identiques 
au Dock standard de Mac OS X 
et ont les mêmes comportements
que ce dernier. Notez que tous 
les Docks reprennent par défaut
les icônes de quelques 
applications Apple fournies avec 
le système (sortez-les du Dock 
si vous n’en voulez pas) et celles
de tous les logiciels ouverts. 
Le passage d’un Dock à un autre
implique la fermeture du Dock 

courant et l’ouverture d’un autre :
il n’y a donc plus de Dock visible
durant trois à quatre secondes.
Heureusement, vous n’aurez pas 
à switcher souvent : l’icône 

de SwitchDock donne accès 
par menus cascadés à tous
les objets (logiciels et documents)
présents dans l’ensemble 
des Docks qu’il gère. Bien trouvé !

1

Switchez d’un Dock à l’autre

1

2

1

Dimension parallèle
Dock-It
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WorkStrip X (50 €, en français 
pour la 3.0, en anglais seulement
pour les versions plus récentes) est 
à mon avis le système de Docks 
multiples le plus complet. Il est 
certes un peu cher, mais comme
vous le verrez, il remplace à lui seul
nombre de petits sharewares.
Les Docks, dénommés ici workspaces,
regroupent sous forme d’onglets 
les icônes des applications, fichiers,
documents, dossiers, etc., que vous 
souhaitez conserver à portée 
de souris. L’icône de WorkStrip 

elle-même permet de passer 
d’un Dock à un autre. Car, comme
avec SwitchDock, seul un workspace
peut être affiché à la fois. Mais la
ressemblance entre les deux outils
s’arrête là. Le basculement est ici
instantané et WorkStrip collectionne
des fonctions dépassant largement
l’usage d’un simple Dock !
Pour la partie purement Dock, pas
de grosses surprises sinon qu’une
fonction permet de camoufler le
Dock standard de Mac OS X – il reste
actif, mais replié et caché sous 
la barre de titre des applications, et
réapparaît parfois. De toute façon, 
je ne vous conseille pas de vous
passer complètement de lui : par
exemple, les docklets, ces mini-
applications fonctionnant à partir 

du Dock, ne s’interfacent pas 
avec WorkStrip. Non seulement 
vous pouvez personnaliser chaque
WorkStrip , mais aussi lui 
associer un fond d’écran ; 
ainsi l’atmosphère de travail change
selon le workspace choisi. 
Fonction inédite : derrière chaque
icône d’un workspace se cache 
une fenêtre-tiroir multifonction,
dont l’usage est largement 
adaptable. Elle peut lister 
les objets les plus récents liés 
à une application. Par exemple, 

les derniers documents ouverts par
Word. Mais vous pouvez aussi 
utiliser ces fenêtres comme des 
« chemises » regroupant un ensemble
de documents de travail. Pour les
sites Web, WorkStrip fait carrément
office de gestionnaire « contextuel »
de favoris. Dans votre workspace
Studio, vous stockerez derrière
l’icône de Safari tous les sites 
sur lesquels vous trouvez 
habituellement des ressources
nécessaires à votre travail 
de graphiste, tandis que dans votre
workspace Jeux, la fenêtre-tiroir de
Safari conservera seulement les URL
des principaux éditeurs de jeux 
ou des services de jeu en réseau. 
Autre fonction-clé : la prévisualisa-
tion immédiate des fichiers 

graphiques, PDF, audio et vidéo… en
fait tout ce que QuickTime veut bien
gérer. De quoi naviguer rapidement,
sans ouvrir aucune application, 
dans vos bibliothèques d’images, 
de séquences et de morceaux 
musicaux et chansons. DragThing 5
sait aussi le faire, mais WorkStrip
vous laisse régler vous-même la
taille de la fenêtre de visualisation
et supporte l‘affichage en grand 

format. Je ne peux pas détailler 
ici toutes les facettes de WorkStrip
que je vous invite à découvrir 
par vous-même grâce à sa version
démo. Toutefois, maîtriser toutes 
ses fonctions – dock, lanceur, navi-
gateur, gestionnaire de fichiers, ges-
tionnaire de favoris, visualisation… –
n’est pas trop long, d’autant 
qu’il s’avère vraiment très agréable
à utiliser au quotidien. 
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WorkStrip X
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Deux «machines»à lancer vos applications 
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DragThing (30 $, 22,50 € env., 
en français), qui existait déjà sous
Mac OS 8 et 9, s’éloigne sensiblement
plus du modèle du Dock de Mac OS X
que ne le fait WorkStrip. À la base,
DragThing assure lui-aussi le regrou-
pement d’icônes afin de lancer aisé-
ment des applications ou garder 
à portée de souris des documents 
ou autres éléments (URL, fenêtre
réduite dans le Dock…). Il est donc
conceptuellement proche de Work
Strip, mais je le trouve plus difficile 
à maîtriser. Ses palettes peuvent être
des fenêtres flottantes ou 
des tiroirs qui s’escamotent sous 
les bords de l’écran . Les palettes
contiennent un ou plusieurs pan-
neaux matérialisés par des onglets,
eux-mêmes structurés en matrice
dont chaque case affiche, sous 
la forme d’une icône, un lien vers 
un objet quelconque. Dans la toute
récente version 5.5, les icônes de
dossier s’ouvrent automatiquement

et dévoilent la hiérarchie des sous-
dossiers. Un excellent moyen d’aller
copier ou déplacer directement 
des éléments vers un emplacement
reculé du disque dur. Vous pouvez
sauvegarder vos « espaces de travail »
et les rouvrir quand vous le souhai-
tez : d’un coup s’affichent à l’écran
toutes les palettes correspondant 
à votre activité du moment. À vous
de construire votre environnement
comme vous le souhaitez. Très 
puissant, mais aussi assez complexe
à mettre en œuvre. La tâche est 
d’autant plus ardue que les réglages
de DragThing sont pléthore , 
tant pour l’application elle-même 
que pour les palettes et les panneaux
qui ont leurs propres jeux 
de préférences et d’options. 
De plus, trois palettes spécifiques
viennent en renfort, que vous 
afficherez ou non à loisir Elles listent,
l’une les applications actives, l’autre
les volumes montés et la troisième

recense toutes les fenêtres ouvertes
(de toutes les applications lancées).
Vous êtes libre de définir aussi 
des modèles de palettes différents
de ceux proposés par défaut, et de
changer la plupart des paramètres
de présentation et de comportement
des palettes, panneaux, menus
contextuels et autres objets. Comme
WorkStrip, DragThing 5 a ajouté 

à son arsenal la prévisualisation 
des fichiers images, audio et
vidéo (à partir du moment où Quick-
Time peut les ouvrir). Lorsque vous
vous promenez dans l’arborescence
de vos fichiers via DragThing et 
que le curseur passe sur une image,
une fenêtre dévoile une vignette
dont la taille ne peut hélas pas être
gérée par l’utilisateur.
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Structurez graphiquement votre Dock

DragThing

Le Dock de Mac OS X vous satisfait, mais
vous voudriez l’organiser un peu mieux ?
Utilisez donc les séparateurs 
graphiques que propose le site italien
iPassion. Ce sont des icônes 
spécialement conçues pour être placées
dans le Dock en guise de séparateurs.
Dans le dossier DockSeparator 1.5, vous

trouverez des modèles classiques, 
d’autres plus graphiques, et certains
horizontaux pour ceux qui placent leur
Dock à gauche ou à droite de l’écran.
Pour utiliser plusieurs fois le même
séparateur, il suffit de le dupliquer. 
Donnez éventuellement un nom 
au séparateur utilisé afin, par exemple,

de préciser le contenu de la section 
du Dock qu’il délimite. Pour ceux qui
préfèrent, il y a aussi une icône… vide
(dont la taille n’est pas variable). 
DockSeparator est une bonne idée, 
mais évidemment ça ne fera qu’empirer
la situation des utilisateurs dont 
le Dock est déjà surpeuplé !

2
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applications et visualiser vos documents

MOSX Dock JLOK  10/02/05  16:10  Page 47



MAC OS X

48 Mars 2005Vous et Votre Mac

P
ourquoi donc auriez-vous besoin
d’ouvrir des comptes d’utilisateur
autres que celui que vous avez

créé lors de l’installation de Mac OS X ou
du premier démarrage de votre tout nou-
veau Mac ? Bien que cela soit proposé de-
puis de nombreuses années – c’est même
possible depuis longtemps sous Mac OS 9
via une extension spécifique –, nous ne
sommes pas encore très habitués aux sys-
tèmes multi-utilisateurs. Ceux-ci peuvent en
effet sembler de prime abord assez com-

plexes. Mais dès que l’on comprend com-
ment ça marche, tout devient très simple
et vous vous mettez à utiliser cette fonc-
tionnalité. Disposer de plusieurs comptes
sur la même machine est très utile pour la
partager en famille, ou encore dans un
bureau, un lieu semi-public ou public. 
En résumé, dès que vous n’êtes pas seul à
vous servir d’une machine, vous devez
créer différents comptes pour protéger les
données de chacun et leur confidentialité,
mais aussi pour garantir le système lui-

même, car tous les utilisateurs n’ont pas
les mêmes privilèges. Et même si vous êtes
le seul utilisateur « officiel » de la ma-
chine, il est toujours utile de créer un se-
cond compte ou plus pour séparer deux
activités : une activité professionnelle et
une autre plus privée, par exemple. Il est
ainsi très désagréable d’ouvrir par erreur,
chez un client, une session sur un Bureau
avec une photo de plage en fond d’écran…
Cela ne met personne à l’aise !

n Alain Lalisse

Les comptes d’utilisateur sont une des fonctionnalités incontournables de Mac OS X et nous y sommes
tous confrontés au moins une fois. Impossible en effet de démarrer Mac OS X sans avoir créé 
au moins un compte d’utilisateur. Si l’assistant d’installation rend cette procédure transparente, 
il n’intervient plus lorsque vous souhaitez ouvrir éventuellement d’autres comptes par la suite. 
Dans ce premier article, nous allons voir comment créer de nouveaux comptes, les modifier 
et les supprimer. Nous poursuivrons notre découverte, de façon plus pointue, dès le mois prochain.

Créez de nouveaux comptes d’utilisateur…
Étape 1
Choisissez un Nom ainsi 
qu’un Mot de passe .
Le Nom abrégé est 
pour sa part créé 
automatiquement. Vous pouvez
le modifier tant que vous 
restez positionné sur 
cet onglet du panneau. 
Ensuite, il sera trop tard. 
Le mot de passe est quant 
à lui caché : vous ne voyez que
des petites boules ,
même lorsque vous le saisissez.
Tapez-le donc avec la plus
grande attention.
Vous pouvez définir un indice
qui pourra éventuellement 
vous aider à vous remémorer 
le mot de passe en cas 
d’oubli fâcheux .5

4
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1
L’INTERFACE ENTRE l’utilisateur
et la gestion des comptes 
est accessible dans 
les Préférences système,
plus précisément dans 
le panneau Comptes qui 
regroupe toutes les options.
La première fois que vous 
ouvrez le panneau Comptes,
vous y découvrez le seul
compte d’utilisateur existant :
celui que vous avez créé lors 
de l’installation de Mac OS X.
C’est le vôtre.
La création de nouveaux 
comptes d’utilisateur ne prend
que quelques instants. 

1
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2
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5

Partagez votre Mac en confiance : utilisez

les comptes d’utilisateur
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Le dossier Utilisateurs et la Maison
À chaque compte d’utilisateur correspond un espace disque créé et organisé
par le système. Tous les dossiers de comptes d’utilisateur créés sont regroupés
dans le dossier principal Utilisateurs situé par défaut à la racine 
du disque dur de démarrage. Le mois prochain, dans la deuxième partie 
de cet article, nous verrons comment déplacer les dossiers des utilisateurs. 
Le dossier d‘utilisateur sur lequel vous vous êtes connecté lors de l’ouverture

de session est symbolisé par l’icône d’une Maison (on le dit aussi « dossier 
Départ », symbolisé par un « ~ » sous Unix). Les autres dossiers d’utilisateur 
apparaissent avec une icône standard de dossier pour vous indiquer 
que ce n’est pas votre Maison. C’est le nom abrégé de chaque utilisateur 
– ce nom est unique, on comprend maintenant pourquoi – qui sert de nom 
au dossier Départ. L’espace disque d’un utilisateur n’est pas limité. 
C’est la bonne entente entre tous qui doit prévaloir. Sauf pour partager 
quelques fichiers (voir plus loin), les dossiers des autres utilisateurs vous sont
interdits. De même, vos dossiers ne sont accessibles qu’à vous-même. Votre
Maison contient un ensemble de dossiers par défaut, en principe suffisants
pour tous vos documents personnels, mais Mac OS X ne vous empêche pas 
d’en créer d’autres à ce niveau et de gérer vous-même les droits d’accès.

2

1

Visitons la Maison…
Mac OS X crée huit dossiers dans votre Maison. Pour mieux les distinguer 
les uns des autres, chacun possède une icône spécifique. Ils ont également 
chacun un but bien précis. Apple vous encourage à les utiliser. Il demande aussi 
aux développeurs de se baser sur ces dossiers. 
Vous connaissez sans doute déjà très bien les trois répertoires dédiés 
au multimédia parce que, par défaut, iTunes travaille dans le dossier 
Musique , iMovie dans Séquences et iPhoto dans Images …543

Bureau est un simple alias regroupant 
ce qui se trouve sur le Bureau. Chaque utilisateur 
en possède un, donc un dossier Bureau qui lui est 
propre. Documents contient tous 
les documents de l’utilisateur. C’est le dossier 
d’utilisation générale. Comme tout nouveau dossier
créé par l’utilisateur hérite des privilèges
du répertoire parent, lorsque vous créez 
un nouveau dossier dans Documents, il est 
immédiatement protégé car il possède les mêmes
droits que le dossier Documents, lui-même 
inaccessible aux autres utilisateurs.

7

6

Étape 2
Choisissez une image représentative parmi les quelques petites vignettes 
proposées en standard ou bien préférez une photo. L’utilitaire inclut 
une gestion simple, mais bien étudiée des photos. Cliquez sur Modifier…
Il suffit de glisser/déposer une image, de la redimensionner avec le curseur, 
et de se déplacer avec la main pour choisir la partie intéressante, 
avant de valider . Vous pouvez également prendre une image à partir 
d’une caméra, iSight ou autre, connectée à votre Mac .9

8
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Étape 3
C’est ici que vous accordez ou non les droits d’administrateur à un utilisateur .
Un administrateur n’a pratiquement aucune restriction d’accès. 
C’est pourquoi l’onglet Restrictions est grisé . Je vous conseille de définir,
dans un premier temps du moins, tous les comptes en tant qu’administrateur,
quitte à en restreindre certaines possibilités par la suite. 
Mac OS X crée et maintient pour chaque compte d’utilisateur un répertoire 
au nom de celui-ci. Il est placé dans le répertoire Utilisateurs (Users) 
à la racine du disque de démarrage. Le dossier du compte d’utilisateur contient
lui-même un certain nombre de sous-dossiers créés automatiquement par défaut.
Un compte d’utilisateur vide n’occupe que 1, 5 Mo sur le disque dur.
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La Maison : un espace privé pour chacun
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Le compte root (racine 
en français) est un compte 
qui existe dans tous les 
systèmes Unix. C’est le compte
du « super-utilisateur ». 
Lorsque vous vous connectez
sous ce compte, vous passez
outre toutes les protections, 
y compris celles qui entourent
les comptes administrateur. 
Il vaut mieux éviter de travailler
dans ce compte. On ne l’utilise
que pour régler certains 
problèmes (fichier impossible 

à détruire ou perte de mot 
de passe, par exemple). Il faut
bien prendre conscience que 
le compte root peut très bien
vous effacer un système tout
entier en une seule commande.
C’est la partie « obscure » 
de sa puissance. Le compte root
n’est pas activé par défaut. 
C’est à vous de le faire.
Pour cela, ouvrez l’utilitaire 
Gestionnaire NetInfo, dans le
dossier Applications > Utilitaires.
Dans son menu Sécurité,

authentifiez-vous avec 
un compte administrateur. Puis,
toujours par ce même menu, 
faites Activer l’utilisateur root.
Donnez encore votre mot 
de passe. Vous pourrez aussi, 
de la même manière, changer
votre mot de passe. Un conseil :
activez ce compte et gardez 
le mot de passe avec votre CD
de Mac OS X. Il se peut que vous
n’en ayez jamais besoin. Tant
mieux ! Mais il se peut aussi qu’il
vous soit d’un grand secours.

Le compte privilégié « root »

Qui, que, quoi et où…

Le répertoire Bibliothèque stocke
toutes vos préférences, vos paramètres 
personnels (les polices, vos favoris 
du Finder, les plug-in des applications, 
les préférences personnelles créées par 
chaque logiciel utilisé…) En fait, on peut
dire que Bibliothèque recrée pour 
votre compte d’utilisateur un « système 
personnalisé » en évitant de dupliquer 
ce qui est commun à tout le monde. 
Prenons un exemple : dans iTunes, 
je préfère importer en MP3. Mon fils, qui 
a un iPod, veut pour sa part importer 

en AAC. La gestion
des utilisateurs
Mac OS X va 
respecter 
nos deux choix 
contradictoires 
et restaurer les
bonnes préférences à chaque ouverture
de session. Chacun de nous possède 
donc son environnement personnel. 
En sauvegardant votre dossier 
Départ, vous sauvegardez donc aussi 
toutes vos préférences.

8 Le dossier Public va vous permettre
d’échanger des documents avec 
les autres utilisateurs de la machine. 
Il contient lui-même un sous-dossier 
particulier, la Boîte de dépôt, dont nous
reparlerons plus loin.
Le dossier Sites , enfin, contient 
toute l’arborescence de votre site Web
personnel ainsi que les ressources 
et les contenus, si d’aventure vous 
en créez un. Par défaut, ce répertoire
contient un exemple composé 
d’une seule et unique page.
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Partagez des fichiers entre utilisateurs
Il suffit d’avoir créé une fois au moins deux utilisateurs pour être tombé sur 
un dossier frappé d’une icône « sens interdit » . Ce type de dossier appartient
à un autre utilisateur que vous. Le message est clair : vous n’y avez pas accès !
Mac OS X protège ainsi tous les dossiers que nous venons de voir précédem-
ment et qui ne vous appartiennent pas. Comment donc partager un fichier ou
un dossier entre utilisateurs d’une même machine ? Première idée : le dossier
Partagé qui se trouve dans le dossier Utilisateurs. Tout le monde y a accès
en écriture et en lecture (sauf les utilisateurs du Finder simplifié). 
Autre solution : un utilisateur veut donner accès à un fichier à tous. Il place 
ce fichier dans son dossier Public. Tout le monde pourra le lire, voire le copier,
mais lui seul pourra modifier l’original. Ces deux premières solutions présentent
un inconvénient : tout le monde peut lire le fichier. Mac OS X prévoit aussi 

un transfert confidentiel. Il suffit alors de déplacer le fichier dans le dossier
Boîte de dépôt d’un utilisateur. Ce fichier devient alors invisible 
à tous (même à vous qui venez de le déposer), sauf à son destinataire qui seul
peut le récupérer. Le dossier est marqué d’une icône « sens unique ».
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EENN FFRRAANNÇÇAAIISS EENN AANNGGLLAAIISS DDEESSCCRRIIPPTTIIOONN DDUU CCOONNTTEENNUU

Bureau Desktop Contient tous les éléments qui seront affichés sur le Bureau d’un utilisateur ouvrant une session.

Documents Documents Contient les documents personnels de l’utilisateur.

Bibliothèque Library 
Contient les préférences et les réglages des applications pour cet utilisateur uniquement. 
Contient également des ressources système spécifiques à chaque utilisateur.

Séquences Movies Contient des films et des séquences vidéo (formats QuickTime et autres).

Musique Music Contient des fichiers de musique (MP3, AAC, AIFF et autres formats).

Images Pictures Contient des fichiers images (les formats peuvent être très variés).

Public Public 
Contient tous les éléments que l’utilisateur désire partager avec d’autres utilisateurs. 
Par défaut, le contenu de ce répertoire est vu par tous.

Sites Sites Contient des pages Web du site Web personnel de l’utilisateur.

8 9
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Paramétrez des comptes d’utilisateur
DEUX POSSIBILITÉS ! Vous êtes 
administrateur. Toutes les options
des Préférences système > Comptes
vous sont alors accessibles. 
En revanche, en tant qu’utilisateur 
« standard », c’est l’inverse : 
la plupart des options sont grisées.
Vous comprenez ainsi pourquoi 
j’ai choisi de définir, dans un premier

temps, tous mes comptes comme 
administrateur. Exception 
à la règle : le nom abrégé est le seul
paramètre qu’un administrateur 
ne puisse pas modifier. 
Nous verrons un petit truc 
pour contourner ce problème 
dans la deuxième partie 
de cet article, dès le mois prochain.

Gestion à plusieurs administrateurs
Il est tout à fait possible de conserver tous les comptes en statut 
administrateur. Les fichiers propres à chaque compte seront protégés. Mais tout
le monde aura accès aux applications, à l’installation de nouveaux logiciels, 
aux mises à jour… Il y a protection des données et de la confidentialité. 
Un administrateur ne peut pas modifier de sa propre initiative les autres mots
de passe. L’accès à des fichiers privés est donc garanti. Une gestion 
avec plusieurs administrateurs évite aussi des erreurs d’inattention telles 
que la suppression par inadvertance de fichiers d’un autre compte. 
Mais il n’y a pas de protection du système, ni des ressources partagées.

D’autres options
Le Finder simplifié est l’option de restriction 
la plus contraignante. Seules les applications sélectionnées
seront accessibles au travers du Dock. Le disque dur 
n’est pas visible. L’utilisateur en mode Finder 
simplifié garde tout de même un espace de stockage 
personnel. Bien entendu, tout ce qui relève du système 
ou de la configuration de l’interface lui est interdit. 
C’est un mode que l’on réservera pour les tout-petits 
ou que l’on appliquera sur des postes utilisés comme bornes
d’accès au public.
La sécurité FileVault a été ajoutée au système 
avec Panther. C’est un mécanisme qui permet de crypter 
le dossier utilisateur. Ainsi, même si votre portable 
tombe entre de mauvaises mains, et même si cette personne
indélicate réinitialise les mots de passe avec le CD 
d’installation de Mac OS X, vos données personnelles 
resteront cryptées et donc inaccessibles. FileVault 
travaille à la volée, et donc de manière transparente pour 
les divers utilisateurs.

4

3

L’administrateur et les autres
Prenons maintenant l’exemple d’une petite famille. Vous travaillez sur votre Mac dans la journée
et vos enfants vous l’empruntent le soir. Comment vous protéger efficacement ? En créant 
un administrateur (vous-même) et en ajoutant des utilisateurs « standard » ou des utilisateurs 
« gérés ». Quelle différence existe-t-il entre les deux types ? 
Un compte d’utilisateur est « standard » lorsque la case Autorisation à administrer 
cet ordinateur n’est pas cochée . Toutes les opérations qui exigent de décliner un mot 
de passe d’administrateur sont interdites. Toutefois, si vous allez dans l’onglet Restrictions,
vous noterez que cet utilisateur standard ne présente pas d’autres restrictions. Il peut 
gérer son Dock, accéder à tous les dossiers Applications, ouvrir les Préférences système…
Le mode « géré » est plus restrictif que le mode « standard ». L’utilisateur n’est non seulement pas 
administrateur, mais en plus, vous lui retirez certaines autres facultés ouvertes à l’utilisateur
standard. Ces restrictions sont justement répertoriées dans l’onglet Restrictions.
Le panneau Certaines restrict. liste toute une panoplie de contraintes qui ne vous poseront pas de gros problèmes de compréhension. Il suffit de cocher 
ou de décocher les options. Les dossiers Applications et Utilitaires sont directement pris en charge . En revanche, si vous avez d’autres logiciels dans des dossiers
séparés, il convient de les rajouter avec le bouton Rechercher… Ces logiciels seront placés dans la partie Autres.
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MAC OS X

Ouvrez sans frapper ?

Vous devez bien prendre conscience qu’il n’y a plus moyen d’accéder aux données 
si vous perdez les mots de passe. Aussi Apple a-t-il prévu un mot de passe principal 
de l’ordinateur avant l’activation de FileVault. Ce mot de passe, applicable 
à tous les comptes, sera utilisé en deuxième recours si un utilisateur oublie son mot 
de passe personnel. Attention : il n’y a pas de troisième recours !

VOUS POUVEZ À TOUT MOMENT SUPPRIMER des comptes 
d’utilisateur. Mais c’est encore plus simple avec Panther ! 
Il ne faut donc pas vous priver d’en créer au besoin 
et les supprimer dès que vous n’en avez plus l’utilité.

Pour supprimer des comptes d’utilisateur, vous devez 
obligatoirement avoir le statut administrateur.
La suppression s’effectue en un clic. Vous sélectionnez 
l’utilisateur et cliquez sur le signe Moins. Vous bénéficiez alors
de deux possibilités.
La première consiste à supprimer définitivement le compte 
et son contenu (c’est-à-dire tous les fichiers et répertoires 
de sa Maison). C’est l’option Supprimer immédiatement .
Si vous pensez devoir récupérer certains fichiers, cliquez 
plutôt sur OK . Le système crée alors une image disque 
du répertoire de cet utilisateur et la place dans un répertoire
Utilisateurs supprimés du dossier Utilisateurs.
Cette sauvegarde peut être plus ou moins importante 
car elle dépend entièrement de ce qu’il y avait dans le dossier
de l’utilisateur. Si on l’ouvre, elle monte sur le Bureau 
comme n’importe quelle image disque. Et on peut la jeter 
à la Corbeille lorsque l’on n’en a plus besoin.
Notez que l’image disque obtenue n’est pas protégée : 
la personne qui supprime un compte a donc accès à tout 
le contenu de ses répertoires.

2

1

La liste de l’option Ouverture automatique 
au démarrage est souvent mise à jour 
par l’installation de nouveaux logiciels, sans que 
vous vous en rendiez compte. Sa maîtrise reste 
cependant du ressort de l’utilisateur. Cette fenêtre, 
qui regroupe à la fois des tâches de fond 
et des applications, est accessible dans l’onglet 
Démarrage. Vous pouvez y ajouter une ou plusieurs
applications que vous utilisez couramment (Mail, 
Safari…) en glissant simplement leurs icônes 
depuis le dossier Applications (attention, pas depuis 
le Dock). Vous pouvez également utiliser les cases
Plus et Moins. Si vous voulez que l’application 
soit lancée, mais pas visible, il suffit de cocher 
Masquer. Notez que vous pouvez ranger cette liste
dans un ordre précis de démarrage en déplaçant 
les éléments à la souris. Tout ceci vaut autant pour 
les documents que pour les applications. 

5

Pour entrer sous Mac OS X multi-utilisateur, vous devez décliner les nom et mot 
de passe d’un compte d’utilisateur valide. C’est ce qu’on appelle « l’ouverture 
de session ». Les options qui permettent de paramétrer cette ouverture 
sont affichées au-dessous de la liste des utilisateurs, dans le panneau Comptes 
des Préférences système. Cette phase d’identification n’est pas obligatoire. 
Pour simplifier la vie à une personne qui travaille seule sur son Mac, elle peut être
évitée. Cette personne entre alors directement sur le Finder, sans entrer ni nom, 
ni mot de passe. Il suffit pour cela de cocher Ouvrir une session automatiquement
en tant que et de choisir un des utilisateurs déclarés.1

La fenêtre d’ouverture de session se présente sous deux formes différentes : 
une liste d’utilisateurs, avec leur pictogramme, ou une fenêtre plus simple dans 
laquelle il faut taper le nom et le mot de passe.
La vue par nom et pictogramme ne réclame que l’entrée du mot de passe. 
En revanche, la seconde demande de connaître à la fois le nom du compte et le mot
de passe associé. Elle est donc plus sûre. C’est aussi de cette manière que vous
pourrez entrer en super-utilisateur root, ce compte n’étant jamais listé avec 
le mode Pictogramme. Enfin, la Permutation rapide d’utilisateur offre
l’activation simultanée sur la même machine de plusieurs utilisateurs. Son utilisation
est limitée car il n’y aura toujours qu’un seul écran et clavier/souris. Mais on peut
faire des choses amusantes, comme lancer iTunes dans un compte et continuer 
à l’écouter comme si de rien n’était en basculant dans un autre compte.

2

4
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2

2

Supprimez des comptes
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U
ne des fonctions inédites appor-
tées par Panther était l'intégra-
tion, sous la forme d’un nouveau

service d'impression, d’un système d’envoi
et de réception de télécopies. Malheureu-
sement, l'outil ne fonctionne pas sans

quelques dysfonctionnements mineurs et il
s'avère surtout assez « spartiate ». Les ver-
sions successives de Panther n'ont rien ap-
porté de nouveau en ce domaine. Et nous
n’avons rien vu de bien nouveau de ce
côté-là dans les premières moutures de

Tiger que nous avons pu installer. Néan-
moins, cette fonction de télécopie a le mé-
rite d’exister et reste utilisable pour du fax
« au coup par coup », à condition d'ap-
prendre à en contourner les problèmes.

n Bernard Le Du

B Détour par Aperçu

C Paramétrez la fonction Fax…

Mac OS X passe alors la main au logiciel 
Aperçu qui affiche une prévisualisation 
du document. Faites de nouveau Fichier > 
Imprimer… (ne cliquez pas sur le bouton
Imprimer, en bas de la page), et cette fois-ci 
optez pour le bouton Fax… 1

La fenêtre de paramétrage de la fonction 
Fax vous propose alors de définir tout d'abord 
les coordonnées du destinataire du fax . 
Deux possibilités : soit vous entrez manuellement
un numéro de fax, soit vous cliquez sur 
la petite icône à droite du champ « À »
pour lister le contenu du Carnet d'adresses .  
C'est là qu'existe une malencontreuse différence
entre TextEdit et Word. Mais ne jetez pas 
la pierre à Microsoft ! Le même problème 
se constate dans iCal ou Stickies… Des utilitaires
signés Apple. Et d'autres logiciels sont aussi 
frappés par ce bogue qui n'a toujours pas 
été éradiqué dans la toute dernière version 10.3.6
de Panther. De quoi s'agit-il ? Eh bien, 
dans Word et les autres logiciels touchés par 
ce dysfonctionnement, vous accédez bel 

et bien à la base du Carnet d'adresses de Mac OS X
en cliquant sur la petite icône, mais vous ne 
pouvez ni choisir un nom dans la liste, ni refermer
cette dernière. Heureusement, ce bogue n'est pas
inhibant : cliquez dans la fenêtre de dialogue 
du fax et poursuivez en entrant les coordonnées 
à la main. Si le destinataire existe dans 
votre Carnet d'adresses, son nom et son numéro

de fax seront complétés immédiate-
ment. Le petit détour que nous 
avons fait par Aperçu règle 
le problème puisque cette application
ne connaît pas le bogue ; de plus, 
c'est une opportunité de prévisualiser
le courrier dès le départ.  3

2

1

C’est une des fonctions les plus mal aimées de Mac OS X. Et ce à raison, car Apple 
a fait le minimum : vous pouvez envoyer un fax à partir de toute application qui sait imprimer, 
mais le système n’intègre pas un véritable logiciel de gestion des télécopies.

Envoyez une télécopie avec Panther
A Passez par l’impression
La fonction Fax de Panther se niche
dans le dialogue d'impression. 
Vous pouvez vous en servir depuis tout
logiciel qui utilise ce dialogue standard,
c'est-à-dire tous les logiciels Mac OS X
natifs. Même si Word propose 
un dialogue d'impression plus complet
que la plupart des logiciels , vous 
y retrouvez tout de même toutes 
les fonctions du dialogue standard, dont
l'accès au fax. Votre lettre est ouverte 
à l'écran, faites Fichier > Imprimer…
Puis, dans le dialogue qui s'affiche, définissez les paramètres de base habituels (nombre de copies, 
nombre de pages). Enfin, cliquez sur le bouton d’ouverture de l’utilitaire Aperçu (l’icône à gauche 
de celle de la fonction PDF). Nous sommes obligés d’en passer par là pour contourner un bogue.

2

1
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Limitée certes, mais pas à négliger :

la fonction Fax... de Panther

1
2

MAC OS X
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B Soyez prévenu de l’arrivée d’un fax

A En attente de réception

D Envoyez la télécopie

Placez-vous en réception de télécopie

Mars 2005 55Vous et Votre Mac

Vous choisissez ensuite le mode 
d'envoi, par Modem (interne 
ou externe) ou par Bluetooth .
Cette dernière possibilité implique 
un téléphone GPRS compatible fax 
et un abonnement Data adéquat. 
Vous déterminez également 
les préréglages de mise en page et 
de qualité de la télécopie .   
La fonction Fax... de Panther prévoit
l'ajout d'une page de garde . 

Il suffit de cocher la case correspon-
dante. Mais pas question de peaufiner
un ou plusieurs modèles de page, 
avec logo par exemple. En fait, c'est 
le logiciel de fax intégré de Panther
qui le génère lui-même : date, heure,
numéro de la ligne départ, nombre 
de pages (page de garde comprise).
La seule personnalisation se limite 
à un petit texte que vous saisissez 
dans la zone adéquate . 76

5

4

4

5

6

7

Cliquez sur le bouton Fax… ou faites à nouveau une prévisualisation 
via le bouton Aperçu qui simulera l'apparence du courrier 
tel qu'il sera reçu (si vous avez coché l'option Simulation Soft Proof). 
Lorsque vous cliquez le bouton Fax…, Mac OS X déclenche une tâche d'envoi
du fax qui se matérialise dans le Dock par une icône Modem interne
ou Bluetooth-Modem. Ouvrez la fenêtre correspondante pour suivre 
le détail des opérations . 2

1

2

1

Vous le constatez, la fonction de réception est particulièrement « spartiate ».
Le logiciel ne prévoit de vous prévenir de l'arrivée des télécopies 
que par e-mail. Pas très pratique. Mais en utilisant une simple fonction 
du Finder de Mac OS X, vous pouvez être alerté de façon plus simple 
et rapide : il suffit d'utiliser les Actions de dossier.
Sélectionnez le dossier dans lequel sont enregistrés les fax entrants, 
déroulez le menu contextuel et faites Activer les actions de dossier,
puis Configurer les actions de dossier et sélectionnez le script add-new
item alarm.scpt . Dès qu'un nouveau fichier est enregistré dans 
le dossier, une fenêtre s'affiche en premier-plan pour vous l'indiquer. 
Notez qu'un développeur s'est ingénié à automatiser cette procédure 
pourtant très basique et propose au téléchargement Fax Alert Installer 1.0…
heureusement gratuit ! Un peu plus intéressant, Fax Status (en version 
préliminaire lors de mon test) ajoute dans la barre de menu des applications
une gestion par icône de la réception des fax : l'icône de téléphone 
passe de grisé à noir lorsqu'un fax est en cours de réception. Le nombre 
de pages est précisé en cours de réception alors qu'un point d'exclamation
indique qu'un fax a été récemment reçu. Fax Status est disponible 
à l'adresse : http://doce.org/section/faxstatus/

2

1

Ouvrez le panneau Imprimantes 
et fax des Préférences système de
Panther afin de paramétrer Mac OS X
pour qu'il puisse recevoir les téléco-
pies. Pour ce faire, affichez l'onglet
Fax. Ensuite, cochez la case 
Recevoir des fax sur cet ordinateur

. Précisez le numéro de télé-
phone de votre ligne et le nombre 
de sonneries avant que le fax n'entre
en fonction (histoire de vous laisser

le temps de décrocher s'il s'agit 
d'un appel vocal). Désignez 
le dossier dans lesquels seront enre-
gistrées les télécopies reçues .
Demandez éventuellement une
adresse e-mail pour être prévenu 
de l'arrivée d'un fax. Demandez
éventuellement l'impression des fax
reçus. Dès qu'un fax arrive, il est 
enregistré par Mac OS X au format PDF
et stocké dans le dossier adéquat.

2
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TECHNOLOGIE

Quand on arrive aux limites d’une techno-
logie, rien ne sert de s’acharner : il faut tout
faire sauter ! Voilà certai-
nement la remarque que
ce sera faite le groupe
d’industriels qui ont mis
au point la norme Serial
ATA. Encore aujour-
d’hui, 95% des disques
durs qui équipent les
ordinateurs fonction-
nent sur une interface
IDE, autrement nom-
mée Parallèle ATA.
Comme son nom le
suggère, cette inter-
face fait circuler les
données entre le dis-
que et l'ordinateur
en « mode parallèle » via une nappe d’en-
viron 5 cm de largeur et d’une longueur

maximale assez courte de 40 cm. Cette
nappe est très sensible aux interférences.

On a d’ailleurs dû doubler
le nombre de ses fils il y a
quelques années, passant
de 40 à 80. L’interface
IDE présente aussi d’au-
tres contraintes. On ne
peut connecter que
deux périphériques
sur une même nappe.
Et les disques durs
doivent être correc-
tement configurés
en maître et en es-
clave à l'aide des
cavaliers.
Contraintes de débit
aussi. On est passé

de 33 à 133 Mo/sec en plusieurs années et
on arrive en bout de course : les fréquences

mises en œuvre pour la version 133 sont à
la limite des perturbations pour assurer des
transferts de données sans erreurs.

Un potentiel important
Place donc au Serial ATA. Contrairement à
ce que l’on pense généralement, transmet-
tre des données en série n’est pas syno-
nyme de lenteur. Il suffit ainsi de constater
que les protocoles actuels les plus « bran-
chés », USB2 et Firewire, sont tous deux
basés sur des protocoles série. SATA a été
inauguré à 150 Mo/sec, mais on nous pro-
met déjà 300 Mo/sec pour cette année,
voire 600 Mo/sec pour l’an 2007 ! Avec
des interfaces natives SATA, on récupère
donc une belle marge de progression pour
le taux de transfert de nos disques durs.
Si SATA présente un grand potentiel, peut-
on dès à présent vraiment en tirer parti
avec efficacité ? Il faut bien avoir à l'esprit
que les disques SATA qui ont été commer-
cialisés en 2003 et 2004 sont souvent en
fait des disques IDE auxquels les fabricants
greffent un pont de conversion. Les disques
SATA natifs ne sont sur le marché que de-
puis quelques mois. Il faut considérer aussi
le contrôleur de disques SATA qui doit être
directement implémenté sur la carte mère
de la machine pour être vraiment efficace.
Et là, c’est de la responsabilité d’Apple.
Passer par le bus PCI annule le gain du 
Serial ATA, sauf si vous faites l'acquisition
d'une carte PCI RAID. 
En effet, on ne tire toute la puissante du 
Serial ATA que dans le cadre d'une utilisa-
tion simultanée de plusieurs disques (au
moins deux) en mode RAID 0. C’est ce que
font très bien certaines cartes PCI SATA

1
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Disques SATA : le retour en force

de l’interface série
R

évolution permanente pour les dis-
ques durs ! Vous avez tous remar-
qué la croissance explosive de leurs 

capacités. 160 Go, c'est déjà presque dé-
passé ! Les monstres de 250 Go, et même
400 Go, séduisent déjà les utilisateurs pro-
fessionnels de la vidéo ou de la musique, et
deviendront sans doute banals dès cette an-

née. Les disques durs vivent une autre révo-
lution, moins spectaculaire, mais fondamen-
tale : le passage à une nouvelle interface. 
Après le SCSI, puis le règne sans partage
de l’IDE et la percée du FireWire, c'est au
Serial ATA – SATA pour les intimes – de
faire son entrée en scène. Nous ne sommes
encore qu’aux prémices d'un grand chan-

gement. Mais, comme c’est souvent la cas,
Apple n’a pas hésité à se positionner réso-
lument en pointe avec l’adoption de cette
technologie pour ses premiers Power Mac
G5 et désormais avec le nouveau iMac G5.
Qu'est-ce que cela peut signifier pour vous,
aujourd'hui et demain ?

n Alain Lalisse

Le niveau de prix du Serial ATA a tellement baissé que le débat
ATA/Serial ATA ne se pose plus. Si votre machine peut 
les accueillir – et c’est pour l’heure le cas des Power Mac G5 
et iMac G5 –, choisissez sans hésiter des disques SATA.  
Les solutions pour récupérer des disques IDE en leur adjoignant
un convertisseur ne sont pas vraiment intéressantes. 
Ces convertisseurs prennent de la place : assurez-vous que
vous pouvez encore fermer la machine après une telle opération.

Déplacer le disque ailleurs dans la machine est également problématique en pratique : vous allez 
modifier la circulation d’air, ce qui peut remettre en cause le subtil système de gestion de l'air 
des Power Mac G5. Le jeu en vaut-il la chandelle ?
Pour doper la capacité de stockage de votre Power Mac G4 et ses performances en entrée-sortie, 
préférez aussi le SATA. Macway propose une carte PCI dotée de deux ports Serial ATA configurée 
en RAID hardware. Enfin, les disques SATA que vous achèterez aujourd’hui pourront être plus facilement
réutilisés demain dans un Power Mac G5 ou une nouvelle machine Apple.

1

L’arrivée des disques SATA, même sur les matériels tout public d’Apple, constitue une évolution 
significative. Peu spectaculaire encore, cette interface offre pourtant un formidable potentiel.

ATA ou SATA : quels disques acheter ?
1
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Besoin d'une importante capacité de stockage 
et les deux seuls emplacements offerts par votre
Power Mac G5 vous bloquent ? Des intégrateurs
ont développé des solutions internes
propriétaires. Ainsi, Promax propose plusieurs
versions du SATAMAXi/500-Mac, et Wiebetech 
offre le G5Jam. Ces solutions consistent à 
intégrer au Power Mac G5 plusieurs disques SATA

connectés à un ou plusieurs contrôleurs PCI 
tout en maintenant, aux dires des fabricants, 
un bon niveau d'aération de la machine, 
indispensable à son bon fonctionnement 
(entièrement asservi à la gestion automatique
conçue par Apple). Un exercice délicat !
Ces solutions s'avèrent assez onéreuses : 
comptez dans les 1 000 $ (750 € env.) pour 

un ajout de 500 Go. Leur support n'est, 
à notre connaissance, assuré qu'aux États-Unis.
Avant tout achat, considérez les disques externes
FireWire 800, une excellente approche tant 
technique qu'économique. Ou encore les disques
SATA 400 Go qui commencent à arriver sur 
le marché ; ils pourraient efficacement remplacer
les disques d'origine 80/160 Go d'Apple.

pour récupérer toutes les performances de
la norme. Mais quid du iMac G5 qui ne
peut embarquer qu'un seul disque dur ?
Certes, on ne pourra pas faire du RAID 0
et exploiter vraiment le SATA sur cette ma-
chine. Mais, alors que le différentiel de prix
entre les disques IDE et SATA est au-
jourd'hui insignifiant, il aurait été dom-
mage qu'Apple ne choisisse pas une nou-
velle technologie. Une constatation qui
vaut pour tous les utilisateurs.

Une ergonomie exemplaire
Concevoir une nouvelle interface, c'était
aussi l’occasion de rajeunir tout l’environ-
nement du stockage. On s’est donc inspiré
de ce qu’on avait fait de mieux, notam-
ment du SCSI. Aussi, terminées les confi-
gurations par cavaliers, avec les erreurs qui
bloquent tout. Serial ATA se veut aussi
convivial que son illustre prédécesseur, le
SCSI. Pour connecter un disque Serial
ATA, il suffit de le brancher sans que vous
ayez à configurer quoi que ce soit. Aucune
erreur possible, il n’y a qu’une seule prise !
L'équation est simple : une sortie contrô-
leur + un câble + un connecteur sur le dis-
que. Serial ATA, c’est également la possibi-
lité de brancher et de débrancher à chaud
des disques durs, sans avoir à redémarrer la
machine. Tout le monde a maintenant pris
cette habitude (encore un coup d’USB, de
FireWire et du SCSI). La nappe de con-
nexion SATA , comparée à une nappe
IDE , est bien plus souple d’utilisation :
seulement 8 mm de large et une longueur
pouvant aller jusqu’à 1 m. Pas surprenant
qu'Apple, qui s’intéresse de très près à des

designs ultra-compacts,
ait sauté sur l'occasion !
Le Serial ATA va faciliter
le travail des designers de
micro-ordinateurs. Qu’on
ne s’y trompe pas, cela
n’a rien d’anecdotique.
Rien que pour cela, cette
nouvelle interface com-
mence à s’imposer pour
des graveurs et lecteurs

optiques, bien que dans ce dernier cas, la
contrainte du taux de transfert passe au
deuxième plan.
Notez aussi qu'avec le Serial ATA, rien
n’empêchera dans quelques temps de met-
tre en externe des disques natifs ! Une solu-
tion simplissime qui risque de concurrencer
directement le FireWire 800.
Le Serial ATA offre encore d’autres atouts
qui seront mis en œuvre au fil du temps. 
Le NCQ – Native Command Queuing – est
une technologie qui permet aux applica-
tions d'envoyer, d'organiser et de traiter
plus rapidement de nombreuses requêtes

d'entrées/sorties envoyées simultanément.
Exemple : je dois lire deux blocs de don-
nées au début du disque, deux au milieu et
deux à la fin… 

Des fonctions avancées
Le NCQ va contrôler le déplacement du
bras du disque pour optimiser le taux de
transfert. Bien entendu, pour vous le NCQ
est transparent. Vos données sont seule-
ment disponibles plus rapidement.

3

2

3
2

1

Plus de disques Serial-ATA pour votre Power Mac G5

Serial ATA est aussi prévu pour les porta-
bles. Et qui dit portables, dit économies
d'énergie. La norme gère trois modes de
fonctionnement : un mode actif et deux
modes de mise en veille. Le réveil du disque
intervient alors soit en moins de 10 µs
(mode ultra-rapide) ou en moins de 10 ms.
Implémenté certainement un peu plus tard
quand il aura acquis ces lettres de noblesse,
le Serial ATA devrait s’imposer dans les or-
dinateurs portables et autres tablettes.

Mon disque dur SATA dispose de deux
connecteurs d’alimentation. 
Je dois les brancher tous les deux.

FAUX. Certains disques durs SATA 
ont deux connecteurs d’alimentation : l’un de
15 broches et celui traditionnel de 4 broches.
Vous utiliserez soit le nouveau connecteur 
15 broches, soit le connecteur 4 broches,
mais pas les deux en même temps. Sinon, 
le disque dur risque de ne pas fonctionner.

Les disques Serial ATA sont plus chers.

FAUX. C’est un reproche qui avait été fait 
à Apple à la sortie des premiers Power 
Mac G5. La situation a été depuis totalement
bouleversée. À quelques euros près, 
les disques Serial ATA et IDE sont au même
prix pour un modèle équivalent.

VRAI ou FAUX ?
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Pilotez votre Mac et vos logiciels

au doigt et au clavier

T
outes les applications
disposent de raccourcis
clavier. Certaines sont

affichées à côté du nom des
menus, d’autres non. Dans un
premier temps, nous vous pro-
posons un résumé des grands
principes qui vous permettront
ensuite de retrouver les rac-
courcis clavier de vos applica-
tions préférées. Comme nous
ne pouvons pas tout traiter,
nous avons choisi des logiciels

très répandus, signés Apple,
Microsoft et Adobe. Pour aller
plus loin, je vous propose de
découvrir également trois outils
pour créer rapidement des
macros, des combinaisons de
touches plus complexes ou des
activations programmées.
Vous constaterez que mes deux
outils préférés, iKey et Key-
board Maestro, ne vont pas
vous ruiner !

n Alain Lalisse

PANTHER (MAC OS X 10.3) a profondément modifié 
le tableau de bord Clavier et Souris. Un nouvel onglet, Raccourcis
clavier, se propose d’ajouter des combinaisons de touches 
aux menus qui n’en possèdent pas encore. Ceci pour 
une application particulière ou plus généralement pour tous 
vos logiciels, qu’ils soient signés Apple ou non. Dans la pratique, 
ce n’est pas aussi simple. Parfois ça fonctionne, parfois pas. 
Tout dépend en fait de comment est développée l’application 
dont vous voulez modifier les menus. De plus, n’imaginez pas 
utiliser cette particularité du système pour des applications trop
anciennes, ni pour celles qui tournent dans Classic.
L’ajout d’un raccourci clavier est en fait relativement simple. 
Tout d’abord, ouvrez votre logiciel cible (ici iTunes). Notez 
le nom exact du menu auquel vous ajouterez le raccourci (prenez
garde aux majuscules/minuscules, au «…» quand il existe). 
Vérifiez aussi que le raccourci que vous prévoyez d’ajouter 
n’est pas déjà utilisé par d’autres menus de la même application.
Fermez ensuite le logiciel cible.
Ouvrez les Préférences système > Clavier, puis Souris > Raccourcis
clavier. En bas de la liste des raccourcis du système, Panther 
propose d’en ajouter d’autres, dits « personnels ». Cliquez 
sur «+». Dans la fenêtre qui apparaît, sélectionnez le logiciel cible. 
S’il n’est pas dans la liste, ajoutez-le via Autre… Tapez exactement
le nom du menu tel que vous l’aviez noté (dans notre exemple 
iTunes, menu Réduire ou agrandir). Choisissez un raccourci 

clavier (j’ai choisi Pomme -) . Cliquez sur Ajouter et fermez 
les Préférences système. Reste à ouvrir le logiciel (iTunes) pour
vérifier que le raccourci a bien été ajouté et qu’il est opérationnel.
J’ai pu ainsi greffer sans problème un raccourci sur 50%
(affichage à 50%) dans Quark XPress 6.1 . En revanche, 
les applications Adobe sont restées récalcitrantes aux attaques
de Panther. Volonté marketing ou développement trop éloigné 
des guidelines Apple ? Vous aurez donc de bonnes surprises, 
mais aussi des déceptions. En attendant de prochaines versions
plus compatibles… Quelques remarques supplémentaires 
sur les possibilités offertes. Si vous ajoutez à un menu votre propre
raccourci alors qu’il en est déjà doté d’un, c’est le vôtre qui 

3

2

1

Souris ou clavier ? À chacun son style. Mais ceux
qui ne jurent que par leur souris devraient tout 
de même essayer de maîtriser un peu leur clavier.
Dans cet article, nous allons voir ensemble 
comment travailler avec les raccourcis clavier 
et comment créer des macros plus complexes.

1

Ajoutez des raccourcis avec Panther
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prévaudra et écrasera le raccourci
d’origine. Vous pouvez donc 
dans une certaine mesure changer 
des raccourcis existants 
qui ne nous satisfont pas. 
Notez bien que les trois points ne
s’obtiennent pas en appuyant trois
fois sur la touche «.», mais en tapant
Option–;. Enfin, le bouton 
Réglages par défaut remet en place
les raccourcis du système, 
mais ceux que vous avez créés 
pour les applications restent actifs 
– pour les retirer, sélectionnez-en un
et utilisez le signe «–» .

2

3

LA VERSION CS de Photoshop dispose de nombreux
raccourcis. Pour les afficher tous, Adobe a prévu un
menu spécifique : Edition > Raccourcis clavier… Une
fenêtre de paramétrage propose d’ajouter, supprimer, 
et de modifier tous les raccourcis de l’application .
Autre possibilité, éditer un résumé sous la forme d’une
page HTML. Pour la palette d’outils (la plus utilisée)
chaque objet possède son propre raccourci. Finis les
clics souris… 1 touche = 1 outil. Il suffit de glisser la
souris sur chaque objet, d’attendre quelques secondes
pour voir apparaître la touche correspondante .2

1

Les logiciels Adobe

Les raccourcis dans quelques grands logiciels

1

2

3

Photoshop Elements 3 n’est pas en reste. Certes, 
il n’est pas aussi complet que son grand frère, 
mais il possède également des touches pour activer 
les outils . Toutefois, la reconfiguration de tous 
les autres raccourcis n’est pas possible ici.

3
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Il y a beaucoup de raccourcis
clavier dans le Finder, les iApps
et les logiciels de base livrés
avec le système. Vous les voyez
lorsque vous déroulez les menus,
mais libre à vous d’en afficher
une liste plus complète. Pour cela, même chez Apple, il y a 
différentes écoles. Tout d’abord, iChat et Carnet d’adresses 
ne possèdent aucune liste. En revanche, iPhoto, iTunes, iMovie,
iSync, iCal et Lecteur DVD ont un menu spécifique (Aide > 
Raccourcis clavier) . Pour Safari et Mail, ouvrez l’aide générale
de l’application et recherchez le mot « raccourcis » pour trouver 

la bonne page .
Enfin, le Finder 
possède de nom-
breux raccourcis 
en tout genre. 
Ici aussi, faites 
Aide > Aide Mac et
tapez « raccourci ».
Vous imprimerez
directement 
les pages 
de raccourcis clavier
ou les transformerez
en fichiers PDF,
toujours via 
le dialogue 
d’impression. 
Vous pouvez encore
faire un copier/
coller du texte vers
un logiciel comme
Word, mais 
dans ce cas, 
vous perdez toute 
la présentation.

2

1

Les logiciels Apple

WORD ET EXCEL possèdent de nombreux raccourcis
non documentés dans les menus. Comment les récupérer ?
Même principe que pour Apple : la première démarche
consiste à ouvrir l’aide et à taper « raccourcis ». L’aide
d'Excel, plus synthétique, est un peu mieux faite que celle 
de Word. Pour voir les affectations de raccourcis clavier 
une à une, allez dans le menu Outils > Personnaliser > 
Personnaliser le clavier…Vous y retrouverez toutes 
les commandes avec leur affectation clavier lorsqu’elle
existe. Notez que l’on peut avoir plusieurs combinaisons
de touches pour une seule commande . Et c’est 
à ce niveau que vous supprimez un raccourci clavier qui
vous gène. Très simplement, sélectionnez-le et faites 
Supprimer . Inversement, vous en créerez de nouveaux.
Choisissez la fonction qui vous intéresse et saisissez, 
dans la zone Nouvelles touches de raccourci ,
la combinaison directement au clavier. Office vous indique
si elle est éventuellement déjà utilisée. Dans ce cas, 
il convient soit d’en changer, soit de supprimer 
l’originale avant que de pouvoir affecter la nouvelle. 
Petit aparté : Word et Excel, bien qu’ils possèdent, 
pour cette fonction, des menus identiques, ont 
un comportement assez différent. Ainsi, alors que 
vous pouvez supprimer n’importe quel raccourci dans
Word, Excel ne vous permet pas de supprimer ni d’éditer
ceux qui ont été définis par Microsoft. Avec Excel, 
vous ne sauriez qu’en ajouter. Autre petite particularité 
de Word : Microsoft a introduit une fonction interne qui
liste toutes les commandes. Allez dans le menu Outils >
Macro > Macros et
tapez « ListCommands »
et exécutez-la. 
Une petite fenêtre 
de dialogue vous 
propose la configura-
tion actuelle ou 
la liste exhaustive de
toutes les commandes.
Un fichier Word de
résultat est créé .54

3

2

1

1

2

2

1

3

4

5

Microsoft Word et Excel
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iiKKeeyy 22 
Prix : 30 $ (22,50 € env.). Éditeur : Script Software

IKEY TRAVAILLE EN TÂCHE DE FOND. Il s’installe
dans les Préférences système et dans la barre
de menus si vous le souhaitez. Il est totalement
transparent à l’utilisateur : démarrage 
automatique, en attente des raccourcis clavier.
L’éditeur de raccourcis n’est pas lancé 
et n’apparaît pas dans le Dock. L’interface 
est en français, mais la documentation très
complète de 147 pages, écrite par le célèbre
Adam C. Engst, éditeur de TidBITS, reste 
en anglais. Heureusement, iKey 2, bien que 
puissant, est plus simple d’emploi que Quickeys. 
La fenêtre-tiroir est dotée de trois onglets.
D’abord, le contexte définit quand iKey est actif :
tout le temps ou seulement quand une 
application X est lancée ou au premier plan. 
Les lanceurs précisent ce qui active la macro :
une combinaison de touches, une date et 
une heure précises ou régulières, un événement
généré par une application ou un événement
système. L’onglet Commandes liste enfin 
toutes les actions que vous pouvez faire, 
classées par thèmes.

1

SOPHISTIQUÉ, MAIS COMPLEXE À MAÎTRISER. De plus, Quickeys n’est toujours pas en français et 
son interface est un peu brouillonne. Enfin, il ne fonctionne pas non plus en tâche de fond : il faut
donc le laisser sans cesse ouvert pour pouvoir l’utiliser. En contrepartie, Quickeys est un outil 
très polyvalent. Il sait faire beaucoup de choses. Il y a peu de tâches que vous n’arriverez pas 
à automatiser in fine. Dans la dernière version, CE Software a ajouté une méthode de création de
macros par enregistrement automatique. Lancez l’enregistrement, réalisez toutes les opérations
les unes derrière les autres : Quickeys détecte et enregistre tout, y compris les temps de pose. 
Au final, la macro fait exactement ce que vous voulez, reste à l’optimiser. Preuve que la program-
mation d’une macro n’est pas simple, CE Software a aussi ajouté un débogueur à la version X2.

QQuuiicckkeeyyss XX22
Prix : 100 $ (75 € env.). Éditeur : CE Software

1

2

3

4

3 logiciels pour automatiser les tâches

En pratique
Photoshop Elements 3 ne dispose pas 
de raccourci clavier pour la fonction Recadrer.
Rien de plus simple de lui en offrir une avec
iKey. Cet exemple ne fait appel qu’à une seule 
commande, le choix d’un menu, mais rien ne
vous empêche de construire des macros plus
complexes avec enchaînement de plusieurs 
commandes. Dans l’éditeur d’iKey, créez une
macro Recadrer. Avec le petit « + », choisissez
une commande de type Menu. Vous ne connais-
sez pas les numéros des menus à renseigner ?

Laissez faire iKey. Il y a un bouton prévu 
à cet effet ; cliquez dessus, puis effectuez le
recadrage dans Photoshop Elements 3. Miracle !
Les données correctes sont entrées dans la
commande . Validez. Définissez maintenant
le contexte actif : lorsque Photoshop Elements 3
est lancé. Déterminez une combinaison 
de touches pour l’activation de cette macro 
tout simple . La macro est prête . Elle
apparaît dans l’éditeur et sera active à chaque
fois que vous utiliserez Photoshop Elements 3.

43

2
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KEYBOARD MAESTRO EST VRAIMENT BIEN PENSÉ. Son interface utilisateur, en français, 
est maîtrisée en quelques minutes. La fenêtre principale liste toutes les macros
créées – rangées par groupe au besoin. Pour créer une macro, cliquez sur 
le bouton Nouvelle Macro. Pour en supprimer une, sélectionnez-la et faites un glisser-
déposer dans la corbeille du Bureau. L’utilitaire propose aussi la permutation 
d’applications, de fenêtres et aussi de presse-papiers (via deux onglets qui activent 
et configurent ces fonctions). Actif en tâche de fond, Keyboard Maestro se lance 
à l’ouverture de session : une fois les macros construites, fermez l’utilitaire. Keyboard
Maestro est encore plus simple d’utilisation qu’iKey 2, mais l’activation de menus, 
par exemple, n’est pas sûre à 100%. Ainsi, le recadrage dans Photoshop Elements 3
n’est pas basé simplement sur le nom du menu et iKey 2 détourne le problème 
en récupérant les index correspondants, ce que ne fait pas Keyboard Maestro.

1

En pratique
Nous voulons ouvrir, d’une seule 
combinaison de touches, plusieurs sites
Web consacrés au Mac. Faites Nouvelle
Macro et donnez-lui un nom. Le popup
menu liste un ensemble d’actions
très variées. Choisissez l’ouverture 
d’un site Web et tapez son URL.
Recommencez pour chaque site. Notez
que les tâches sont numérotées .
Vous pourrez les remettre dans l’ordre
qui vous convient ensuite en les dépla-

çant à la souris. La macro construite, 
il faut l’activer. Plusieurs possibilités : 
la traditionnelle combinaison de touches

, un événement sur une application,
un timer, une palette de macros. Au final,
faites Enregistrer pour que votre macro
apparaisse dans la liste. Vous reviendrez
d’ailleurs éventuellement dessus pour la
modifier, changer l’événement… Fermez
Keyboard Maestro. Une combinaison 
de touches plus tard, les trois fenêtres
des sites Web Mac s’affichent d’un coup. 

5

4

3
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KKeeyybbooaarrdd MMaaeessttrroo 22 
Prix : 20 $. Éditeur : Stairways Software
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Objectif : rationnaliser des tâches
manuelles répétitives. Des flux très
simples comme des flux complexes,
notamment dans le pré-presse. 
Certes, c’est déjà possible via 
la programmation AppleScript… 
qui impose de savoir programmer.
Mais avec Automator, ce devrait être
bien plus simple. Automator 
contiendra d’origine une bibliothèque
d'actions concernant Mac OS X 
lui-même et un certain nombre 
de logiciels, notamment ceux d’Apple.
Chaque action conçue pour effectuer
une tâche particulière (comme trouver
les images liées dans une page Web,

renommer un groupe de fichiers ,
créer un nouvel événement dans 
un agenda iCal) et correspond 
à une étape particulière du processus
de réalisation. Les résultats d'une
action sont directement transmis à 
la suivante. À l’utilisateur d’enchaîner
les actions dans un certain ordre… 
Ce qui est grandement facilité par 
l’environnement d’édition totalement
graphique et constamment assisté. 
S’il s’appuie sur AppleScript, Automa-
tor dispose toutefois de ses propres
API et les développeurs devront 
adapter leurs logiciels et créer 
des bibliothèques actions adéquates.

Automator, une nouveauté Tiger
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Dopez Photoshop Elements 3

avec des plug-ins
L

es plug-ins, disponibles en très grand nombre, sont des
logiciels développés soit par Adobe, soit par des édi-
teurs tiers. Ils apportent de nouvelles fonctions ou per-

mettent de réaliser des effets graphiques particuliers. On les
appelle également filtres ou modules externes. Pour les utiliser,
c’est en général très simple : ils s’installent tout bêtement dans

le dossier Plug-Ins que vous trouverez dans votre dossier Pho-
toshop Elements. La plupart des plug-in sont commercialisés
(souvent entre 15 et 25 dollars) et les plus réputés valent sou-
vent assez cher (plus de 100 dollars). Dans ce domaine
comme dans d’autres, vous trouverez également des plug-ins
distribués en freewares. n Vincent Boyer

Photoshop Elements 3 est un produit complet aux nombreuses fonctions, mais qu’on peut 
encore enrichir grâce à la plupart des plug-ins conçus pour son grand frère Photoshop.

Des plug-ins pour quoi faire ?
CERTAINS MODULES SONT TRÈS SPÉCIALISÉS
et servent à combler des lacunes de Photoshop/
Photoshop Elements ou proposent encore 
des alternatives plus complètes aux fonctions
déjà présentes dans le logiciel d’Adobe. 
Ainsi, Mask Pro d’Extensis (200 $) est un outil 
de détourage efficace et précis qui manque 
cruellement à Photoshop Elements 3 . 
Moins cher et tout aussi complet, KnockOut 2 
de Corel (100 $) est une bonne solution. 
Mais, la plupart des plug-ins sont des moteurs 
d’effets spéciaux. Sans eux, il serait laborieux 
et complexe d’obtenir des résultats convaincants
et rapides à partir des seuls outils de Photoshop,
ou tout simplement impossible. Par exemple,
Alien Skin propose Eye Candy 5 Textures (100 $)
qui est compatible Photoshop Elements en natif.
Ce plug-in permet de simuler des effets de four-
rure ou d’écailles, de texture de briques ou 
de métal, de manière totalement paramétrable. 
Extensis et Alien Skin ont aussi à leur riche 
catalogue des modules pour créer des cadres 
– respectivement PhotoFrame 2.5 (200 $) 

et Splat ! (100 $). Cela va du simple au double 
question prix et pourtant ces deux plug-ins 
se valent à peu près. À vous de voir, donc… 

L’éditeur Flaming Pear propose quant à lui 
de nombreux filtres d’effets spéciaux 
(effets d’eau, de lumière, de texture entre autres)
que vous pouvez tous tester en version démo.
Enfin, il existe des plug-ins, comme Booster 
Elements (30 $) de Human Software, qui 
vous permettent d’utiliser les courbes de façon
précise. Une fonctionnalité que n’offre pas 
Photoshop Elements, mais qui peut être utile 
aux photographes. Un dernier conseil, 
n’abusez pas trop des plug-ins et servez-vous 
des effets spéciaux avec créativité. 
Par ailleurs, veillez à n’installer que ceux 
qui vous sont réellement utiles : ces produits 
sont souvent gourmands en ressources 
système et auront très vite fait de ralentir 
Photoshop Elements.

2

1

1

2
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CE N’EST MALHEUREUSEMENT
pas très évident si vous 
ne savez pas précisément 
ce que vous cherchez. Aucune
base de données exhaustive 
n’a été constituée. Mais de
nombreux sites tentent 
toutefois de regrouper des
offres, tant des produits 
commerciaux que des 
sharewares et freewares.
Le site Adobe Studio 
Exchange est une piste,
mais il n’est proposé qu’en
anglais. Le site Internet 
Photoshop Filters.com 
propose un recensement 
intéressant, de même que 
Photoshop Support . C’est
là aussi un bon point de
départ. Vous pouvez 
également vous tourner vers
les sociétés XChange et 
Apacabar qui sont les 
principaux distributeurs de
plug-ins professionnels en

France. Une autre méthode
consiste simplement 
à taper quelque chose comme 
« plugins photoshop »
(ou une variante) dans votre
moteur de recherche. 
Vous constaterez que la liste
retournée est très longue. Ce
n’est donc pas facile à 
exploiter, mais c’est aussi
comme cela que vous mettrez
la main sur des plug-ins 
gratuits (ajoutez le terme 
« freeware » à votre requête). 
Attention au moment de 
télécharger plug-ins, modules
et effets, à bien choisir 
leur version pour Photoshop
pour Mac OS X ; des milliers 
de plug-ins n’existent que pour
Photoshop Windows. Une 
version développée pour 
Windows ou Mac OS 
classique… ne fonctionnera
pas avec la version de 
Photoshop pour Mac OS X.

3

2

1

1 Ouvrez votre image, puis rendez-vous dans le menu Filtre et
choisissez Alien Skin Splat > Frame. La fenêtre Splat! s’affiche

avec à gauche deux curseurs qui servent à régler la taille 
du cadre et sa marge de profondeur. Ajustez-les à votre guise.

2 Le bouton Browse juste 
au-dessus des deux 

curseurs vous permet de vous 
promener dans la bibliothèque 
de cadres. Vous pouvez 
d’ailleurs en télécharger d’autres 
sur le site de l’éditeur. 
Votre cadre est enfin prêt. 

C
ommencez par télécharger la démo gratuite de Splat! et cliquez sur Demo.
Cette version est presque complètement fonctionnelle pour 30 jours. Lancez l'installateur et, lorsqu’on vous le demande, sélectionnez votre dossier
Plug-Ins situé dans le dossier Photoshop Elements. Lancez Photoshop Elements.

Encadrez vos photos et illustrations avec Splat!

3Mais ne nous arrêtons pas là…
Rendez-vous dans le menu 

Filtres et sélectionnez cette fois 
Border Stamp. Cette fonction permet
de rajouter des motifs tout autour 
de votre photo. S’agissant d’une
photo de mariage, nous rajouterons
adéquatement des pétales de roses
en cliquant sur Browse et en 
sélectionnant Flowers > Roses petals.

1

2

3
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E
n fait, sans même le savoir, vous pouvez déjà utiliser la
philosophie fondatrice de Spotlight sur Mac OS X. Si
vous utilisez régulièrement iTunes, vous devez connaître

la fonction des listes de lecture intelligente, dites Smart Playlist.
Elle permet d’organiser, selon des règles que vous fabriquez

très simplement, des listes de lecture de séquences musicales,
quelle que soit leur place dans votre bibliothèque iTunes.
Nous allons voir que ce principe peut être également appliqué
à quelques autres types de fichiers : les documents PDF et les
fichiers QuickTime. n Fred Blaison

PRENONS UN EXEMPLE CONCRET pour mieux 
comprendre ce que sont les listes de lecture 
intelligentes d’iTunes. Imaginons que vous 
souhaitiez avoir dans un dossier spécifique 
une sélection aléatoire de 50 morceaux de pop.
Très simple ! Déroulez le menu Fichier > Nouvelle
liste de lecture intelligente… et renseignez 
la boîte de dialogue qui s’affiche comme suit :
« le genre est pop », puis limitez à 50 morceaux
sélectionnés aléatoirement. iTunes crée une liste
intelligente en respectant vos critères de choix. 
iTunes gère vos choix sans changer quoi 
que ce soit à l’organisation réelle de votre
bibliothèque. En fait, les 50 morceaux élus
ne sont pas déplacés dans ce dossier, qui ne 
comprend que des pointeurs temporaires. 
C’est là un avant-goût des fonctions avancées 

de recherche disponibles dans Tiger et 
des dossiers « intelligents » qu’on retrouvera
dans le Finder de Tiger et d’autres applications
comme Mail ou le Carnet d’adresses. 
Une différence toutefois : avec Spotlight, 
le fichier pourra se trouver n’importe 
où, sur n’importe quel volume, alors qu’avec 
iTunes, les fichiers doivent avoir été ajoutés 
au préalable à votre Bibliothèque.
Si vous souhaitez découvrir d’autres exemples 
de listes de lecture intelligente, analysez celles
qui sont fournies avec iTunes : Ajouté récemment,
Années 90, Mon meilleur classement, Morceaux
récents. Sélectionnez une de ces listes 
en maintenant le clic droit de votre souris 
(ou Ctrl + clic long), et dans le menu choisissez
Modifier la liste de lecture intelligente .2

1

VOUS COMPRENEZ BIEN COMMENT FONCTIONNENT
les listes intelligentes d’iTunes ? Eh bien, 
nous allons en détourner l’utilisation 
pour d’autres types de fichiers reconnus par 
l’application. J’ai fait des tests avec les fichiers
PDF et les séquences QuickTime. Je n’ai 
en revanche pas trouvé d’autres types de fichiers
acceptés. Néanmoins, même si c’est limité, 
vous pourrez grâce à iTunes, et sans 
aucun frais, vous construire une bibliothèque PDF
ou un gestionnaire de fichiers multimédia. 
C’est déjà pas mal ! Vous disposez sans 
aucun doute de documents au format PDF 

sur votre disque dur : des documentations 
diverses et variées, des livres électroniques 
ou des revues achetées en ligne. Sans compter
que, désormais, vous pouvez très simplement
créer les PDF vous-même avec Mac OS X.
Ce format devient donc pour nombre 
d’utilisateurs le format de sauvegarde privilégié.
Le PDF est beaucoup moins limité que le RTF 
ou le .doc. Il peut contenir des documents 
très complexes, des tableaux, des graphiques 
vectoriels d’architecture et même de la 3D.
Les documents PDF peuvent surtout être ouverts
sur toutes les plateformes Mac OS, Windows 

et Unix, sans que celui qui les consulte ait 
à posséder les applications qui les ont créés 
ou les polices de caractères utilisées. Génial ! 
Pour créer un PDF sur Mac OS X, c’est très simple.
Par exemple, vous visitez avec Safari 
une page d’un site Internet. Vous souhaitez
conserver les informations pour les consulter
plus tard. Utilisez simplement la fonction 
Imprimez de Mac OS X pour exporter 
des documents au format PDF. Choisissez dans 
un premier temps le menu Fichier > Format 
d’impression pour vous assurer que vous 
imprimez au format A4. Puis choisissez le menu

Qu’est-ce qu’une « liste intelligente » ?

Créez puis intégrez des fichiers PDF dans iTunes

1

2

Vous attendez avec impatience les nouvelles fonctions de Tiger, notamment Spotlight, 
l’outil système de recherche globale ? Vous pouvez d’ores et déjà y goûter grâce à… iTunes.
Un lecteur de fichiers MP3 et AAC ? Bien sûr ! Mais allons un peu plus loin et découvrons ensemble 
s’il peut vous aider à gérer efficacement d’autres types de données.

Comment détourner iTunes pour en faire un

gestionnaire de fichiersPDF
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Fichier > Imprimer, puis cliquez sur le gros bouton PDF (en bas à gauche) 
et optez pour l’option Enreg. comme PDF . Une boîte de dialogue 
vous invite à donner un nom à votre fichier. Enregistrez-le provisoirement
sur votre Bureau. Il vous suffit ensuite de glisser ce (ou ces) fichiers 
depuis le Bureau vers la Bibliothèque d’iTunes. Ils seront pris 
automatiquement en charge. Pour réaliser cet article, j’ai créé des fichiers
PDF à partir des pages de portraits publiés sur le site Pro d’Apple.

3

Créez une liste intelligente spéciale PDF

La même chose avec QuickTime

3

VOS FICHIERS PDF SONT DÉSORMAIS DISPONIBLES DANS ITUNES.
Pour les organiser, la solution la plus évidente est de créer une liste de lecture
intelligente en sélectionnant comme critère, « Type est Document PDF ».
iTunes listera tous les fichiers PDF présents dans votre Bibliothèque. 
Mais nous allons pousser le principe un peu plus loin et nous servir 
des informations sur les fichiers gérées par iTunes pour normalement
caractériser les fichiers musicaux (ce qu’on appelle les « tags » MP3).
Dans iTunes, sélectionnez donc un des fichiers PDF de votre liste 
intelligente, puis faites Pomme + I. Une boîte de dialogue s’affiche 
comme si vous alliez renseigner des infos sur une chanson. 
Dans le champ Nom, j’ai entré le titre de l’article. Dans le champ Artiste,
le nom de la personne qui fait l’objet du portrait. Dans le champ 
Regroupement, j’ai mis « Apple – Pro ». J’ai fait de même avec deux autres
articles sauvegardés au format PDF.
Ensuite, j’ai créé une liste de lecture intelligente sur les critères suivants : 
« le type est Document PDF » ; « le regroupement est Apple – Pro ». Je n’ai pas 
coché la case Limitation, mais plutôt opté pour une Mise à jour en temps réel.
Enfin, j’ai nommé cette liste « Portraits, Apple Pro ». Désormais, à chaque 
fois qu’un fichier PDF est ajouté à la Bibliothèque d’iTunes et que j’indique 

un regroupement « Apple – Pro » dans ses infos, il apparaît automatiquement
dans la liste de lecture intelligente. Pour lire le fichier, je clique simplement 
sur son nom dans iTunes. L’application adéquate est ouverte, par défaut 
Aperçu. Vous pouvez changer l’application par défaut qui lit les fichiers PDF, 
en préférant à Aperçu le tout nouveau Adobe Reader 7 par exemple, 
en utilisant la fenêtre d’information de ce fichier dans le Finder.
Attention toutefois, certains documents qui apparaissent sur le Finder 

avec l’icône d’un fichier PDF standard sont en fait des packages applicatifs.
D’ailleurs, dans l’affichage en liste du Finder, vous constaterez que 
ces fichiers sont de type Application et non de type Document PDF . 
Ce sont pratiquement toujours des documentations conçues par 
Apple. Il s’agit en fait de packages qui incluent de nombreux fichiers, 
dont de véritables PDF, un par langue.
Il est possible d’en extraire le « vrai » fichier PDF dans la langue 

qui vous intéresse. Faites un clic droit (ou ctrl + clic)
sur le fichier et affichez le Contenu du paquet.
Dans le dossier Contents/Resources, vous trouverez 
les documents PDF rangés dans des sous-dossiers, 
un pour chaque langue (French.lproj, par exemple). Une fois 
le « vrai » PDF trouvé, il suffit de le glisser sur le Bureau 
pour l’utiliser directement. Vous pouvez notamment 
le glisser dans votre Bibliothèque iTunes où il sera 
immédiatement pris en compte par la liste intelligente 
que vous avez créée. Vous noterez aussi que la taille réelle 
du PDF pour cette seule langue est nettement plus petite 
que le fichier .app déguisé en PDF.

21

ITUNES ACCEPTE AUSSI LES VIDÉOS QUICKTIME.
Il vous jouera la bande son (si elle est reconnue)

et sa fonction d’illustration affichera 
la première image de la vidéo . 
Afin de connaître le type du fichier, information
nécessaire pour créer une liste de lecture 
intelligente , sélectionnez le fichier dans 
la Bibliothèque. Dans Résumé (Pomme + I), le type
devrait être Fichier de séquence QuickTime.
Attention, si vous double-cliquez sur le fichier

dans iTunes, il sera pris en charge par ce dernier…
ce qui n’est pas très intéressant puisqu’il ne sait
malheureusement pas encore visualiser les .mov.
Pour lire le fichier vidéo, vous devez d’abord 
le retrouver : cliquez sur son nom dans 
la Bibliothèque ou dans une liste de lecture. 
Puis, dans le menu déroulant, choisissez Afficher
le fichier du morceau. Le fichier sera alors révélé
dans une fenêtre du Finder et vous n’aurez plus
qu’à le lancer dans le lecteur QuickTime.

3

2

1

1

1

2

3

2
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Structurez et consolidez vos projets dans

Entourage 2004

E
ntourage 2004 vous permet de ras-
semblerenunpointcentral,dans une
seule interface de visualisation, l'en-

semble des éléments d'un projet (données,
événements, contacts...) et de suivi des
tâches etdu temps.Une des fonctions phare
de la suite bureautique Office 2004, dont je

vous propose de tirer parti sans plus tarder.
Vous pouvez bien entendu utiliser cette
fonctionpourmettreenordreetsuivre l'état
d'avancement de projets aussi divers que
préparer un tour du monde, organiser une
conférence à Apple Expo 2005, développer
un logiciel pour Mac OS X ou encore orga-

niser un mariage ! Pour illustrer cet article
pratique, je vais m'appuyer sur ma propre
expérience : je me suis servi du Centre de
projets pour consolider les informations et
actions liées à la créationdu magazine que
vous êtes en train de lire.

n Bernard Le Du

1 Lancez Entourage et, dans la palette 
des fonctions à gauche, cliquez sur l'icône 

Centre de projets. Faites Nouveau projet.
La fenêtre de l'Assistant Nouveau Projet
s'affiche en avant-plan.

2 Dans ce premier écran, donnez un nom 
au projet. Ici, Vous et Votre Mac.

Vous pouvez également glisser-déposer une image
pour identifier le projet (ici le logo du magazine),
définir une couleur de référence et préciser 
une date d'échéance (la date prévue de sortie 
du numéro 1). Cliquez sur la flèche en bas 
à droite pour passer à l'écran suivant.

4 Par défaut, Entourage crée un dossier, 
dit Dossier Finder, qui porte le même nom

que le projet. Il est placé par défaut dans 
le répertoire Utilisateur/documents/projets
Office (donc en dehors du fameux répertoire
Utilisateur/documents/données utilisateurs
Microsoft). Ce dossier Finder contient 
des fichiers relatifs au projet – soit 
les originaux, soit des alias - s'ils sont 
stockés ailleurs sur le disque ou partagés 
entre plusieurs projets, par exemple.

3 Ici, vous définissez les « dossiers espions »
(l'appellation américaine « Watch Folder »

est de meilleur goût). Ces deux dossiers 
– le Dossier Finder et le Dossier Entourage – sont
créés pour regrouper des éléments du projet.

Lorsque vous initiez un projet ou y participez, vous êtes amené à gérer un grand nombre 
d'éléments et de documents variés. Comment y voir plus clair, ne pas oublier un rendez-vous 
ou un coup de fil à passer, ni égarer un courrier, un plan, une feuille de calcul ? 
Le Centre de projets d'Entourage 2004 apporte une réponse simple et efficace.

À savoir !
Entourage 2004 n'est commercialisé qu’avec Office
2004. Pour bénéficier du Centre de projets, vous
devrez acquérir la suite complète (Standard : 580 € ;
Mise à jour : 330 € ; Éducation : 175 €). Seuls 
les événements, tâches, contacts et messages élec-
troniques issus de la base de données d'Entourage
sont gérés par le Centre de projets. Pas question 
de l’interfacer avec Mail, Carnet d'adresses et iCal. 
Le seul moyen de vivre à cheval sur les deux mondes
consiste à synchroniser les bases de données 
des uns et des autres (lire Synchronisez Mac OS X 
et Entourage, dans Vous et Votre Mac N°1).

Créez un nouveau projet

MINI•DOC
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5 Le second dossier, dit Dossier Entourage,
correspond, lui, à une boîte 

aux lettres Entourage au nom du projet.
Cette boîte regroupe les messages électroniques
liés au projet. Vous ne pouvez y accéder 
que par l'interface des boîtes aux lettres 
d’Entourage, par le Centre de projets
ou par la Palette de projets.

7 Le troisième écran vous autorise à définir
des règles assurant automatiquement 

un routage des messages vers un projet donné,
en fonction de l'adresse de l'émetteur, 
de leur objet (à ce niveau, trois mots-clés 
peuvent être précisés), ou bien selon des règles
plus ou moins complexes que vous définissez
avec Entourage (menu Outils > Règles).
Vous pouvez enfin demander qu'un alias 
du dossier de votre projet (Utilisateur/
documents/projets Office/projet) soit placé sur
le bureau, donc immédiatement accessible.

6 Vous pouvez aussi intégrer directement 
à votre projet des éléments autres 

que des fichiers : des contacts, des événements,
des tâches à effectuer, etc., qui ont été créés 
par ailleurs dans Entourage. 
Il suffit pour cela d'avoir défini dans Entourage
une catégorie correspondant au projet. 
Tout élément marqué dans cette catégorie 
sera référencé automatiquement dans le projet. 
Vous procéderez de même pour mettre 
en commun des éléments appartenant à un autre
projet ou à un sous-projet.

1 Vous ajoutez un mémo, une présentation 
ou une feuille de calcul à un projet 

directement depuis les logiciels Word 2004,
Excel 2004 et PowerPoint 2004 via la Boîte 
à Outils (icône de boîte à outils rouge dans 
la barre de menu Standard), onglet Projets.
Pour les autres fichiers, vous devez passer 
par le Centre de projets d'Entourage puis, 
dans l'onglet Fichiers ou à partir de la Vue 
d'ensemble, ajoutez le ou les fichiers. 
Vous pouvez le faire en cliquant sur Ajouter
ou par simple glisser-déposer. Dans ce cas, 
le fichier original n'est pas physiquement
déplacé, mais un alias est créé 
dans le dossier espion Finder du projet.
Si vous enregistrez directement un document
dans le dossier espion Finder du projet ou 
son alias sur le bureau, c'est le fichier original
qui est alors directement intégré au projet.

3 Le client de messagerie instantanée 
MSN Messenger est lui aussi intégré 

au Centre de projets. D'une part, vous gérez 
des adresses MSN depuis un projet. 
D'autre part, les dialogues échangés avec 
les membres du groupe de travail, par exemple,
ou avec un contact lié d'une manière 
ou d'une autre au projet, sont enregistrables
dans le cadre d'un projet. 
La conversation sera initiée depuis le client 
MSN Messenger 4.1 (fourni en standard 
avec Office 2004) ou directement depuis 
le module Contacts d'Entourage 
(les contacts qui disposent d'un compte MSN
voient leur icône changer selon leur état 
de connexion sur le réseau).

2 Tous les rendez-vous, réunions, repas 
d'affaires, …, ainsi que les tâches 

que vous avez planifiées dans le cadre 
d'un projet peuvent être gérés depuis le Centre
de projets (à condition bien sûr que vous 
vous serviez des modules Calendrier et Tâches
d'Entourage). Vous créerez des événements 
et tâches aussi bien dans les modules
Calendrier et Tâches que dans un projet 
lui-même, le Centre de projets n'étant 
d'une certaine manière qu'une autre approche,
une autre vue sur vos activités et vos 
informations professionnelles et personnelles.
Lorsque vous créez un événement dans 
Calendrier ou une tâche dans Tâches, vous 
l'intégrez à un projet via le menu déroulant 
Projet, à l'extrême droite de la barre d'outils.

Intégrez des éléments au projet
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1 En pratique, il suffit d'afficher le Centre 
de projets, de passer en Vue d'ensemble

puis de cliquer, en bas à gauche, 
sur l'icône Sauvegarder. Suit l'affichage 
de deux fenêtres dans lesquelles vous renseignez
les paramètres de la sauvegarde.
L'archivage concernera tout ou partie 
des éléments d'un projet : messages, contacts,
tâches, notes, événements, mais aussi les fichiers.
Attention, le fichier généré est un « .rge » 
qui ne peut être ouvert que par Entourage.
Cette procédure peut être également utilisée 
pour exporter un projet afin de l’ouvrir 
avec Entourage 2004 sur une autre machine.

Si vous êtes plusieurs à travailler sur un même
projet, son initiateur peut décider de le partager 
afin que tous les membres du groupe puissent
avoir accès aux divers éléments 
– sauf les mails et les clips stockés dans l'Album
(Boîte à outils > onglet Album). Il suffit 
de placer le projet sur un serveur de fichiers
auquel les autres collaborateurs ont accès.
C'est le créateur du projet qui prend l'initiative 
de le partager, qui décide de ce qui sera ou non
partagé, de façon automatique ou non.
Tous les éléments partagés sont couverts 
par les mêmes privilèges de lecture et d’écriture
ouverts à tous les collaborateurs invités.

1 La Palette de projet se cache dans la Boîte 
à outils. Pour y accéder, il suffit de cliquer

dans la barre Standard des différentes 
applications, sur l'icône en forme de boîte 
à outils rouge, puis dans la fenêtre qui s'ouvre
sur l'onglet Projets. S'affiche alors une vue
d'ensemble synthétique du projet courant.
Pour passer à un autre projet, faites votre choix
dans le popup menu (à côté du nom du projet).
Le résumé synthétique présente, pour un projet
donné, une liste d'événements planifiés pour 

la journée, une liste des tâches programmées,
une liste de messages récents ou nouveaux... 
Chaque liste est dotée d'un bouton Ajouter
pour intégrer au projet le document 
en cours d'édition, créer un événement, 
une tâche ou un autre élément.
Vous pouvez également consulter le contenu
des dossiers espions Finder et Entourage, 
grâce aux deux petites icônes correspondantes.

Accédez à votre projet depuis Office

Travaillez en groupe sur des projets

Archivez un projet
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Montez un film, sonorisez et titrez-le avec

seulement QuickTime Pro

T
ous les utilisateurs Mac OS – et de
plus en plus de « Windowistes » –
connaissent QuickTime. Mais peu

s’offrent un « ticket» pour QuickTime Pro.
Pourtant, si vous êtes un tant soit peu créa-
tif, cette version non bridée vous est indis-
pensable. Sous son apparente simplicité, ce
sont des fonctions de montage, doublage,
sous-titrage...  qui sont à portée de main !
Et sans recourir à un logiciel dédié. Vous
avez aussi la possibilité de monter n’im-
porte quel format (excepté les MPeg-1 et 2)
sans avoir à en passer obligatoirement par
le DV. Nous allons vous le prouver en
créant un film de toutes pièces avec de la
vidéo, du son et des titres. n Vincent Boyer

Apple commercialise sous le nom de QuickTime Pro une version complète de son lecteur 
et compresseur de médias. Pour quelque 41 €, vous disposez de fonctions non accessibles 
en standard qui vous permettent d’aller bien au-delà de la simple lecture.

À savoir !

Montez avec QuickTime Pro

AUSSI ÉTONNANT QUE CELA PUISSE PARAÎTRE, il est 
possible de faire un montage de base directement
depuis le lecteur. Ouvrez votre séquence vidéo et
repérez les deux petits triangles situés juste 
au-dessus du réglage de volume. Grâce à eux, 
vous pouvez sélectionner la partie à traiter ou bien
à supprimer. Déplacez le second triangle vers la fin
de la partie et le premier au début [1]. Pour effacer
la partie ainsi sélectionnée, il suffit d’appuyer 
sur la touche Supprimer. Vous pouvez répéter 

l’opération sur une autre partie de la séquence. 
Faites de même sur toutes les séquences 
que vous souhaitez intégrer dans votre projet, puis
copiez-collez-les à la suite pour les monter. 
Si vos séquences ne sont pas toutes à la même
taille, utilisez la fonction Ajuster à l’échelle dans le
menu Édition. Preuve de la puissance de QuickTime
Pro, vous pouvez également déplacer votre vidéo
pour la centrer, par exemple. Sélectionnez 
Lire les propriétés de séquence dans le menu

Séquence [2] puis sélectionnez la Piste vidéo 2
dans le menu Séquence (les vidéos ajoutées,
et leurs bandes sonores le cas échéant, sont 
empilées comme des calques). Rendez-vous 
ensuite dans le menu déroulant à droite du menu
Séquence dans lequel vous choisissez Dimensions,
puis vous cliquez sur Ajuster et déplacez 
à la souris votre vidéo où bon vous semble. 
En redimensionnant la seconde vidéo, vous créerez
un effet « vidéo dans la vidéo », par exemple [3].

Cette Mini Doc ne donne qu’un bref aperçu 
des riches possibilités de QuickTime Pro. 
Vous pourrez également concevoir des 
interfaces (skins) pour personnaliser vos 
séquences, ajouter des sous-titres, marquer 
des chapitres, utiliser le langage SMIL pour 
rendre vos séquences interactives… 
Si vous lisez l’anglais, n’hésitez pas à vous 
rendre sur l’excellent site Web QuickTime 
d’Apple, bien fourni en pas à pas. 

1 2 3
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QUICKTIME PRO DISPOSE de ses propres effets. 
Pour les appliquer, vous devez impérativement 
utiliser le format QuickTime (.mov). Ouvrez 
votre séquence, choisissez Exporter dans 
le menu Fichier, puis Séquence vers QuickTime
dans le menu déroulant Exporter. Cliquez ensuite
sur Options et, si ce n’est déjà fait, cochez 
la case Vidéo pour accéder au bouton Filtre [4].
Vous pouvez maintenant appliquer l’un des 14 effets
proposés, notamment Nuances qui vous permettra
de passer votre séquence en N&B, Sépia 
ou encore Rayon X [5]. Pour appliquer 
plusieurs effets à une même séquence, il suffit 
de répéter l’opération en choisissant à chaque fois
un filtre différent.

Ajoutez des effets

LE LECTEUR PERMET ÉGALEMENT de créer 
très simplement des diaporamas. Faites Ouvrir
une suite d’images dans le menu Fichier [9],
puis sélectionnez votre dossier d’images. 
Cliquez sur le premier fichier et validez. 
QuickTime Pro vous propose ensuite de régler 
le nombre d’images par seconde [10].
Il ne reste plus qu’à ajouter une bande son.

...et l’image

Travaillez le son…

VOUS POUVEZ ISOLER LA BANDE SON 
d’une séquence (ou inversement la bande vidéo
de la bande son) grâce à la fonction Extraire 
les pistes du menu Édition [6]. Les fonctions 
Activer et Effacer les pistes parlent d’elles-
mêmes. Une fois la piste extraite, vous avez 
les mêmes possibilités de montage 

qu’avec la vidéo : supprimer un blanc en début 
ou fin de piste par exemple. Vous pouvez 
bien entendu éditer des fichiers MP3, AIFF 
et même des fichiers AAC protégés [7]ou non.
Bref, tous les formats supportés par QuickTime.
Pour ajouter une piste audio à une piste 
vidéo, copiez-collez-la, puis faites Ajouter dans 

le menu Édition en plaçant le curseur de lecture
là où elle doit débuter. Pour régler le volume, 
faites Lire les propriétés de séquence, puis 
sélectionnez la Piste son voulue et optez 
pour Volume dans le second menu déroulant.
Vous avez également la possibilité de régler 
les Basses et les Aiguës ainsi que la Balance [8].

4

6 7

9 10

8

5
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Partagez des fichiers entre Mac et PC

grâce à SharePoints

E
n standard, le système de partage
de Mac OS X vous autorise à par-
tager votre dossier Public (Users >

Compte d'utilisateur > Public) avec d'au-
tres utilisateurs de Mac et de PC sous
Windows, et ce en quelques clics. Mais
vous souhaiteriez aussi avoir la souplesse
de pouvoir partager d'autres répertoires,
y compris sur des volumes différents du
disque ou du volume de démarrage. Pour-
quoi pas même sur un disque externe ? 
C'est tout à fait possible ! Mais il vous
faudra pour ce faire utiliser un petit logi-
ciel dénommé SharePoints. Ce merveil-
leux utilitaire développé par Michael
Horn est bel et bien localisé par Bruno
Lapeyre. Hélas pas sa documentation
(bien que ce soit prévu puisqu'il existe
déjà dans l'image que vous téléchargerez
un fichier French Documentation...
vierge). Je vous propose donc une Mini
Doc de SharePoints, à laquelle j 'ai
rajouté l'utilisation complémentaire de
SharePoints Automounter et d'ASF
Monitor, deux autres petits outils signés
du même auteur. n Bernard Le Du

1 Tout d'abord, vérifiez l'état du partage 
de fichiers dans le panneau Partage.

Activez le Partage de fichiers si ce n'est 
pas déjà le cas.
Activez aussi le Partage Windows
(via le serveur Samba de Mac OS X) 
si des utilisateurs de PC sous Windows sont 
susceptibles d'accéder à votre Mac. 
Notez votre adresse IP, en bas. Vous devrez 
la communiquer à ceux que vous autoriserez 
à se connecter.

2Créez, quelque part sur votre machine, 
un dossier que vous partagerez. 

Ici, le dossier est dénommé Partage BLD
et notez qu'il n'est pas sur le volume 
de démarrage. Il pourrait très bien être
sur un disque dur externe.

SharePoints est un donationware (c’est-à-dire que vous êtes invité à verser quelques euros si vous 
vous servez de ce logiciel de façon permanente).

Préparez le partage

Retrouvez toute la souplesse 

du partage de fichiers de Mac OS 9

sous Mac OS X et partagez grâce 

à SharePoints tout ce que vous voulez

et rien que ce que vous voulez.
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1SharePoints est disponible en deux versions
fonctionnellement identiques. Choisissez 

donc celle que vous voulez : une application 
double-cliquable ou un Panneau de préférences.

3SharePoints n’a qu’une fenêtre à onglets. 
Placez-vous dans l'onglet Partage 

”normaux”. Donnez un nom au partage 
(champ Nom du partage) : ici Partage BLD.

2Dans cet article, nous utilisons la version Pan-
neau de préférences. Pour ouvrir le panneau

SharePoints, passez par les Préférences Système.
SharePoints se trouve à la section Autre.

5Cliquez sur le bouton Valider le partage,
en bas à droite. Votre mot de passe 

administrateur vous est alors demandé.

les nouveaux fichiers/dossiers créés dans 
le dossier partagé auront les mêmes privilèges 
que ce dernier (s'applique à l'égard des utilisateurs
Mac, ou PC, en connexion de type AppleShare, 
et non aux utilisateurs PC via Samba). En cochant
en plus la case Possesseur (possesseur Apple) ,
tous les fichiers et dossiers créés dans le dossier
partagé auront de facto le même propriétaire 
que le dossier partagé. Cochez la case Accepter 
les invités Windows si vous autorisez 
la connexion d'utilisateurs Windows en simple 
mode Invité. Reste donc à préciser (bouton 
Définir) le chemin d'accès au dossier partagé, 
ici Partage BLD dans le champ Dossier .
Positionnez les menus déroulants 
Partage de fichiers et Partage SMB (Windows)
sur le choix Activé (+) .6

5

4

3

6

5

4

3

6Comme vous le constatez 
dans la partie supérieure de la fenêtre 

de SharePoints, le partage du dossier 
Partage BLD est désormais actif.

8 L'onglet Groupes permet de créer des 
groupes d'utilisateurs et de les administrer.

Pour remplir le champ GID (Group ID), laissez
le logiciel attribuer lui-même l'ID afin d'éviter
tout conflit. Pour intégrer des utilisateurs 
à un groupe, sélectionnez un groupe 
dans la liste à gauche, cliquez sur un utilisateur,
puis sur le gros bouton « + ».

7 L'onglet Utilisateurs & doss. Public
permet de créer des utilisateurs nominatifs

qui seront limités strictement au seul usage 
du service de partage de fichiers. Pour remplir 
le champ UID (User ID), le mieux est d'appuyer 
sur le bouton UID suivant, le système 
attribuera lui-même l'ID afin d'éviter tout conflit.
Cliquez sur Ajouter l'utilisateur.

1

2

4Précisez les autorisations d'accès au dossier
partagé . Les fichiers et dossiers 

déplacés dans ce dossier conserveront 
leurs privilèges originels. Cochez la case
Héritage : Autorisation du dossier parent :2

1

Préparez SharePoints
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11Connexion au dossier partagé Partage BLD 
à partir d'un Macintosh du réseau local.

Notez que le dossier Public est accessible puisque
je me suis connecté à partir de la machine 
distante avec le même compte d'utilisateur.

10 L'onglet Partage SMB est à renseigner 
si vous avez prévu la connexion 

d'utilisateurs PC sous Windows via SMB.

Conçu par le même développeur que l’utilitaire SharePoints,
AFS Monitor est un petit shareware à 5 $ (3,70 € env.) qui 
vous permettra de contrôler, par l’entremise d’une console 
(ci-dessous) et via une icône dans le Dock, l'activité réseau
concernant les dossiers que vous avez partagés. Remarquez
qu’AFS Monitor, comme
son nom le sugère, ne
s’aperçoit que du trafic
utilant le protocole AFP :
vous ne verrez donc 
que les machines 
interconnectées via 
le partage AppleShare, 
mais aucun des PC 
qui seraient connectés 
par le protocole Samba.

Un autre outil complémentaire, 
lui aussi proposé à 5 $, est 
à installer sur les machines 
du réseau qui se connectent 
à des dossiers partagés, soit par
Mac OS X, soit par SharePoints, soit
via Samba. Il suffit de connaître 
le nom du serveur, son adresse IP
et le nom du volume 

partagé. Grâce à SharePoints Automounter, ces ressources
réseau sont automatiquement 
montées lors d’un redémarrage 
ou lorsque vous ouvrez une session. 
Il faut toutefois que ces dossiers soient
en accès ouvert aux invités, et 
non en accès nominatif.

12Connexion au dossier partagé Partage BLD
effectuée à partir d'un PC fonctionnant

sous Windows XP Professionnel. Mon dossier
public n'est pas visible ; seul le dossier Partage
BLD, partagé via SharePoints et SMB, est accessible.

Vous n'avez « que » deux 
ou trois Mac à la maison
et vous voulez partager
des dossiers autres que 
les répertoires Départ ?
Pas la peine d'utiliser 
SharePoints. Le petit 
freeware OMSP 0.1 
(pour Organize 
My SharePoints), 
de Sebastian Krauss, 
fait très bien l'affaire. 
Les possibilités 

de paramétrage sont 
certes limitées au strict
minimum, mais c’est 
un bon petit outil 
« clic-bouton ».
Pour partager une 
ressource, il suffit 
d'indiquer son chemin 
et de lui donner un nom.
C’est simple comme 
bonjour. Il semble 
que Sebastian Krauss 
ait stoppé tout 

développement d'OMSP. 
Le logiciel n'est plus 
téléchargeable via 
son site, mais il reste 
disponible sur le site
Versiontracker.

Une solution encore plus simple

9Dans l'onglet Partage, vous pouvez 
paramétrer certains aspects du partage,

comme la déconnexion en cas d'inactivité, 
un message d'accueil, l'enregistrement 
d'un fichier de log... Il convient d'avoir 
autorisé l'enregistrement d'un Log pour 
pouvoir utiliser par la suite ASF Monitor.

Des outils complémentaires

MINI•DOC
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Fabriquez un petit câble réseau   

Ethernet RJ-45

L
es câbles tout faits que vous trou-
vez dans le commerce ont des
tailles standard. Or, pour répon-

dre à la demande d’un ami, je n’ai be-
soin ici que d’un petit bout de câble qui
servira à relier une borne AirPort à un
routeur… Bref, quelque chose dans les
10 cm. Évidemment, ce que nous allons
apprendre ensemble dans cet article est
totalement indépendant de la longueur
du câble. À vous d’acheter le métrage
dont vous avez besoin. 

n André Sterpin

1 D’abord, il vous faut du câble , de catégorie 5,
s’il vous plaît ! Ça s’achète chez les revendeurs

informatiques ou les magasins d'électronique.
Vous en avez peut-être un bout qui traîne quelque
part, qu’il suffira de raccourcir.

1

Vous avez besoin d’un câble Ethernet d’une longueur bien particulière ? 
Il n’y a pas d’autre solution que de le fabriquer vous-même. Alors, on y va ?

2 Indispensables aussi : les connecteurs RJ-45
et des cabochons de couleur 

dont l’utilité est double : faciliter le repérage 
des différents câbles et protéger l’ergot 
qui maintient le connecteur Ethernet clipsé. 
Une partie très fragile, qui casse souvent 
si vous branchez et débranchez sans cesse 
le câble. Pensez à passer le cabochon avant
de sertir le connecteur ! Je n'en placerai pas sur
ce câble-ci : il n'est pas destiné à être 
manipulé et, étant donnée sa longueur réduite,
on voit tout de suite à quoi il est connecté. 
Il existe des connecteurs avec guides, sans guides,
blindés… Ici, j’utilise des connecteurs simples .
Vous voyez les broches métalliques 
dans lesquelles vont s'encastrer les fils du câble.

5

4

32

Réunissez le matériel qu’il vous faut

1

2

3

4

5

Le câble terminé mesure plus des 10 cm que m’avait demandé mon ami. Mais 
10 cm, c'est trop rigide pour être plié, et comme les éléments à connecter seront
l'un au-dessus de l'autre – et pas dos à dos – un minimum de jeu est nécessaire.

NB : La rédaction de Vous et Votre Mac et l'auteur de cet article déclinent toute responsabilité 
s'il arrive quelque chose à votre matériel alors que vous avez volontairement suivi notre article pratique.
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Les deux paires servant actuellement (en Base 10 et Base 100) sont celles que nous laissons droites 
ou, qu’au contraire, nous croisons.
Pour le Base 1000, je pense que c'est pareil, mais je n’ai pas eu l’occasion de le tester.

4 Personnellement, je n'emploie pas la partie de la pince 
qui sert à dénuder les câbles. Je préfère travailler 

au cutter et couper à 2 ou 3 cm du bord du câble .
Comme ça, je suis sûr que les conducteurs ne sont pas 
endommagés et je dispose d'assez de longueur pour 
détorsader aisément les paires et les mettre « à plat ».
C'est beau, détorsadé , non ?3

2

1

Pour un câble « droit », les paires doivent être 
placées de cette façon, aux deux extrémités 
du câble comme suit :

1.  blanc/orange
2.  orange
3.  blanc/vert
4.  bleu
5. blanc/bleu
6.  vert
7.  blanc/brun
8.  brun

Pour un câble « croisé », les paires doivent être 
ordonnées comme ci-contre à une extrémité, et 
comme ci-dessous à l’autre (en gras, les changements).

1.  blanc/vert 
2.  vert
3.  blanc/orange
4.  bleu
5. blanc/bleu
6.  orange
7.  blanc/brun
8.  brun

Déshabillez-moi, oui, mais avec précision !

3 Ensuite, il faut vous procurer une pince à sertir les connecteurs RJ-45. C’est un peu plus cher (comptez dans les 15 €). 
Elle est habituellement composée, au plus près de la charnière, de deux lames sensées dénuder le câble , la partie « sertisseuse » 

et une partie coupante . Pour ma part, j'emploie de préférence cette pince ci-dessus ; elle ne fait que sertir, mais elle le fait bien !98

76

1

2

3

6 7 8 9

5 C’est une étape essentielle : il s’agit de bien répartir et organiser les fils. Deux possibilités : 
câble droit ou câble croisé.
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6 Après avoir coupé droit les conducteurs, on les glisse 
comme ceci dans le connecteur. Bien au fond .

Ensuite, poussez la gaine le plus loin possible .
Sur cette image , on voit que les câbles sont bien enfoncés.4

3

21

7 En bas, à gauche, vous distinguez nettement les contacts 
qui iront s’enficher dans les conducteurs. En bas à droite, 

c’est l'ergot en plastique qui va « coincer » les conducteurs 
et leur gaine dans le connecteur.

6

5

8 Introduisez le connecteur dans la pince, délicatement mais fermement. Lorsque le connecteur est clipsé, assurez-vous que le câble et la gaine 
sont bien au fond avant de sertir. Une fois le premier connecteur serti, la manœuvre à réaliser est évidemment la même pour l'autre extrémité du câble.

Câblez les connecteurs RJ-45

1

4

2

5

6
3
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Ce mois-ci, faisons connaissance avec 
un concept important de l’environnement 
Dreamcard : l’arrière-plan des cartes 
et les groupes d’objets d’arrière-plan.

MINI•DOC
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Programmez des applications avec

Revolution DreamCard

L
a plupart des logiciels sont des « mécanos » bien plus so-
phistiqués que ce que nous avons vu dans les deux pre-
mières leçons de notre cours ! Ils présentent notamment

une interface utilisateur composée de plusieurs fenêtres, de menus,
de dialogues… Pour en faciliter le développement et en assurer la
cohérence, Dreamcard propose l’idée de « fond de carte » ou 
« d’arrière-plan » qui permet de mettre en place des objets par-
tagés. C’est ce que nous allons explorer ce mois-ci. Dans notre
prochain numéro, nous nous en servirons pour créer une inter-
face à onglets. Conservez donc cet exemple, nous en aurons be-
soin le mois prochain. n Nicolas Klingsor

1 Pour réaliser une application multi-fenêtre, il suffit de créer plusieurs piles :
une première pile, dite Mainstack (pile primaire), qui s’ouvrira lorsque 

l’application sera lancée, contient les autres piles dénommées, elles, Substacks
(piles secondaires). Vous pouvez vous servir des Substacks pour ouvrir 
d’autres fenêtres, créer des boîtes de dialogue et d’alerte, des palettes, 
des menus personnalisés et tout autre sorte de fenêtre dont votre application
a besoin. Avouons-le, tous ces objets que je viens de citer ne sont rien 
d’autres que des fenêtres plus ou moins particulières. La Mainstack 
et ses Substacks seront sauvegardées dans un seul et unique fichier. 

2 Pour débuter, vous allez 
concevoir une pile très simple

composée de deux cartes. 
Comme nous l’avons vu ensemble
dans les deux leçons précédentes,
faites File > New Mainstack.
Dans le menu Object, demandez
Stack Inspector pour afficher 
la palette des propriétés de 
la pile. Donnez un nom à la pile : 
« Mon Application ».

3 Cette pile comprend déjà une carte par défaut, celle qui est affichée. 
Juste pour la distinguer par la suite, allez par exemple dans le menu 

Development > Image Library. Dans la réserve d’icônes qui vous est 
proposée, choisissez-en une, puis cliquez sur le bouton Place Image.
Revenez sur la carte et déplacez l’icône dans un coin où elle ne gênera pas. 
Créez maintenant une seconde carte, via le menu Object > New Card.
La fenêtre correspondant à la nouvelle carte est vide. Pour l’instant, 
pour aller d’une carte à l’autre, vous devez en passer par le menu View
(et ses options First, Prev, Next, Last, Recent). Ne serait-il pas plus simple
d’écrire un script, judicieusement placé dans un bouton afin de passer 
d’une carte à l’autre d’un simple clic ? C’est ce que vous allez faire. 
Nous avons vu précédemment comment créer un bouton.
Revenez à la première carte (celle sur laquelle vous avez placé une icône) 
et créez un bouton (objet Push Button dans la palette Tools). Utilisez 
l’Object Inspector (menu Object) pour le nommer « Suivante »
et ajoutez-lui le petit script : go to the next card
Cliquez sur le bouton Apply et fermez l’éditeur de script.
Maintenant, si vous passez en Run Mode (mode Exécution, matérialisé 
par le curseur simple), vous pouvez aisément vous promener de la première 
à la seconde carte en cliquant simplement sur le bouton Suivant.

2

1

1

2
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5 Allez sur la carte qui contient le bouton Précédent, sélectionnez
ce dernier et coupez-le. Revenez sur la première carte 

(par le menu View > Prev puisqu’il n’y a plus de bouton à notre disposition)
et collez le bouton. 
La première carte dispose bien désormais des deux objets boutons 
Suivant et Précédent.  
Sélectionnez-les tous les deux et groupez-les en cliquant 
sur le bouton Group de la barre d‘outils de Dreamcard. Nommez 
le nouveau groupe « Navigation » dans l’Object Inspector.
Pour que ce groupe apparaisse sur toutes les cartes actuelles 
et futures que vous ajouterez à la pile, vous le définissez comme 
background. Pour ce faire, cochez dans la foulée la case 
Behave like a background (se comporter comme un groupe 
d’arrière-plan) dans l’Object Inspector.5

4

4 Bien évidemment, il faut 
procéder de même 

sur la seconde carte sur laquelle 
vous venez d’arriver. 
Créez-y un bouton (Push 
button) pour revenir à la carte 
précédente d’un seul clic. 
Et tant que vous y êtes, prévoyez 
un bon petit effet visuel ! 
Dans le bouton de retour Précédent,
tapez le script suivant :
visual effect dissolve
go to the previous card
Mais ce n’est toujours pas très 
ergonomique ! Cela serait mieux 
encore que les boutons Suivant 
et Précédent soient tous 
les deux sur les deux cartes 

– et celles que l’utilisateur 
de votre application créera 
forcément pour pouvoir entrer 
de nouvelles données.
Dreamcard utilise un mécanisme 
qui permet à plusieurs cartes 
de partager un ou plusieurs 
groupes d’objets. Ainsi, les mêmes
objets peuvent-ils apparaître 
sur plus d’une carte. C‘est 
un gain de temps précieux 
lors du développement 
et une garantie de cohérence 
de l’interface utilisateur. 
Dans Dreamcard, le groupe d’objets
partagé entre plusieurs cartes 
s’appelle aussi background 
(arrière-plan). Comment faire ?

3

6Désormais, toutes les nouvelles cartes qui seront créées 
dans la pile comporteront automatiquement le groupes d’objets 

qui a été défini comme « arrière-plan ». 
Créez quelques nouvelles cartes et passez de l’une à l’autre. 
Elles comportent toutes le groupe Navigation (composé des deux boutons
Suivant et Précédent) . Mais lorsque vous tombez sur la seconde, 
la carte d’origine (celle qui avait reçu le bouton Précédent avant que vous ne
le coupiez), surprise : nulle trace du groupe Navigation . Pourquoi donc ?
La raison en est que le groupe d’arrière-plan n’est placé automatiquement
que sur les nouvelles cartes créées après sa mise en place. Or la seconde
carte de la pile, vous l’aviez créée avant de définir le groupe Navigation. 
Vous aurez donc à placer manuellement le groupe Navigation sur 

cette dernière carte : il suffit de faire Object > Place Group et de choisir 
Navigation dans la liste proposée .
Notez aussi qu’il est tout à fait possible de retirer un groupe d’arrière-plan
de certaines cartes si sa présence n’est pas justifiée. Sélectionnez 
le groupe et faites Object > Remove Group. Le groupe d’objets d’arrière-plan
n’est plus présent sur cette carte, mais demeure dans l’arrière-plan 
des suivantes. Vous pouvez ainsi facilement créer un groupe d’objets 
d’arrière-plan qui sera affiché sur toutes les cartes et un autre groupe 
que vous ne placerez que sur certaines cartes.

8

7

6

3

6

7
8

4

5
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À l’heure actuelle, un enregistreur de DVD de salon est le moyen le plus rapide, le plus facile 
et peut-être même le moins cher pour capturer une source analogique. Et votre Mac est le meilleur
outil pour en tirer un superbe DVD personnalisé !

Grâce à votre Mac, tirez tout le parti de votre

graveur DVD de salon
(ce qui a fait les beaux jours de la VHS).
Aujourd’hui, le DVD remplace cette bonne
vieille cassette. De plus, à l’aide d’un Mac,
aucun problème majeur pour récupérer ce
qui se trouve sur un DVD déjà encodé en
MPeg-2. Vous pourrez même l’éditer, le re-
monter, le chapitrer et en refaire un DVD…
Bref, de quoi faire depuis une capture brute
de plusieurs épisodes d’une série un enregis-
trement propre qui démarre sur la première

J’AI PRIS POUR HABITUDE D’ENREGISTRER
sur Canal+ (en clair) La semaine des Guignols
qui passe le dimanche vers 13h45. Ça dure 
environ 26 min (ce qu’on appelle un demi-format
en jargon télé), page de pubs incluse.
J’enregistre l’émission sur un DVD grâce 
à mon enregistreur de salon Seeltech (lire 
À savoir). Immanquablement, j’ai pris un peu 
de marge au début et à la fin et j’ai enregistré 
la coupure pub. Le DVD+RW qui sort de l’enregis-
treur ressemble à n’importe quel DVD gravé. 
La structure qui le compose est identique 
à celle que nous connaissons sur les DVD 
que nous produisons avec iDVD, par exemple.
Nous allons dans un premier temps 
récupérer les données du DVD sur le disque 
dur du Mac. Pour ce faire, on a tout intérêt 
à effectuer une « extraction » plutôt 
qu’une simple copie, histoire d’assurer le bon
transfert de toutes les données. Par exemple, 
si le DVD n’a pas été finalisé, une simple 
copie pourra très bien ne pas contenir tous 
les fichiers. Pour cette opération, j’utilise 
le logiciel freeware MacTheRipper .
La vitesse d’extraction dépend des capacités de
lecture du lecteur/graveur qui équipe votre Mac.
Les données se présentent alors comme 
sur cette copie d’écran .
Le fichier VIDEO_TS.VOB correspond 
au menu du DVD, les fichiers VTS_01_x.VOB, 
à ceux de l’enregistrement.

2

1

image, s’arrête sur la dernière, sans coupu-
res publicitaires et autres choses inutiles.
Mieux, vous créez un montage sur un mê-
me disque de plusieurs enregistrements et
obtenez ainsi un DVD parfaitement adapté
à vos habitudes de « lecture ». Mais plus
qu’un long discours, une démonstration en
images s’impose. On se place en situation
réelle et on va démonter toutes les étapes.

n Alynpier

R
éaliser des DVD personnels à partir
d’enregistrements effectués avec un
graveur de DVD de salon, c’est ce

que j’expérimente depuis quelque temps avec
d’excellents résultats. Documentaires divers,
séries, films aussi bien sûr : quand on sait la
regarder et choisir, il y a des tas de choses
intéressantes à la télévision ! Rarement 
cependant aux heures où vous pouvez la re-
garder, d’où l’intérêt des enregistrements

Extraction des données

ATELIER

1

2

Un petit mot sur le matériel 
employé. J’ai acheté en juin 2004
un enregistreur Seeltech DW9915
dans une grande surface. Avec 
la remise accordée à l’époque, 
je l’ai payé moins de 190 €.
C’est un modèle qualifié « entrée 
de gamme » puisqu’il ne dispose
pas de disque dur intégré. 
Qu’importe ! Mon magnétoscope
VHS n’en avait pas non plus 
et je n’ai donc pas, pour 
l’instant, changé mes habitudes.
L’appareil est branché sur ma TV
par un simple câble péritel. 
En deux mots, je programme 
et j’enregistre en mode Standard,
c’est-à-dire 130 min. Ça me suffit
amplement, surtout pour 
ce que je fais. Évidemment, j’utilise
des DVD+RW réinscriptibles 
(ce sont les mêmes qui 
me servent depuis le début !). 
Une fois les infos « traitées », 
je les réutilise sans problème.

À SAVOIR !
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NOUS ALLONS À PRÉSENT OUVRIR les fichiers .VOB, de manière à pouvoir en
faire une édition – et en particulier couper les parties inutiles. Nous travaillons
ici sur des fichiers déjà encodés en MPeg-2, ce qui suppose deux choses :

A Pour pouvoir lire le fichier – c’est QuickTime qui s’en charge –, 
il faudra impérativement disposer du module de lecture MPeg-2 de QuickTime ;
on le trouve sur AppleStore. Ça se télécharge sans délais, mais il vous faudra
tout de même débourser quelque 30 €.

Procédez de même pour la fin. 
Positionnez-vous, placez la marque
In (touche I)… La partie entre cette
marque et la fin de la capture est
alors sélectionnée et vous la coupez
avec la combinaison Pomme + X.
C’est le même principe pour 
supprimer toute sélection 
à l’intérieur de la capture, par exem-
ple les pubs. Marquez le début In 
et la fin Out et supprimez la partie
sélectionnée. Ça ne prend que 

quelques minutes. Petite astuce :
vous profiterez, grâce au curseur 
et à l’indication de temps 
qui figure sous la marque Current,
pour noter les positions 
des différents chapitres que vous
voudrez faire figurer sur le DVD. 
Dans le cas des Guignols, le début
correspond au lundi, je note 
donc précisément la position 
des écrans qui correspondent 
aux autres jours de la semaine.

B L’édition d’un fichier MPeg-2
ne se fait pas à l’image près, 
mais par GOP (Group Of Pictures). 
Ces GOP sont constitués, suivant 
les cas, de 9 à 18 images. L’édition 
se fera donc grosso modo à la demi-
seconde près… ce qui ne m’a jamais
posé de problème !
Le meilleur outil est alors le freeware
MPeg Streamclip. Le menu Open Files
permet de choisir l’un de ces fichiers
.VOB et vous propose deux choix :
l’ouvrir seul, ou ouvrir tous ceux 
qui composent la capture complète.
Bien évidemment, on choisit 
de cliquer sur le bouton Open All .
S’ouvre alors une fenêtre 
dans laquelle on trouve la première
image du film et, en bas, certaines

indications intéressantes .
Les trois premières nous renseignent
sur l’état de ces flux ; c’est juste 
pour info, puisque nous ne pourrons
pas les modifier. En revanche, 
Current donne la position du curseur,
Start et End celles du début 
et de la fin du fichier, In et Out 
les positions programmées du même
curseur pour faire une édition.
Commencez par élaguer le début 
et la fin de la capture. Placez 
le curseur précisément au début 
de ce que vous voulez garder, 
et vous le marquez Out (touche O).
Toute la partie comprise entre 
le début du fichier et la marque Out
se grise ; il suffit alors de l’effacer
(Pomme + X) .4
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C L’édition terminée, passez à l’exportation. MPeg Streamclip 
propose plusieurs fonctions, dont la possibilité d’exporter le flux video 
en MPeg-2 et le flux audio en AIFF. En effet, le flux audio original est 
en MP3 et nous donne du fil à retordre. De toute façon, nous allons 
le réencoder en AC3, pour des raisons de compatibilité avec les amplis audio 
(les platines, elles, décodent les deux sans problème). Choisissez donc 
la fonction Demux to headed M2V and AIFF… convenant parfaitement 
à la suite des opérations (l’exportation en AC3 n’est possible que si le fichier
de base est déjà codé en AC3, ce qui n’est pas le cas ici).
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Édition et exportation des flux 
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NOUS ALLONS CHARGER les deux 
fichiers extraits (.m2v et .aiff) 
dans le logiciel MovieGate Lite. 
MovieGate est un freeware 
d’encodage/authoring DVD très 
complet, développé par Mac&Vidéo
(www.macetvideo.com). La version
Lite est spécialement conçue 
pour créer un DVD-vidéo chapitré
utilisant un flux vidéo déjà encodé,
mais prenant en charge l’encodage
en AC3 du flux audio. Simplicité :
seuls quelques clics suffisent. 
Rapidité : pas d’encodage vidéo
long. Le résultat est à la hauteur !

A Réglez tout d’abord les préféren-
ces . Choisissez le bitrate 
audio (entre 128 et 224, mais je suis
resté sur 192). Optez pour Garder 
les fichiers élémentaires (cela évite 
de les effacer, au cas où on devrait
recommencer). Si vous avez 
un petit disque dur, cochez Vider 
le dossier de destination avant 
encodage (je ne le fais pas parce
que j’ai suffisamment de place 
sur mon disque dur). Enfin, cochez
Lancer le lecteur DVD à la fin 
du travail. La fenêtre principale 
de l’application se résume quant 
à elle à peu de choses .

Vous indiquez les différentes 
sources, la destination, ainsi que 
le nom à donner au DVD.

B L’option Chapitrage permet
d’insérer précisément les marqueurs
placés précédemment . Il n’y a
qu’à les reporter un par un ou bien
utilisez la fonction très pratique 
de positionnement de marqueurs 
à intervalles de temps réguliers
pour faciliter le déplacement rapide 
dans le clip sans en avoir de repères
précis. Il suffit alors d’indiquer 
un intervalle de temps (j’utilise
00:03:45 de manière habituelle) et
faire Ajouter marqueur chaque… 
Fermez cette fenêtre et démarrez 
le processus.
MovieGate Lite va alors successive-
ment convertir l’AIFF en Wav, puis 
ce dernier en AC3, multiplexer 
les fichiers vidéo et audio (pour 
obtenir un fichier MPeg), en faire
l’authoring et créer le DVD final .
Dès que celui-ci est terminé, 
l’utilitaire Lecteur DVD fourni avec
Mac OS X prend le relais et affiche 
le DVD fini. Avant d’en entreprendre

la finition, vérifiez rapidement le bon
fonctionnement, zappez d’un 
marqueur de chapitre à un autre… 
Sur notre disque dur, nous disposons
maintenant de différents éléments

. Un dossier VIDEO_TS « plein »
(on voit bien qu’il n’y a pas de menu,
donc le clip démarre dès l’insertion

du disque) et un dossier AUDIO_TS
vide, réminiscence des premiers 
formats DVD, totalement inutile, 
mais dont la présence est encore 
vérifiée par certaines platines. 
À ne pas oublier donc sur tous 
vos DVD pour leur assurer 
une compatibilité maximale.
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Remontage des flux et authoring DVD
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Finition et gravure
UNE FOIS LE DVD TERMINÉ, RESTE À LE GRAVER ou à le conserver tel quel 
pour l’instant (nous verrons plus loin pourquoi). Deux solutions s’offrent 
à vous selon que vous disposez ou non de Toast 6.0.7 (dernière version).

A Avec Toast 6.0.7, il suffit de choisir
l’onglet Vidéo, puis de cocher 
le choix DVD depuis VIDEO_TS dans
Avancé. Glissez ensuite 
le dossier que vous venez de créer

sur la fenêtre Finition et gravure
. Notez que, si comme ci-contre, 

un fichier invisible .DS_Store 
était créé, il faudrait l’effacer 
avant de lancer la gravure.
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MovieGate est un outil puissant
qui, même utilisé de manière 
simple, permet de produire en 
un clic un mini-DVD chapitré 16/9
en noir et blanc, à partir d’un
montage iMovie, par exemple ! 
Et il offre encore bien d’autres 
choses... C’est une boîte à outils
bien plus complète qu’iDVD.
Les réglages, très nombreux,
sont regroupés en deux 
fenêtres. Les préférences 
permettent de régler les 
paramètres audio et vidéo, fixer
les tailles maximales des DVD 
et mini-DVD, demander une 
recompression éventuelle, gérer
les fichiers élémentaires, la
création du DVD, de l’image 
disque et le lancement de 
Lecteur DVD à la fin.
La fenêtre de travail principale
permet la sélection du format

, DVD ou mini-DVD, et de 
l’aspect du DVD .

Vous sélectionnez une
source vidéo . S’il
trouve une source
audio, MovieGate la
prend en compte auto-
matiquement ; sinon, il
faut le faire à la main

. Ne pas oublier d’ajouter la
piste (qui apparaît alors dans un 
tiroir), pour qu’elle soit prise en
compte et qu’il soit possible d’en
entrer une autre. 
Il est possible de mélanger des 
pistes dont les caractéristiques
d’encodage sont différentes 
(bitrate, quantisation).
Vous obtenez une première 
estimation de taille avec les 
valeurs proposées par défaut

. Ensuite, libre à vous de 
régler plus finement les valeurs
de Bit Rate et de Quantiser

tout en suivant l’évolution
de la taille estimée du fichier
final, de faire du « vrai » noir et

blanc , de chapitrer le fichier
(vous posez des marqueurs en

déplaçant le curseur et en faisant
Ajouter, ou en les important depuis
iMovie, s’ils y ont été définis ).
Reste à déterminer le dossier de
destination, préciser
le nom à donner au
disque… et à cliquer
sur Démarrer .
Une fois le disque 
terminé, le bouton
Graver sera actif
et proposera… la 
gravure d’un disque !
Ceux d’entre vous qui
ont déjà acquis de
bonnes connaissances

en encodage MPeg-2 pourront
éventuellement régler d’autres
paramètres dans la seconde fe-
nêtre à laquelle ils accéderont
par le bouton Expert) .13
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2B À défaut de Toast 6.0.7, utilisez la fonction de gravure de Mac OS X. 
Créez préalablement une image disque DVD à l’aide du freeware DVD Imager .
Glissez le dossier VIDEO_TS (pas le dossier du DVD !) sur l’icône (empilage de disques 
optiques) au milieu de cette fenêtre. Cochez Prompt for new destination (pour choisir 
le dossier d’accueil) et Create Image qui vous demande le nom à lui donner 
Attention là encore (et ceci est valable pour tous los DVD si vous voulez vous assurer 
une compatibilité maximale) : n’utilisez dans le nom que des lettres capitales et des tirets
bas « _ » au lieu d’espaces.
Il ne reste plus qu’à lancer Utilitaire 
de disque, de cliquer sur le bouton Graver,
d’indiquer où se trouve l’image disque 
produite (SEMAINE_GG.img) et suivre 
les instructions de gravure.

3

2

C Évidemment, dans le cas d’un fichier de 915 Mo, c’est un peu bête de griller 
un DVD. D’autant plus que l’objectif premier était de rassembler sur un même DVD 
plusieurs émissions de la Semaine des Guignols consécutives. Alors ?
Dans un mois, vous maîtriserez bien la technique que je vous ai exposée ici 
et vous serez prêt à passer à l’étape suivante. C’est donc ce que nous verrons 
dans Vous et Votre Mac n°4 (chez votre marchand de journaux fin avril) 
avec, en prime, la possibilité d’utiliser iDVD pour créer une présentation sympa, 
avec une introdution, de la musique, des boutons et tout le toutim !

3

Le logiciel MovieGate Lite 1.0.1, que j’utilise dans ce
pratique, est la version « allégée » de MovieGate 1.1.4,
développée par l’équipe de Mac & Vidéo pour répondre
aux besoins les plus simples d’un encodage/authoring
DVD de base.

ZOOM SUR MOVIEGATE
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iVisit sous
Windows XP

iVisit sous 
Mac OS X 10.3.6
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Sans atteindre la qualité d’un iChat – qui ne fonctionne cependant que sur Mac OS X –, iVisit offre
aujourd’hui la meilleure solution de vidéoconférence mixte Mac et PC. Son utilisation de base 
est simple, mais la mise en œuvre de ses fonctions avancées mérite quelques explications détaillées.

Quand des utilisateurs Mac et PC

dialoguent en vidéo !

n’est pas tip-top, il a le mérite de très bien
fonctionner, notamment dans le cadre
d’échanges mixtes Mac-PC. 
iVisit est disponible en deux versions,
l’une peut être utilisée librement (avec des
limites importantes en terme d’échange de
fichiers), l’autre requiert le paiement d’un
abonnement annuel de 39,95 $ (30 € env.).
Si le logiciel est actuellement en anglais, il
existe toutefois un forum iVisit en français
sur lequel vous trouverez de nombreux
renseignements utiles. Ce forum est or-
chestré par une société qui va représenter
iVisit en France. Elle est en cours de loca-

lisation et d’adaptation des logiciels, mais
également des serveurs et des services liés
à iVisit. Une version française PC est sor-
tie début 2005. Il faudra patienter encore
un peu pour Mac OS X. Cet article pré-
sente essentiellement les fonctions de vidéo-
dialogue de la version Lite. Si vous le sou-
haitez, une fois ces fonctions maîtrisées, vous
pourrez découvrir par vous-même qu’iVi-
sit permet aussi de partager des fichiers ou
votre Bureau à distance et de créer (avec la
version Plus), un « salon » où vous accueil-
lerez de nombreux visiteurs.

n Bernard Le Du

V
ous voulez « voir » d’autres utilisa-
teurs ? S’ils sont tous sur Mac, la
meilleure solution est sans doute

iChat. Ce logiciel est livré avec Mac OS X et
intègre des codecs de grande qualité tant
pour le son que pour l’image. Pas la peine
d’aller chercher votre bonheur ailleurs. La
version qui sera fournie avec Tiger, la pro-
chaine version de Mac OS X, permettra
même des conférences à plusieurs.
Mais si des membres de votre famille, des
partenaires d’affaires, des collègues de tra-
vail, …, sont eux sur PC, alors là c’est moins
évident car les solutions mixtes sont rares.
La plus simple – et je l’évoquerai un peu
plus en détail dans un encadré – est d’uti-
liser iChat sur Mac et de demander à vos
correspondants sur PC d’installer AIM 5.9.
J’ai testé cette solution : elle marche sans
problème, mais reste toutefois limitée en
fonctionnalités et la vidéo est moyenne –
sans compter que les utilisateurs PC n’ont
droit qu’à une minuscule fenêtre de visua-
lisation. Autre possibilité un peu acrobati-
que : bricoler quelque chose avec, côté
vidéo, OhPhoneX sur le Mac et NetMee-
ting sur PC, couplé pour le son à une liai-
son Skype. Ça peut se faire. Mais NetMee-
ting est tombé en désuétude dans le monde
des PC. Même chose pour le protocole
CU-Seeme qui oblige à passer par des ser-
veurs dédiés dits « réflecteurs ». Ces types
de réseaux ne sont plus guère utilisés que
par des personnes en quête de rencontres
virtuelles « chaudes », vous voyez ce que
je veux dire (si ça vous chante, téléchargez
alors vChat ou SquidCam). 
J’ai plutôt choisi de vous faire découvrir le
système iVisit, développé à la fin des an-
nées 90 par Jim Dorcey, le même consul-
tant de l’Université de Cornell aux Etats-
Unis qui inventa CU-Seeme en 1991. IVisit
est différent de ce dernier. En particulier, il
s’affranchit du réseau des réflecteurs de
CU-Seeme. iVisit est disponible sur systè-
mes Mac OS 9 et Mac OS X (au moins la
version 10.2), et si son interface utilisateur

ATELIER
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ACTUELLEMENT, LE LOGICIEL POUR MAC OS N’EST DISPONIBLE QU’EN ANGLAIS. Il vous faut le 
télécharger sur le site d’iVisit.

A Cliquez, en bas de l’écran d’accueil du site,
sur l’un des boutons iVisit Lite ou iVisit
Plus , selon votre choix (iVisit Plus étant
la version payante sur abonnement annuel).
Patientez trois secondes, le temps 
que le service détecte que vous êtes 
sur Mac ou PC et vous dirige vers 
la page de téléchargement adéquate.
Téléchargez la version correspondant 
à votre configuration système.
Une fois le logiciel téléchargé et 
décompressé, double-cliquez sur son icône
pour vous connecter au site d’iVisit. 
Une connexion Internet est requise. Notez
qu’iVisit peut se contenter d’une liaison
modem. Disposant d’une Freebox V4, 
je n’ai toutefois pas testé cette solution.

B Il va falloir vous inscrire. C’est gratuit 
pour la version Lite. S’enregistrer consiste 
à fournir un certain nombre d’informations,
en particulier une adresse e-mail 
fonctionnelle qui servira à recevoir 
le code d’activation et à retrouver 
vos autres données si vous les oubliez.
S’en suit une transaction avec le serveur
d’iVisit qui crée le compte et vous envoie 
un message contenant votre code d’autorisa-
tion nécessaire à l’activation du compte.

Vous ouvrez à nouveau iVisit et activez 
votre compte. Dès lors, le programme iVisit
est utilisable.

C Votre adresse sur iVisit sera du type :
nom.XXXX@ivisit.net. 
Le nom est celui que vous avez choisi et 
qui a été accepté. C’est lui qui sera exposé
aux autres utilisateurs du système.
L’extension.XXXX (exemple : vvmac.9988) 
est composée de quatre chiffres et n’est pas
publique. C’est le code d’appel. Suit l’indica-
tion du domaine, par exemple : @ivisit.net.
Personne ne peut vous contacter en direct
via iVisit s’il ne connaît pas votre adresse
complète : nom_utilisateur.XXXX@domain.

D Pour vous connecter (fenêtre Logon), 
il suffit d’entrer votre nom et votre mot 
de passe (cochez éventuellement 
les cases Remenber ) et de cliquer 
sur le bouton Logon . Vous serez alors
connecté au serveur qui vérifiera si vous
avez des messages non lus et si vous avez
manqué des appels. Cliquez sur OKay pour 
utiliser iVisit. Pensez à cliquer sur le menu
File > Logoff lorsque vous mettez fin 
à votre session iVisit, surtout si vous partagez
votre Mac avec d’autres utilisateurs.
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CONNECTÉ, vous disposez d’une fenêtre audio vidéo (AV) locale qui renvoie l’image capturée par
votre caméra et propose différentes zones de réglage. Si elle n’est pas visible, faites
Tools > Local Audio Video. Elle est divisée en trois grandes zones : Video, Audio et Recording.
Vous ouvrez/refermez chaque zone à l’aide de la petite flèche bleu ciel, à gauche . 
Chaque zone est munie d’une petite flèche noire à droite qui déroule un menu d’options.

A La zone Video
Les options Video ne nécessitent pas de commentaires particuliers. Notez seulement que High
Resolution n’est disponible que si vous êtes un utilisateur Plus. Le réglage de taille de l’image
est une option de visualisation purement locale : ce n’est pas la taille de l’image qui est 
envoyée. Par ailleurs, vous pouvez demander Pause : le flux vidéo provenant de la caméra
est stoppé et vous pouvez coller une image dans la fenêtre ; c’est elle qui sera vue par 
votre interlocuteur. Cela peut être un bon moyen de présenter quelques secondes un objet ou 
un document. La conversation audio ou le chat texte restent opérationnels pendant ce temps.

B La zone Audio
Elle comprend un bouton essentiel : Talk . Il y a deux manières d’utiliser iVisit 
au niveau audio. Soit le son n’est transmis que lorsque vous appuyez sur ce bouton, 
soit vous sélectionnez, dans le menu des options Audio, l’article Hands Free Mode .

C La zone Recording
J’en reparlerai plus loin.
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Installation du logiciel et inscription à iVisit
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Comprenez les fonctions de votre fenêtre AV
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BIEN ENTENDU, VOUS NE POUVEZ ÉTABLIR UNE CONNEXION qu’avec des gens qui sont eux-mêmes équipés d’iVisit Lite ou Plus et ont une adresse iVisit. 
Il n’est pas nécessaire qu’ils soient en ligne : vous pouvez leur laisser des messages et ils seront prévenus lorsqu’ils ouvriront une session des appels en absence.

A Créez votre Carnet d’adresses
La première chose que vous avez à effec-
tuer est de commencer à remplir votre 
Carnet d’adresses iVisit qui, bien qu’il
s’appelle AddressBook, n’est en rien lié
avec le Carnet d’adresses de Mac OS X).
Pour communiquer avec un autre utilisateur
en direct, vous devez connaître son adresse
complète (nom_utilisateur.XXXW@domain).
Dans la fenêtre AddressBook (si elle n’est
pas affichée, ouvrez-la via le menu Tools >
AdressBook), cliquez d’abord sur le bouton
People (c’est la section dans laquelle
sont listés vos contacts directs). La liste 
de vos contacts est présentée . Au départ,
il n’y a que vous-même et une corbeille.
Pour ajouter un contact au Carnet, déclinez
son adresse dans le champ Adresse puis cli-
quez sur la croix bleue . Pour organiser
vos contacts, créez des dossiers : dans la
zone de saisie, tapez : « /nom_du_dossier »

(en minuscule) et appuyez sur la touche 
Entrée. Le dossier s’ajoute à la liste. 
Vous vous déplacez dans le carnet avec 
la flèche grise en haut à gauche. Pour
supprimer un contact, glissez-le dans la cor-
beille (il ne sera pas détruit tant que vous
n’aurez pas demandé File > Empty trash).
Vous pouvez appeler en direct quelqu’un
sans l’enregistrer préalablement dans 
le Carnet d’adresses : dans la fenêtre
AdressBook, cliquez en haut sur le bouton
Messages et saisissez son adresse iVisit
complète dans le champ Adresse.
Si votre carnet est fourni, vous retrouverez
facilement une adresse en commençant 
à la taper. Quand le logiciel vous présente 
la bonne adresse, faites juste Entrée.
Si le nom d’un contact est surligné en jaune,
cela signifie qu’il vous a laissé un ou 
plusieurs messages. Cliquez dessus pour lire
les messages dans la fenêtre Chat.
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B Passez un appel ou envoyez un message
Pour téléphoner à un contact, cliquez une fois sur son nom dans le Carnet d’adresses. 
Le logiciel vous propose alors Messages ou Connect. Choisissez. Si vous aviez double-cliqué,
la connexion AV aurait été automatique.

C Recevez des appels et des messages
Pour gérer efficacement la réception d’appels, réglez 
les paramètres en bas de la fenêtre du Carnet d’adresses. Chaque
option peut prendre deux, trois ou quatre états (vert, jaune, 
rouge ou blanc). La première option concerne les appels :
vous pouvez tous les accepter (Accept all incoming calls) ou tous 
les ignorer (Ignore incoming calls). Vous pouvez aussi choisir 
d’afficher l’identité de l’appelant (Caller ID on incoming calls) ou
envoyer un signal « occupé » (Send busy on incoming calls).
La seconde option concerne les messages : vous pouvez 
accepter de les voir dans la fenêtre de chat texte 
(Show incoming messages), les bloquer (Block incoming 
messages) ou les suspendre (Hold incoming messages).
La troisième option détermine votre propre statut : les autres
utilisateurs vous voient-ils en ligne (Show online) ou non 
(Do not show online) ? À vous de choisir…
Ces règles que vous fixez seront appliquées sauf à l’égard 
de personnes que vous avez appelées ou qui vous ont appelé 
il y a moins d’une demi-heure.
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La solution iChat/AIM
Pour ces essais, nous avons utilisé un Mac sous Mac OS X 10.3.6 équipé à la fois 
d’iChat et d‘une caméra iSweet FireWire, ainsi que d’un PC sous Windows XP Pro avec
une caméra FireWire UniBrain. 
Sur le PC, nous avons d’abord installé la version française 5.5 d’AIM. Malheureusement,
la caméra FireWire du PC n’a pas été reconnue par le logiciel. Bizarrement, 
elle était pourtant parfaitement vue et pouvait être calibrée par l’Assistant Vidéo 
d’AIM ! Nous avons ensuite essayé avec une caméra USB de Logitech, sans plus 
de succès. Là encore, elle était reconnue par l’Assistant, mais pas gérée ensuite.  
Après téléchargement et installation de la version 5.9 américaine d’AIM 
(non disponible en français), nous n’avons plus eu aucun problème. Nous avons donc pu
vidéodialoguer de Mac à PC.
Globalement, le confort de l’utilisateur Mac est infiniment supérieur à celui 
de l’utilisateur PC. AIM Windows n’affiche la vidéo reçue (fluide tout de même…) 
que dans une minuscule zone.
En envoi, il est patent que 
les codecs, tant audio que
vidéo utilisés par AIM, sont
sensiblement inférieurs à ceux
sur lesquels s’appuie iChat.
Pour autant, la solution ainsi
configurée est parfaitement
exploitable et fonctionne 
sans problème.

Vidéotéléphonez avec iVisit
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D La fenêtre AV de votre interlocuteur
Lorsque vous êtes en conversation audio-vidéo avec 
un interlocuteur, vous pouvez le voir dans sa propre fenêtre AV 
et interagir avec certains paramètres de la connexion. Il y a 
notamment deux séries d’icônes. La première vous permet 
d’autoriser ou prévenir certaines actions de votre interlocuteur.
Le second groupe vous indique le statut de certains réglages que
votre interlocuteur a effectués de son côté (et sur lesquels vous
ne pouvez rien sauf à lui demander de faire des modifications).

Première série d’icônes 
L’icône Browser reception en forme de mini-fenêtre sert à couper
la fonction de partage de fichiers, d’images et d’URL sur laquelle
je reviendrai plus loin. En cliquant dessus, vous stoppez 
les envois vers votre Mac. L’icône Pause permet interrompre 
le flux vidéo entrant ; l’image de votre interlocuteur va se figer. 
Si vous voulez bloquer toute conversation audio ou écrite avec 
un interlocuteur, cliquez sur l’icône « C ». Vous pouvez bloquer 
la réception audio d’un de vos interlocuteurs en cliquant sur l’icône
de son haut-parleur. L’icône « P » interdit à un de vos interlocuteurs
de s’isoler avec vous dans une connexion privée.

Seconde série d’icônes 
L’icône Browser reception est barrée d’un trait rouge ?
Votre interlocuteur refuse de recevoir des fichiers et autres 
éléments envoyés par vous. L’icône de la caméra est barrée 
d’un trait rouge ? Votre interlocuteur n’a pas ouvert 
votre fenêtre AV sur son écran et il ne vous voit donc pas, mais
peut vous entendre. L’icône du crayon est barré d’un trait rouge ?
Votre interlocuteur n’a pas ouvert sa fenêtre de chat texte. 

10

9

8

L’icône du microphone est elle aussi barrée d’un trait rouge ? Votre interlocuteur 
ne reçoit pas votre flux audio. Le bouton Private ne sert que lorsque vous êtes 
en conférence à plusieurs afin d’isoler temporairement de la conversation générale 
un dialogue audio ou texte avec un de vos interlocuteurs.
Cette fenêtre AV comporte aussi un Menu local auquel vous accédez avec 
la petit flèche noire, en haut à droite. Les options parlent d’elles-mêmes (certaines 
ne sont disponibles que si vous êtes un abonné iVisit Plus et avez créé un « salon » : 
elles vous permettent en effet de gérer vos visiteurs (en particulier leur accès).

11

LA ZONE RECORDING de votre fenêtre AV locale possède des contrôles
et un menu local pour enregistrer sur votre Mac soit votre propre
connexion (vous vous enregistrez), soit toutes les connexions 
courantes (vous et les autres, en audio-vidéo et chat texte). 
Vous ne capturez l’audio-vidéo de vos interlocuteurs que s’ils l’ont
autorisé (ce que vous voyez dans leurs propres fenêtres AV). Cette
autorisation est donnée en cochant la case Others may record me .
Toutefois, vous serez alerté d’une tentative d’enregistrement et vous
conserverez la possibilité de cliquer sur Allow (permettre) ou Deny
(refuser). Mais si la case Others may record me n’est pas cochée,
tout enregistrement par un tiers est impossible. Les rapports à l’image sont compliqués 
dans nos sociétés et l’enregistrement est toujours une question très délicate.

A Pour enregistrer, c’est très simple
Vous pouvez choisir entre vous enregistrer vous-même (Record self) ou l’ensemble 
des conversations autorisées (Record connections) . Cliquez une fois sur le petit bouton
marqué d’un rond rouge pour démarrer l’enregistrement. Cliquez de nouveau 
sur ce bouton pour arrêter l’enregistrement. Vous pouvez aussi mettre en Pause .
La fenêtre vous indique le temps écoulé ainsi que le poids du fichier. Lorsque vous arrêtez
l’enregistrement vidéo, la fenêtre de sauvegarde sur disque Save as s’ouvre. Enregistrez 
le fichier où vous le voulez. Vous pouvez aussi accéder à certains réglages .

B Relire un fichier audio-vidéo en local
Faites File > Play iVisit recording . Vous pouvez projeter un fichier audio-vidéo 
à votre(vos) interlocuteurs(s) en choisissant l’article File > Play file to network .8

7
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Enregistrez et visionnez vos conversations
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Une compil’ réussie est un art difficile. Aussi, dès que vous en aurez une bonne sous la main, 
fabriquez-lui une belle pochette ! Voici un aperçu des logiciels qui vous aideront à la concevoir.

Taillez des jaquettes sur mesure pour

vos compilations

Créez la jaquette
avec iTunes

de soirée : c’est alors iTunes qui se charge
pour vous de faire le choix. Moins automa-
tique, mais plus personnel : créez une liste
de lecture et glissez-y un à un vos morceaux
préférés. Ensuite, vous gravez votre compi-
lation sous la forme d’un CD-audio ou d’un

LES FICHIERS SONT CONVERTIS au format MP3
ou AAC. Vérifiez – et modifiez si nécessaire – 
les infos de chaque morceau de musique. 
Il faut notamment indiquer le nom de l’artiste,
le titre des pistes et ajouter une image. 
Pour ma propre bibliothèque, je scanne 
les pochettes de mes CD pour les ajouter 
en tant qu’illustrations aux fichiers MP3. 
La connexion à Internet facilite ici le processus

car, dès l’introduction d’un CD,  iTunes peut 
aller chercher automatiquement dans une base
de données les pistes d’un album. Pour cela,
soit les Préférences générales d'iTunes sont 
réglées pour Se connecter à Internet 
au besoin, soit on fera Obtenir le nom 
des pistes du CD dans le menu Avancé.
Pour l’illustration, vous devrez la plupart 
du temps l’ajouter à la main.

La dernière version de iTunes vous propose
de créer une pochette personnalisée 
pour les listes de lecture, le Mix de soirée
et même pour toute la bibliothèque, 
si cette dernière est vraiment toute petite.
La pochette créée avec iTunes est prévue
pour les boîtiers CD extra-plats : 
vous obtiendrez un document que 
vous plierez en deux pour le glisser juste
dans la face avant. Le modèle unique 
proposé par iTunes ne prévoit ni les bords,
ni le dos des boîtiers classiques. 

CLIQUEZ SUR LE SIGNE « + » en bas à gauche de la 
fenêtre. Donnez un nom explicite à cette nouvelle
liste, puis glissez les morceaux de musique, 
de la bibliothèque vers la liste. La gestion 
d’une liste de lecture est très souple : vous
classez les titres en les déplaçant simplement ;
vous en supprimez ou en ajoutez à volonté.

1

CD-MP3. Reste à créer, en fonction du type
de boîtier utilisé, les éléments visuels qui
donneront à votre « création » une touche
professionnelle : la jaquette, le dos, les tran-
ches ou encore le rond.

n Alain Lalisse

VOUS AVEZ MAINTENANT UNE LISTE DE LECTURE
bien renseignée et fonctionnelle. Sélectionnez-la,
puis allez dans le menu Fichier > Imprimer
où tout se passe. iTunes ne propose 
en effet aucun menu spécial dédié à la création
de jaquette. Dommage…
Dans le dialogue d'impression, choisissez 
l'option Pochette de CD.
Un pop-up menu vous propose maintenant 
un thème . Le choix n’est pas très large 
et varié, mais en pratique, on trouve 
toujours ce dont on a besoin. Que se soit 
en couleur ou en noir en blanc, en illustration
simple ou en mosaïque, en texte seul, sur fond
noir ou blanc, il y en a vraiment pour tous 
les goûts. A vous la décision.
Pour vous aider, Apple construit en temps 
réel une prévisualisation du résultat . Cliquez 
sur Imprimer... La boîte de dialogue 
d’impression s’affiche alors. 
Vous pouvez lancer tout de suite l’impression 

ou bien créer un fichier PDF (bouton Enreg.
comme PDF…) que vous reprendrez aisément
dans Photoshop Elements, par exemple, 
histoire d'améliorer encore la présentation. 

3

2

A
près avoir placé dans iTunes votre
collection de CD audio, vous en
êtes peut-être déjà venu à créer vos

compilations personnelles. C'est un jeu
d’enfant avec le logiciel d’Apple. Le plus
simple est en fait d’utiliser la fonction Mix

1

Importez et paramétrez les fichiers

Imprimez ou enregistrez la jaquette
Créez une 
liste de lecture

ATELIER

2

3
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Une pochette en 4 clics avec CD Jaquet !

CD Jacquet dispose d’outils pour travailler
le texte (couleur, interligne, taille, police…).
Le fond peut être lui aussi coloré. Enfin, 
il gère la transparence des images 
pour mieux faire ressortir le texte 
(très utile pour la liste des titres) . 
Pour la face avant, on a le choix 
entre une seule image ou une mosaïque.
Mêmes options pour faire une face 
arrière. Pour les ronds de CD , 
c’est un peu plus complexe. Outre 
le fait qu’il place automatiquement 
les noms d’artiste et d’album, vous aurez
à indiquer à CD Jaquet la position exacte
des cercles sur les feuilles autocollantes.
Cela se fait assez facilement, 
avec un bon double décimètre. 
Une fois le travail terminé, vous imprimez
directement ou vous enregistrez 
un fichier PDF pour poursuivre l’ouvrage
dans Photoshop Elements, par exemple.
Dans les deux cas, les marques 
de découpe sont imprimées. La version 
de démonstration est opérationnelle, mais
impose le mot « DEMO » un peu partout.

4

3

Ce shareware très simple d’emploi n’en est pas moins efficace. À chaque lancement, une explication en français est proposée.
L’interface est composée de quatre simples onglets.

L’onglet iTunes récupère directement 
vos listes de lecture . Vous pouvez
alors éditer la liste des chansons par 
simple double-clic : utile pour retravailler
les titres trop longs, par exemple. 
Les trois onglets suivants correspondent
aux pochettes avant, arrière et aux ronds
des CD. Le principe est toujours le même :
vous renseignez au mieux un nom 
d’artiste et un nom d’album. Vous glissez-
déposez ensuite deux images dans 
les cases appropriées . Si vos MP3
contiennent des images, elles sont déjà
disponibles. Utilisez Internet pour 
en rechercher éventuellement d’autres. 

2

1

La bande des quatre

PPrroodduuiitt EEddiitteeuurr PPrriixx NNooss rreemmaarrqquueess

CD Jacquet J.F. Pautex 10 € C‘est le plus simple à mettre en œuvre.

Disclabel SmileOnMyMac 29,60 € Un logiciel très complet pour créer toutes sortes de pochettes.

Discus CD 
Labeler

Magic Mouse 29 € env.
Livré sur un CD bourré de nombreuses illustrations ; l’interface est trop simpliste et limitée ; 
l’intégration avec iTunes est à revoir.

UnCoverIt IWasCoding 16,23 € Intéressant et complet, mais aucun garde-fou contre les erreurs de manipulation.

Bien que très rapide, la fabrication de pochettes pour vos compilations reste assez limitée avec iTunes. Nous vous présentons dans 
cet Atelier une sélection de quatre logiciels dédiés à cette fonction. Point commun : ils sont tous d’un prix très abordable (de 10 à 39 €).

1

2

3

4

3
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DISCLABEL DISPOSE d’une petite quarantaine de modèles 
qui peuvent servir d’autant de bases de départ. 
Les modèles sont classés en 3 catégories : modèles Disclabel,
classiques et abstraits. Pour chacun, vous pouvez voir 
le rond, la face avant, le dos (avec les deux bords), la double
face avant… Cliquez sur la petite barre d’icônes pour 
les afficher un à un, avec les flèches droite et gauche. 
Vous remarquez d’ailleurs que Disclabel ne gère pas seulement
les boîtiers CD cristal classiques, mais aussi les boîtiers 
extra-fins de 5 mm, les boîtiers DVD, les jaquettes VHS.
Vous pouvez aussi créer vos propres modèles, mais nous 
verrons cela par la suite… 
Pour cet article, j'ai choisi le modèle avec une flûte 
à champagne qui se trouve dans la catégorie : Modèles 
Disclabel. Une fois le modèle choisi, cliquez sur Nouvelle 
création depuis ce modèle.

2

1

Passez ensuite dans l’onglet Modifier.
À gauche : vos créations. Dans la fenêtre principale : 
la zone de travail. En bas, les outils . Et vous retrouvez la pe-
tite barre d’icônes qui affiche le rond, la face avant, arrière 
et la double face. Commencez par donner un nom à votre 
jaquette. J’ai appelé la mienne « Anniversaire ». Disclabel 
peut créer des jaquettes pour tous types de CD (audio, MP3, 
mais aussi des CD de photos, de présentation…). Il est interfacé
avec iTunes, iPhoto, iDVD, mais aussi avec des données issues 
d’un fichier texte correctement formaté (le format est 
décrit dans l’aide du logiciel). Dans le cas de la musique, 
les listes de lecture iTunes sont gérées automatiquement. 
Il faut donc avoir au moins une liste bien préparée. Dans le pop-up
menu , choisissez l’application iTunes. iTunes s’ouvre 
en tâche de fond et un autre pop-up menu affiche toutes 
les listes de lecture. Choisissez la vôtre.

5

4
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Rhabillez votre CD avec Disclabel

UnCoverIt, la création sans filet

Disclabel, de l’éditeur SmileOnMyMac, est selon moi le logiciel le plus complet et le plus fiable, mais il s’avère parfois un peu complexe 
à mettre en œuvre. Voyons cela ensemble et en détail…

L’interface de UnCoverIt est plutôt 
perturbante. Vous commencez 
de manière très classique par choisir
une liste de lecture iTunes ou un CD.
Puis vous sélectionnez le type 
de couverture que vous voulez créer.
Vous vous retrouvez alors dans 
un logiciel de dessin vectoriel où tous
les objets peuvent être manipulés. 
Cela va d’ailleurs assez loin car chaque
objet graphique possède un titre, ce qui
facilite la sélection. Et un double clic
sur ce titre ouvre un inspecteur 

contextuel avec un nombre
impressionnant d’options graphiques 
ou typographiques. Petit problème 
de développement et d’interface 
utilisateur fort gênant : vous pouvez
tout aussi bien redimensionner 
les contours de la jaquette ou le rond
du CD pour le transformer en ovale…
que les autres objets ! Voilà des possi-
bilités inutiles, voire dangereuses. Car 
à la moindre erreur de manipulation,
vous ne savez plus très bien où sont 
les limites de la jaquette ou du rond.

2
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Choisir un modèle et le modifier
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NOTRE MODÈLE COMPORTE PLUSIEURS ZONES DE TEXTE. Lors de la sélection 
d’une liste de lecture iTunes, elles se sont remplies automatiquement. Pourquoi ?
Parce qu’une zone de texte contient des balises qui sont renseignées 
automatiquement. Créez une nouvelle zone de texte (avec l’outil Texte).
Sélectionnez le texte pour le mettre en sur-brillance. Vous avez alors accès 
aux pop-up menus Insérer et Choisir un format. Ces balises vont aller

chercher directement 
les informations dans la liste 
de lecture iTunes. Bien entendu,
il n’est pas indispensable 
d’entrer une balise. On peut
aussi entrer du texte libre, 
sans aucune liaison avec iTunes.
Remarquez que les zones de
texte sont redimensionnables
mais toujours contraintes par les bords . C’est une option par défaut qu’il vaut mieux 
conserver. Le style du texte se modifie avec la palette Polices standard de Mac OS X (police, style, 
taille, ombre…) . Le menu Format >Texte propose la justification. Les fonctions de gestion 
du texte sont très riches. Un peu d’exploration est donc nécessaire. Faites les modifications de texte 
sur tous les types de jaquettes .4

3

2
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MAINTENANT FAITES APPEL À VOTRE SENS ARTISTIQUE
inné pour agrémenter vos créations d’images. 
Et si vous utilisiez tout simplement les pochettes 
issues de vos CD (enregistrées dans iTunes) 
ou encore des photos personnelles ?
Placez-vous sur le livret de 2 pages.
Faites un peu de place en retirant certains blocs
textes (touche Retour arrière). Cliquez sur l’outil
Image, puis sur Insérer Image et, dans le pop-up,
choisissez iTunes . Une fenêtre apparaît avec 
un autre pop-up qui propose les listes de lecture.

Choisissez la bonne et, oh surprise !, ce sont 
toutes les jaquettes de tous les disques entrant
dans la compilation qui apparaissent ! 
Il n’y a pas de miracle : elles sont seulement 
extraites des tags MP3. Ici, j’ai huit couvertures 
qui correspondent à une compilation de huit CD 
différents . 
Sélectionnez les jaquettes (à la souris avec 
la touche Pomme). Cliquez sur Créer Montage.
Je vous laisse tester toutes les variantes. 
C’est assez plaisant ! Au final, faites Importer.
Eh voilà, vous retrouvez toute la composition 
sur votre jaquette. Redimensionnez-la. 
Pour conserver les proportions, appuyez en même
temps la touche Majuscule. Importez maintenant
deux photos. Refaites Insérer Image et choisissez
cette fois-ci un fichier sur disque dur (un JPeg). 
Redimensionnez, toujours avec la touche 
Majuscule et placez ensuite l’image sur 

la jaquette . Les images peuvent être 
recadrées (outil Rogner), placées dans une figure 
géométrique (outil Masquer), ou encore tournées
(avec les deux outils de rotation)…
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Servez-vous des outils Texte

Des illustrations à gogo !
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Si vous avez acheté Toast, vous connaissez peut-être déjà Discus
puisqu’il fait partie des outils livrés par Roxio. Nous avons 
utilisé la version 3.10D qui est vendue et livrée sur CD-Rom.
L’interface de Discus n’a pas changé depuis celle 
que nous connaissions dans le package Toast. Cela ressemble 
très fortement aux premiers logiciels 
graphiques avec de gros boutons et un bruit
de casserole à chaque clic. Interface 
très enfantine ! Même si le logiciel offre 
un ensemble de fonctions intéressantes, 
il est cependant un peu en retard
par rapport à Disclabel ou même CD Jaquet.
Il n'est par exemple toujours pas interfacé
directement avec iTunes. Récupérer 
les listes de lecture impose d'en passer par
un export texte. En général, son intégration
avec les iApps n’a pas été envisagée à ce
jour. Son principal intérêt réside dans sa très
grosse bibliothèque d’images, de styles et de
textures livrée sur le CD. Il y a notamment
des reproductions d'œuvres d'art prestigieuses
dont je ne perçois pas l'utilité pour 
la création de jaquettes CD ou DVD…

VOTRE CRÉATION PEUT ÊTRE DIRECTEMENT IMPRIMÉE
ou exportée aux formats PDF, JPeg ou Tiff 
avec différents niveaux de compression (menu 
Fichier > Exporter). Sachez aussi que Disclabel 
enregistre automatiquement tout ce que 
vous faites. Vous ne risquez donc pas de perdre
bêtement de nombreuses heures de travail. 

L’impression est accessible dans 
l’onglet Papier. Vous imprimez tout
d’abord une page de calibration .
Les mesures de la croix renseignent
précisément le logiciel sur le réglage
de votre imprimante. Il suffit de suivre
les indications de la feuille test. 
Vous choisissez ensuite le type 
de papier utilisé : il y en a de toutes
les marques et une mise à jour de
cette bibliothèque est même prévue
par Internet. Il suffit alors de glisser
le modèle sur la page
( et ). Cerise sur
le gâteau : si le design
que vous avez conçu
vous plaît, enregistrez-le
comme modèle 
(menu Fichier). Vous 
le réutiliserez autant 
de fois que vous voudrez
pour d’autres créations.
De quoi avoir des modèles
bien différents et 
très personnels pour vos
compilations Musique 
baroque et vos compila-
tions Jazz…

32
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Discus : le poids des images

Et vous terminez enfin par l’impression…
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Voici un moyen de protéger des documents sans avoir besoin de crypter tout votre dossier 
d'utilisateur avec FileVault. Le principe, très proche, consiste à utiliser une image disque cryptée. 

Protégez vos données sensibles

dans une image-disque

AVEC UTILITAIRE DE DISQUE (Applications > Utilitaires),
créez une nouvelle image. Donnez-lui un nom .
Choisissez un emplacement protégé (par exemple, 
le dossier Documents de votre dossier Départ), une taille pas trop petite car
vous ne pourrez pas l’étendre dynamiquement par la suite, le cryptage AES-128,
un format image disque en lecture/écriture. Cliquez sur Créer. Un mot de passe 
de protection vous est demandé . Il ne faut jamais l’oublier ! Votre image 
est créée en quelques secondes. Le fichier .dmg se trouve dans le dossier
que vous avez choisi. L’image monte sur le Bureau automatiquement.4
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VOUS UTILISEZ UNE IMAGE DISQUE comme 
un disque dur. Tout fichier glissé y est 
automatiquement copié. Pour supprimer 
des éléments, jetez-les à la Corbeille. Rappelez-
vous : nous avons choisi un mode lecture/
écriture. Vous pouvez déplacer le fichier .dmg
correspondant à l’image disque et l’ouvrir sur un autre Mac. Le mot de passe sera demandé pour décrypter
les données. Une solution idéale pour transporter de manière confidentielle des données sur une clé USB.

SI VOUS TRAVAILLEZ TOUS LES JOURS avec vos documents, 
faites en sorte que l’image cryptée monte automatiquement. 
La procédure est simple : glissez le fichier .dmg dans les options
de démarrage de votre compte d’utilisateur. À chaque connexion,
votre image s’ouvrira sur le Bureau. Le mot de passe ne vous est
pas demandé car il est intégré à votre Trousseau d’accès.

1

2

3 4

Il est également possible de partager 
des informations entre utilisateurs
d’une même machine Mac à l’aide 
d’une image disque. 
Choisissez alors les options Cryptage
vide et Image disque en lecture/écriture.
Ensuite, placez le fichier .dmg dans 
un réper-
toire
accessible 
à tous.
Vérifiez
aussi, 
en lisant 
les infos
sur l’image
disque, 
que la case
Ignorer 
les autori-
sations de
ce volume
a bien été
cochée.

L
’image disque que vous allez créer
s’utilise comme n’importe quel dossier
ou disque dur. Elle monte automati-

quement sur le Bureau et est aussi rapide
qu’un disque dur : le cryptage est effectué à
la volée. Les données sont parfaitement
protégées. Même si on vous vole votre Mac

ou le fichier image disque par copie physi-
que, accès réseau, montage en mode T… et
même si on réinitialise les mots de passe ou
que l’on se connecte en super-utilisateur
root, vos documents resteront inviolés :
vous seul disposez de la clé pour ouvrir
l’image. Mais n’oubliez pas votre mot de

passe ! Personne ne pourra alors vous aider.
Sans lui, l’image disque cryptée s’avère illi-
sible et le codage 128 bits quasi-impossible
à « craquer » dans des temps raisonnables
et sans une puissance de calcul qui dépasse
de très loin les ressources des utilisateurs
que nous sommes. n Alain Lalisse

Inversement, partagez
une image disque

Création 
de l’image disque

Utilisation

Montage 
automatique
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Cette rubrique 
vous intéresse !

Contactez Angélique Mermet
Tél. : 01 40 33 79 56
angelique@vvmac.com

Vous voulez 
communiquer

01487801 87

Récupération
de disques crashés
et de fichiers XPress, Excel, Word endommagés?
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Votre film est enfin terminé, bravo ! Mais vous aimeriez bien vous offrir un générique 
professionnel, quelque chose à la mesure de votre chef d’œuvre. En suivant ces conseils, 
vous blufferez vos spectateurs. Le logiciel de montage vidéo d’Apple dispose d’outils
pour réaliser des génériques de qualité. Et avec un peu de créativité et l’aide de Photoshop
Elements, il est possible de créer un générique digne des plus grands studios.  n Vincent Boyer

Avec Final Cut Express et Photoshop Elements

réalisez un générique 
«hollywoodien» !

POUR COMMENCER, nous allons
concevoir un fond statique et 
un titre stylisé qui accompagneront
le générique en lui même.

Lancez Photoshop Elements, 
puis créez un nouveau document 
de 768x576 pixels à une résolution
de 72 pixels/pouce (ou choisissez

Préparez les éléments
PAL D1/DV pixel carré dans le menu
Paramètre prédéfini) . Pour
créer le fond, vous vous servirez
simplement de l’effet Métal rouillé
disponible dans la palette Styles 
et effets . Il suffit de glisser/
déposer l’icône de l’effet 
sur le document pour l’appliquer. 
Sauvegardez votre fichier 
en lui donnant comme nom « Fond »
et un format, JPeg par exemple.
Passez maintenant au titre. Créez 
un nouveau document aux mêmes
dimensions, sélectionnez ensuite
l’outil Texte. Tapez votre titre, puis

supprimez le calque d’arrière plan.
Votre fond est maintenant 
transparent. Pour faire ressortir 
le texte, appliquez-lui un effet 
d’ombre portée (palette Styles et 
Effets > Styles de calques > Ombres
portées). Pour parfaire le tout, 
vous pouvez appliquer un motif 
ou un effet . N’oubliez pas 
de sélectionner Simplifier le calque
dans le menu Calque sans quoi
aucun effet ne serait enregistré. Pour
finir, enregistrez votre document,
mais prenez soin de le faire 
au format Photoshop, cette fois .4

3

2

1

1

2
4

3
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OUVREZ MAINTENANT FINAL CUT EXPRESS. Importez
tous vos éléments, images et vidéos dans 
le Navigateur. Placez le fond sur la première piste
de la Timeline, puis votre titre au-dessus 
de la piste contenant votre fond . Si ce dernier
est au format JPeg, vous n’aurez pas de mal 
à ajuster sa durée, mais en revanche, s’il est 
au format PSD, il vous faudra double-cliquer 
sur la piste pour pouvoir la modifier. Si votre titre
est trop grand, vous le réduirez en sélectionnant
Image+Fil de fer en haut au centre de la fenêtre
Canevas . Vous pourrez également le déplacer.6

5

Réalisez l’assemblage

DANS LA FENÊTRE VISUALISATEUR, repérez l’icône d’un A dans 
une bobine en bas à droite. Cliquez dessus et sélectionnez Texte >
Défilant vertical . Cliquez ensuite sur l’onglet Contrôles
de la fenêtre Visualisateur, puis rentrez le texte devant apparaître 
au générique. De nombreux réglages s’offrent à vous pour mettre 
en forme le texte. Pour notre part, il sera centré à gauche et 
comportera une taille fondu de 50% . Ainsi, le texte s’effacera
progressivement en arrivant sur le titre. Vous visualisez le résultat
en vous rendant dans l’onglet Vidéo de la fenêtre Visualisateur. 
Toujours dans cet onglet, glissez/déposez votre texte sur la fenêtre
Canevas et choisissez Superposer dans les menus qui s’affichent 
en transparence . Si vous avez activé le mode Image+Fil de fer,
vous pouvez redimensionner et déplacer votre générique.

9

8

7

Montez le générique

Derniers raffinements
POUR TERMINER, RAJOUTEZ DES PETITES SÉQUENCES rappelant le film,
qui défileront pendant le générique. Pour cela, sélectionnez
une séquence puis glissez/déposez-la sur le Canevas et choisissez 
à nouveau Superposer. Réduisez et positionnez-la à gauche 
du générique . Vous pouvez en placer plusieurs sur la même piste
avec des transitions pour un résultat encore plus saisissant. 
Vous trouverez les transitions dans l’onglet Effet du Navigateur .11

10

5

6

7

8

9

10
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Connaissez-vous vraiment toutes les possibilités de votre iSight ? Cet élégant périphérique 
ne se contente pas d’être les « yeux et les oreilles » d’iChat AV. Utilisé avec un peu de méthode, 
il peut également devenir l’ange gardien de votre maison.

Télésurveillez la chambre de bébé

avec votre iSight

Q
uand on vous dit iSight, c’est la visio-conférence au travers
d’Internet qui vous vient tout de suite à l’esprit. Il est vrai
qu’Apple démontre les mérites d’iSight essentiellement avec

son logiciel de messagerie instantanée iChat AV. Pourtant, il existe
d’autres possibilités d’utilisation ! Ainsi, grâce à votre iSight, vous
surveillez votre maison depuis votre bureau ou votre lieu de villégia-
ture, ou vous veillez depuis le salon ou le jardin sur vos enfants qui
dorment ou jouent dans leur chambre. Cet atelier vous explique
comment mettre facilement en place un tel système avec une (ou
plusieurs) caméra iSight et quelques logiciels. n Frédéric Blaison

LA SOLUTION LA PLUS SIMPLE À METTRE EN ŒUVRE, 
ET LA MOINS COÛTEUSE, consiste à surveiller une pièce 
de votre maison à l’aide de votre iSight et du logiciel gratuit 
d’Apple, QuickTime Broadcaster. Cela ne prend que quelques 
minutes à configurer (hors pose du câblage bien entendu). 

A Réglez correctement votre iSight
Connectez la Webcam iSight à votre Mac. Mac OS X lance alors
automatiquement le logiciel iChat AV. Vous effectuez les réglages 
d’iSight en cliquant sur l’icône verte d’une caméra située entre 
votre nom et votre avatar, en haut sur la liste des contacts. iChat AV 
ouvre une fenêtre de prévisualisation de ce que filme votre iSight. 
Profitez-en pour cadrer l’espace visuel de ce que vous voulez capter .
Vous pouvez ainsi régler la zone que vous souhaitez surveiller 
– la chambre de votre enfant, par exemple. Pour ma part, 
j’ai « visé » la porte d’entrée de mon appartement. Une fois satisfait 
de vos réglages, désactivez iSight dans iChat AV. Pour ce faire, 
il vous suffit de décocher le menu Vidéo > Caméra activée.

1

1

Télésurveillance simple 
avec QuickTime Broadcaster

Il vous faut un Mac avec un port Firewire 400 (connectique 6 broches) 
et une iSight (149 €). Pourquoi une iSight ? Cette Webcam Firewire offre
tout simplement des images bien supérieures à celles d’une caméra USB.
Parce qu’elle intègre aussi un micro : vous aurez à la fois l’image et le son ! 
Mais si vous trouvez une autre caméra Firewire avec micro, rien n’interdit
de l’utiliser. Selon la configuration des lieux, vous aurez besoin d’un 
(ou plusieurs) câble 
Firewire. Si vous 
ne disposez que 
d’un Macintosh 
au rez-de-chaussée 
et que vous voulez 
surveiller votre enfant
à l’étage du pavillon,
vous devrez « tirer 
du câble » entre
votre ordinateur 
et l’iSight directement
placée dans la cham-
bre. Il vous faudra aussi des câbles Firewire 400 6 broches/6 broches 
de Belkin pour une distance de 90 cm à 4,30 m (www.belkin.com/fr/) .
Pour une distance plus longue, utilisez plusieurs câbles reliés 
par un répétiteur. Macally propose le FH-110 
livré avec un câble de 5,50 m pour 32 €
(www.macally-europe.com) .
Pour la transmission des données au travers 
d’Internet, un accès ADSL ou câble 
est vivement conseillé, avec une bande 
passante d’au moins 1 Mbps et plus 
selon les possibilités offertes par votre localité 
et votre fournisseur d’accès Internet.

2

1

Le matériel nécessaire

1

2
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B Paramétrez QuickTime Broadcaster
Téléchargez QuickTime Broadcaster 1.0.1 qui 
requiert au moins Mac OS X 10.1.3. (allez sur 
les sites d’Apple, Version Tracker ou MacUpdate). 
Le processus d’installation achevé, lancez 
QuickTime Broadcaster (répertoire Applications).
Ce programme se présente sous la forme 
d’une fenêtre, avec un aperçu de ce que filme
iSight. Choisissez dans le menu local Audio, l’option
LAN – Music, et dans le menu local Vidéo 
l’option LAN – High Motion . Cliquez sur Afficher 
les détails. La fenêtre de Broadcaster propose 
les réglages étendus, divisés en trois sections sur 
la droite : Audio, Vidéo et Réseau . Affichez 
l’onglet Réseau. Réglez le menu local Transmission
sur Monodiffusion manuelle. Récupérez l’adresse 
IP de votre ordinateur dans les préférences 
système de Mac OS X (section Réseau) et indiquez-la
dans le champ Adresse. Si vous souhaitez utiliser 
le flux à travers Internet, remplissez le champ

Adresse avec l’IP de l’ordinateur receveur du flux.
Laissez telles quelles les autres options. Choisissez
le menu Fichier > Exporter > SDP et enregistrez 
le fichier .sdp sur votre Bureau. Donnez-lui un nom. 
QuickTime Broadcaster crée alors une séquence
QuickTime. Ouvrez-la sur votre récepteur (ordinateur
perso ou n’importe quel ordinateur de votre réseau
local ou Internet, mais dans une configuration 1:1,
c’est-à-dire un seul récepteur à la fois). 
Ne cochez pas la case Enreg. sur le disque,
à moins que vous ne souhaitiez enregistrer 
la diffusion sur le disque dur – ce qui ne 
peut manquer de créer un fichier très gourmand
en espace disque. Cliquez sur le bouton Diffuser.
Lancez le lecteur QuickTime dans lequel 
vous ouvrez le fichier .sdp à l’aide du menu
Fichier > Ouvrir la séquence comme nouvelle 
lecture . La diffusion en direct commence 
après un petit temps d’attente occasionné 
par la mise en tampon du flux. 
Si vous utilisez un pare-feu, vous devrez peut-être
créer des règles pour ouvrir les ports 5432 (audio)
et 5434 (vidéo) afin de laisser passer le flux. 
Dans cet atelier, nous avons réglé la diffusion 
pour des flux élevés et diffusés en local. 
Si vous souhaitez observer la transmission 
à travers Internet, préférez des réglages audio et
vidéo adaptés aux connexions DSL et câble.

4

3

2

NOUS VENONS DE METTRE EN PLACE UNE TÉLÉSURVEILLANCE 
BASIQUE, suffisante pour surveiller vos enfants à distance, 
par exemple. Mais si vous souhaitez installer un système 
de surveillance de toute la maison pour prévenir des cambriolages 
durant votre absence, ce système ne sera pas satisfaisant. 
Mieux vaudra faire appel à un autre logiciel : EvoCam d’Evological
Software (15 $). Une version d’évaluation de 15 jours est disponible.
Les principaux avantages de ce logiciel, proposé uniquement 
en anglais, sont la détection automatique des mouvements, 
l’enregistrement de courtes séquences spontanées, l’envoi d’une 
capture par email et des services Web intégrés pour surveiller 
à distance et en temps réel.

A Mise en place d’un capteur
de détection des mouvements
Lancez EvoCam après avoir pris 
soin d’arrêter la diffusion et de quitter
QuickTime Broadcaster. Veillez aussi 
à avoir bien désactivé iSight 
dans iChat AV. Dans le menu local
New Item de l’onglet Items,
choisissez l’option Sensor .
Un contour apparaît au milieu 
de l’écran pour matérialiser 
le capteur. Le contour est plus

1

Télésurveillance complexe avec Evocam

2

3

4
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épais lorsqu’il est sélectionné et peut être déplacé
et redimensionné comme lorsque vous rognez 
une image dans un logiciel de retouche. Ainsi, si
vous souhaitez surveiller l’entrée d’un appartement,
centrez cette zone sur la porte . Lorsque vous

sélectionnez un capteur, l’onglet
Items propose des options pour 
régler la sensibilité (Sensitivity)
de légère (Low) à élevée (High).
Assurez-vous que la case Show 
motion est cochée pour visualiser
les mouvements détectés sur 
EvoCam. Vous pourrez analyser 
ainsi sur le logiciel ce qui déclen-
che la détection d’un capteur.
Cliquez sur le bouton Settings
de l’option On motion .
Dans ces options complémentaires,
si vous cochez la case Refresh ,
EvoCam prendra une capture 
s’il détecte du mouvement dans 
la zone d’un capteur. Si vous cochez
la case Record Movie, il enregis-
trera une séquence QuickTime 
au moment où a lieu la détection du mouvement.
Tapez « 1 » dans le champ de cette option 
et réglez le menu déroulant sur Minutes .
Si la configuration de la pièce est plus compliquée,

par exemple une porte et une fenêtre juste à côté,
créez d’autres capteurs avec le menu local New
Item. Cliquez n’importe où sur l’écran d’aperçu pour
retrouver les options générales de l’onglet Items. 

6

5

4

3
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B Configurez la séquence QuickTime
Cliquez sur l’onglet Recording pour régler la qualité de l’enregistrement 
des séquences vidéo qui se déclenchent lors de la détection 
d’un mouvement par un de vos capteurs.
Cliquez sur le bouton Video pour modifier l’image (nous n’apporterons pas 
ici de modifications car les réglages par défaut sont satisfaisants). 
Cliquez sur le bouton Sound pour régler l’audio. Une nouvelle fenêtre 
s’ouvre, et dans le menu local Compressor, choisissez Qdesign Music 2
puis validez avec OK. Enfin, cochez la case Movie include sound .
À l’aide de l’option Destination , vous précisez le dossier dans lequel 
seront stockées les séquences enregistrées. Le plus simple est de choisir 
le dossier Séquences de votre compte.

8

7

C Configurez des captures
Dans l’onglet Refresh, réglez la capture d’image lors de la détection 
d’un mouvement par un capteur. Cliquez sur l’option When motion 
is detected . Cochez ensuite la case Send image as email. EvoCam 
a besoin de connaître le serveur SMTP que vous utilisez, ainsi que l’adresse 
de destination : cliquez sur Set Up Now pour basculer sur l’onglet Server
et entrez les informations nécessaires. À droite du menu local Configure ,
cliquez sur le bouton Advanced pour renseigner vos nom d’utilisateur 

10

9

et mot de passe d’accès au serveur SMTP (il doit s’agir des mêmes références
que votre compte email). Pour cet atelier, nous utilisons une adresse .Mac 
et le serveur SMTP de .Mac. Revenez dans l’onglet Refresh. Cochez 
la case Save image to folder . EvoCam propose de choisir un dossier 
pour sauvegarder la capture. Dans l’optique où vous souhaiteriez conserver 
les anciennes captures (EvoCam va en effet écraser la précédente 
à chaque détection du capteur), cochez la case Archive image to folder .12
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D Testez la configuration et affinez les réglages au besoin
Vous pouvez désormais effectuer un test de vos réglages. Passez devant 
la caméra et retournez près de votre ordinateur : EvoCam a lancé 
l’enregistrement d’une séquence vidéo et pris une capture de ce qui s’est
passé, puis vous l’a envoyée par email. 

Cette phase de test vous permet de voir si la sensibilité de la détection 
n’est pas trop élevée. En effet, si vous avez laissé entrouverte 
une fenêtre et que vous avez une plante verte : le vent peut faire bouger 
légèrement les feuilles et générer des détections dans tous les sens, 
et par voie de conséquence des e-mails à répétitions…

F Sauvegarde des images sur un serveur distant
Les plus exigeants d’entre-vous pourront pour leur part enregistrer 
les images créées lors de la détection d’un capteur sur un serveur FTP 
en configurant les options FTP Server du menu local Configure
placé dans l’onglet Server .
Une fois tous les champs renseignés, rendez-vous dans l’onglet Refresh
et cochez la case Upload to server. Vous pourrez, par exemple, 
récupérer l’image d’un intrus si vous êtes en train de vous faire piller… 
Bien entendu, on ne vous le souhaite pas !

15

G Utilisation de plusieurs caméras iSight
Comme vous l’avez sans doute compris après lecture du présent article, 
EvoCam est un logiciel assez sophistiqué. Dans certaines circonstances, 
par exemple le cabinet d’un médecin, il faudra peut-être surveiller 
simultanément plusieurs pièces : l’entrée, la salle d’attente… 
EvoCam sait gérer ce cas de figure. Il autorise l’ouverture d’une fenêtre 
pour chaque caméra connectée et le réglage de chacune d’elles 
indépendamment des autres. Il sait également récupérer les réglages 
d’une caméra et les appliquer à une autre. 
Pour connecter plusieurs Webcams iSight à un seul Mac, vous pouvez 
utiliser tout simplement un hub Firewire. Les règles exposées au début 
de ce pratique concernant le déploiement des câbles Firewire dans le local 
à surveiller restent les mêmes et s’appliquent pour chaque iSight.

E Surveillez à distance 
via une page Web
Il est possible de peaufiner 
les réglages d’EvoCam pour obtenir
une vue en temps réel de ce qui 
se passe via une page Web stockée
sur votre ordinateur. 
Cliquez d’abord sur l’onglet Server
et choisissez Built-in Web Server
dans le menu local Configure. .
Cochez ensuite la case Enable 
built-in web server, puis cliquez 
sur le bouton Advanced.
Validez la case Require username
and password pour protéger 
la page Web en inscrivant dans 
les champs Username et Password
le nom d’utilisateur, puis le mot 
de passe requis pour y accéder . 
En cochant la case Use custom HTML
for “webcam.html”, vous pouvez

remplacer la page créée 
automatiquement par EvoCam 
par une création personnelle. 
Faites OK une fois que tous 
vos choix sont effectués…
EvoCam ouvre automatiquement 
la page Web sur votre navigateur ;
vous pouvez ainsi copier 
l’adresse pour l’utiliser partout 
où vous le souhaitez. Cette page 
Web nécessite Java pour 
fonctionner, et l’image est mise 
à jour en temps réel. 
À ce stade des manipulations, vous
pouvez enregistrer vos réglages 
via le menu File > Save As. EvoCam
crée un fichier dont vous 
vous servirez chaque fois que vous
aurez besoin de mettre en place 
une télésurveillance avec 
votre Mac durant vos absences.
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Enfocus Instant PDF 3.0

QuarkXPress Passport 6.5 complet : 2199 €HT

Enfocus Instant PDF 3 .0 : 199 €HT

1 journée de prise en main* : 385 €HT

QuarkXPress Passport 6.5 màj
depuis 5 : 359 €HT

Enfocus Instant PDF 3 .0 : 199 €HT

QuarkXPress Passport 6.5 màj
depuis 4 : 519 €HT

Enfocus Instant PDF 3 .0 : 199 €HT

QuarkXPress Passport 6.5 màj
depuis 3 : 679 €HT

Enfocus Instant PDF 3 .0 : 199 €HT

Configuration minimale conseillée

Mac OS X v10.2 ou ultérieure
128 Mo de RAM
230 Mo d’espace disque

Windows 2000 ou XP
128 Mo de RAM
190 Mo d’espace disque

Configuration minimale requise

Mac OS X v10.2.8 ou ultérieure
Windows 2000 ou XP
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